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Use the following sections to find information on Delcam Draft: 

Drafting (see page 3) 

Drawings (see page 6) 

Notes (see page 38) 

Views (see page 42) 

Annotation (see page 116) 

Dimensions (see page 189) 

Hatching (see page 242) 

Balloons (see page 147) 

Schedules (see page 269) 

Embedded Bill of Materials (see page 304) 

Symbols (see page 260) 
 

Drafting - an overview 
The following sections give an overview of the drafting functionality: 

Introduction to Delcam Draft (see page 3) 

Start Delcam Draft (see page 4) 

Exit Delcam Draft (see page 6) 
 

What is the Delcam Draft? 
Delcam Draft within PowerSHAPE provides tools to create a 2D 
representation (an engineering drawing) of your model. 

There are two ways you can create a drawing of your model: 

 From scratch using wireframe. 

Delcam Draft 



 

4 • Delcam Draft PowerSHAPE 2015 R2 Reference Help  

 Using a 3D model created in PowerSHAPE. 

You can fully annotate your drawing using tools such as hatching, 
dimensioning, and text. 

 Create a solid of your model where possible before drafting 
from it. This improves the quality and speed of hidden-line 
views. It also improves the accuracy of dimensioning. 

 

Entering Drafting mode 
You can start Delcam Draft in the following ways: 

Using the menus 
1 Select Module > Drafting from the menu. The drafting toolbar is 

displayed. 

 
2 You can select drafting options from the Object menu. 
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 Assembly modelling functionality is available from Drafting 
mode. 

Using the toolbar 

1 Click  (Main toolbar).  

 This is the same as hovering over  and selecting  from 
the flyout.. 

 
The Drawing Selector dialog is displayed and the drafting toolbar 
is displayed. For further details, see Creating a new drawing (see 
page 8). 

 If a drawing is already open when you enter Drafting mode, 
the last accessed drawing is displayed in the Open Drawing 
dialog.  

 When you switch between Modelling mode and Drafting 
mode, the correct mode is automatically enabled. For 
example if you select a drawing, Drafting mode is switched 
on automatically. 

The Drafting toolbar contains these buttons:  

 Drawing (see page 8) 

 View (see page 42) 

 Workplane 

 Line 

 Arc 

 Curve 

 Annotation (see page 116) 

 Hatching (see page 243) 
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 Symbol (see page 260) 

 Schedule (see page 269) 
 

Exiting Drafting mode 

Click  to exit Drafting mode and display the Main toolbar. 
 

Drawings 
Use the following sections to create and edit drawings in 
PowerSHAPE: 

Introduction to drawings, including examples (see page 6) 

Creata a drawing (see page 8) 

Create a title block on a drawing (see page 13) 

Create objects on a drawing (see page 14) 

Editing a drawing (see page 15) 

Drawing templates (see page 19) 

Creating Component Drawings (see page 28) 
 

What is a drawing? 
A drawing is equivalent to a piece of paper. A model can contain a 
number of drawings. You can use drawings to: 

 enter and annotate 2D geometry. 

 create views (see page 42) of a 3D model and annotate the 
model directly. 

 Create a solid of your model where possible before drafting 
from it. This improves the quality and speed of hidden line 
views. It also improves the accuracy of dimensioning. 
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Drawing examples 
You can create a drawing of the following example model in two 
ways. 

 
 Create the model in PowerSHAPE and create views on a drawing 

of the different projections of the model . 

 Create objects directly onto the drawing . 

 
 

Objects in 3D models and drawings 
Objects can exist in two places:  

 In the 3D model. 

 On the drawing. 

Objects created in the 3D model are displayed: 

 in the model window. 

 in views on drawings. 
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If you create an object on a drawing, you can see it only on that 
drawing. These objects may partially or wholly overlay a view, as if 
they are drawn on the glass of the window through which the model 
is viewed. 

 

Creating a drawing 
The following sections provide information on creating drawings: 

 Creating a new drawing (see page 8) 

 Changing the settings of a drawing (see page 9) 

 Opening existing drawings (see page 10). 

 Converting wireframe drawings (see page 13) 
 

Creating a new drawing 
To create a new drawing: 

1 Click  Modelling Mode (Main toolbar), to display the Drawing 
Selector dialog.  

 

2 Click Create new drawing . 
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3 A new drawing is displayed in the graphics window. Each drawing 
sheet is automatically named with an S followed by the drawing 
number. 

4 A single view of the displayed model is created automatically and 
is attached to the cursor. Click in the drawing to position the 
single view.  

You can now create either 2D geometry (see page 14) on the 
drawing or views (see page 42) of a 3D model. 

You can change the default settings of the drawing (see page 9) 
using the Options dialog. 

You can edit the drawing (see page 15). 
 

Changing the settings of a drawing 
To set or change the default drawing settings: 

1 Select Tools > Options > Drafting > Drawings to display the 
Drawings (see page 9) page in the Options dialog. 

2 Specify the settings for the drawing. 
 

Drawings options 
Use the Drawings page of the Options dialog to specify settings for 
drawings. 

 
Template — You can use a drawing from another model as a 
template. The model must have the word 'template' in its name. 
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To use a template: 

1 In the Layout area, select the Template option. 

2 Select a Model from the list. 

The Drawing list displays drawings contained in the selected 
model. 

3 Select a Drawing from the list. 

4 When you create a new drawing, it takes its size and initial 
contents from the selected template drawing. For example, 
the template drawing normally contains a border frame and 
perhaps a company logo. 

Size — The default dimensions of the drawing are displayed. To edit 
the dimensions of the drawing, select the option to the left and edit 
the values. You can also select a standard paper size from the list. 

Save thumbnails — Select this option to store the thumbnails from 
the drawing in the model.  

Graduated background — Select this option to apply any graduated 
background to new drawing windows. Deselect it to use the mid-
colour of the graduated background in new drawing windows. 

Set the graduated background colours using the View Edit dialog. 
For further details, see View > Layout. 

OK — Confirm the settings and close the dialog. 
 

Opening existing drawings 
To open an existing drawing from Modelling mode: 

1 Click  Modelling Mode (Main toolbar). 

 
The Drawing Selector dialog is displayed. 

 If a drawing is already open when you enter Drafting mode, 
the last-accessed drawing is displayed. 
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2 Select the drawing you wish to open from the list of drawings 
displayed in the Drawings section on the dialog. Alternatively click 
the Open All button to select all the drawings listed. 

 
3 Click OK. 

The selected drawings are displayed in the graphics window. 

To open an existing drawing from Drafting mode: 

1 Click Open Drawing  on the Drafting toolbar. 

 
The Drawing Selector dialog is displayed.  
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Viewing thumbnails 
You can view thumbnail images of existing drawings in the Drawing 
Selector dialog. Drawing thumbnails are stored with the model. 

 
1 Select a single drawing from the list of drawings displayed on the 

dialog. 

A thumbnail image of the drawing is displayed on the right.  

2 Click OK to open the drawing. 
 

Drawing Selector dialog 

Use this dialog to open existing drawings, or click  to create a 
new drawing. You can view thumbnail images of existing drawings 
when you select a single drawing from the list. 
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Drawings — Click a drawing in the list to select it. Select a single 
drawing to display a thumbnail image in the preview window on the 
dialog. 

Open All — Click to select all the drawings listed. 

Delete — Select a single drawing or multiple drawings from the 
Drawings list and click Delete to delete the selection. You can also 

use Delete  on the Main toolbar to delete the selection. 

Create new drawing  — Click to create a new drawing. 

OK — Click to open the selected drawing. 
 

Convert Drawing dialog 
Use this dialog to export a 2D wireframe representation of a 
drawing to a view or another drawing. The drawing can be 
converted to an open model or to a new model.  

 
To model — If there is one model open, this model is displayed in 
the dialog and is selected. The drawing is copied to this model by 
default. Select the To new model option to copy the drawing to a 
new model. If there is more than one model open, these are listed 
in the dialog. The first in the list is selected by default, but you can 
select any model from the list.  

To new model — Select this option to copy the drawing to a new 
model. This option is selected automatically if there are no open 
models listed in the dialog. 

OK — Create a drawing converted to 2D geometry representation in 
the specified model. 

 

Creating a title block on a drawing 
A title block is a block of text containing: 
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 PowerSHAPE and its version number 

 Name of the sheet 

 Date 

 Name of the author. 

When you create a title block, a border is added around the drawing 
and the text. 

 
To add a title block: 

1 Ensure the drawing window is open (see page 41) and is the 
current window. 

2 Select Tools > Create Titleblock from the menu. 

You can edit the text (see page 126). 

You can update the title block to the current details by creating the 
title block again. 

 

How do I create objects on a drawing? 
You can create objects on the drawing in exactly the same way as 
you would in a model. 

 The workspace of the drawing is only 2D; so if you create a 
3D object such as a surface on a drawing, its view is 
constrained to the XY plane. Refer to the chapters on 
individual objects for further information on how to create 
them. 
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The origin of the global workspace is in the bottom left corner of the 
drawing and is marked by a circle with a cross as shown below. You 
can edit its position using the Edit Drawing dialog. See Edit Drawing 
dialog (see page 17) for further details on how to use this dialog. 

 
 

Editing a drawing 
Use one of the following methods to edit a drawing:  

 Double-click on the drawing to display the Edit Drawing dialog 
(see page 17).  

 Right-click in an empty space in the drawing to display the 
context menu. Click Select from the context menu to display the 
Edit Drawing dialog (see page 17). 

 If you try to delete model geometry in a drawing view, the 
geometry is blanked from the view rather than being deleted 
from the model. 

Edit Drawing context menu 
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Select — Select the drawing. 

Copy — Copy the drawing. 

Paste — Paste a drawing that you copied. 

Paste Special — Attaches the copied geometry to the cursor and 
does not paste until you click the position you want. 

Delete — Delete the drawing. 

Convert... — Display the Convert Drawing dialog (see page 13). 
This option exports a 2D wireframe representation of a drawing 
to a view or another model. The drawing can be converted to an 
open model or to a new model. Using this option is the preferred 
alternative to converting views on drawings within a model. 
Specify Convert settings on the Drafting > Views > General page 
(see page 83) of the Options dialog.  

Update — Update the out-of-date views on the drawing. 

Update all Drawings — Update all out-of-date views in the model. 

Modify Text — Select this option to display the Text Editor dialog. 
This contains the text names and strings included on the 
drawing. 

 
Use this dialog to change the strings on the drawing in one of the 
following ways: 

 Enter the text into the String column of the dialog. Click Apply 
to make the substitution. 

 Use the Import from file button to import a .csv file that 
contains substitution text strings.  The format of the file is 
Text Name,String as follows: 

Name_1,Substitution_1 
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Name_2,Substitution_2 

 
 
 
Name_n,Substitution_n 

Modify — Display the Edit Drawing dialog (see page 17). You can 
display the Edit Drawing dialog by selecting Edit > Modify. 

 Closing a drawing does not delete it from the model. 
 

Edit Drawing dialog 
Use this dialog to edit drawings. 

 
Name — Enter the name of the drawing. Change the name of the 
drawing to something more meaningful. To use a drawing as a 
template, the name of its model must contain the word template. 
Sheet Number — Use this option to differentiate between two 
drawings with the same Name. Drawings have a unique drawing 
name in the format Name (Sheet Number); for example, Fred 
(1)........ Fred (n). If the drawing sheet numbers are not 
consecutive after you change a sheet number, renumber the sheets 
automatically by selecting Yes when asked if you wish to renumber. 

Description — Enter a description of the drawing and its contents. 

Update Views — Click this button to update the contents of all the 
hidden and section views in the drawing. 

Flatten Geometry — Click this button to flatten 3D wireframe objects 
onto the drawing (the Z coordinate of the objects becomes zero). 
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Template — You can use a drawing from another model as a 
template. 

 This button is available only when you are editing a drawing 
in a template model. The model must have the word template 
in its name, to use a drawing as a template. 

1 Click the Template Settings button to display the Template Settings 
dialog. 

 
2 Use this dialog to specify where balloons are positioned. Balloons 

can be positioned in the following places: 

 On view border (default). The view border is indicated by the 
green arrow on the drawings included below. 

 
 Outside view border 

 
The option you choose affects the position of the balloons in all 
drawings that you create using the drawing template.  
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 When you are creating model drawings, you select the 
template to be used from the Model list in the Edit Drawing 
dialog. 

Size — The default dimensions of the drawing. To edit the size of 
the drawing, select the Size option, You can edit the Width and 
Height of the drawing or select a standard paper size from the list. 

Origin — Edit the origin of the global workspace of the drawing. By 
default, the origin is in the bottom-left corner of the drawing and is 
marked by a circle with a cross: 

 
To specify the coordinates: 

 Enter X, Y, Z coordinates. 

  Position — Click this button to display the Position dialog to 
use position-entry tools 

OK — Make the changes to the drawing and close the dialog. 

Cancel — Discard any changes and close dialog. 
 

Drawing templates 
Drawing templates are used to set up standard drawing layouts, 
including title blocks and views. 

Setting up drawing templates (see page 19) 

Using drawing templates (see page 20) 

Setting up component drawing templates (see page 21) 

String variables for drawing templates (see page 22) 
 

Setting up drawing templates 
Set drawing templates in the following ways: 

 Using the default drawing creation method from the Drawing 
Options dialog. 

 From the Edit Drawing dialog (see page 17). 
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Drawing templates can contain views. If the drawing does not 
already contain views, views are copied from the template drawing 
when the template is set.  

The created views: 

 display the geometry currently displayed in the model window.  

 have the same attributes as the views in the template model. For 
example, shaded or hidden views.  

The view settings can be used to control the way in which the scale 
is set in the created views. For further details, see Edit View dialog 
(see page 104). 

You can set views to hidden only if they contain surfaces or solids.  

 To set up a hidden view in a drawing template you must 
create solid or surface geometry in the view before setting the 
view as hidden. 

Any geometry displayed in a template drawing view is ignored when 
a drawing template is set. The geometry is simply an aid in setting 
up the view. 

Any balloons created from a template drawing point to the relative 
position of the created drawing. Balloons that point to specific 
coordinates in a template drawing follow the workplane coordinates 
of the created drawing. When the active workplane is defined on the 
model, balloons point the the coordinates determined by that 
workplane. 

Levels in a view are copied from the views set up in the drawing 
template. We recommend that all the view levels in drawing 
templates are set to ON. For further details, see Edit View dialog 
(see page 104). 

 If view levels are set OFF, the geometry on those levels will 
not be displayed in the created views. 

 

Using drawing templates 
To use a template: 

1 Select the Template option on the Edit Drawing dialog. (see page 
17) 

2 Use the Model list to select the model you want. 

To use a drawing as a template, the model must have the 
word 'template' in its name. 

3 Use the Drawing list to select a drawing contained in that model. 

4 Click OK. 
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Setting up component drawing templates 

 This is specialised functionality for component drawings used 
in Delcam Toolmaker. 

You can make the following changes to the drawing templates: 

 If the template has a view called Bitmap View then the 
component drawing is placed at the position of Bitmap View, 
indicated by  in the image below. 

You can create multiple views by adding a suffix to the name of 
the view. For example Bitmap View_1, Bitmap View_2. The 
template above provides for a single view, so in this case, 
Bitmap View is placed on the drawing. Bitmap View_1 and 
Bitmap View_2 are placed on a new drawing. 

 If a text exists that starts Parameter table position then the 
parameter table is placed at that position. In the template shown 
below, this is indicated by . The maximum height of the table 
can be given by having End as the final part of that text item. 

 For components with a trimmed length parameter, a table is 
produced of the trimmed lengths if a text exists that starts 
Trimmed table position. In the template above, this is indicated 
by  in the image shown below. 
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 If a template drawing exists that has the same name as the 
component, that drawing is used. For example, if a drawing 
called Ejector plate exists in the template model then all ejector 
plates use that drawing. There can be several related drawings 
(for example, Ejector plate_1, Ejector plate_2), in which case the 
drawing that gives the best view, in terms of scaling, is 
displayed. 

 
 

Text substitutions for drawing templates 
Use the Text Substitution dialog to manage, add, and edit drawing 
template properties. You can 

 add general properties to drawing templates (see page 23). 
Properties such as, %[author], %[date] are substituted with the 
relevant text when the drawing is created. 

 add electrode specific properties (see page 24), for example, 
%[electrode_name], %[roughing], %[finishing]. 
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 add fixed parameters (see page 26), these are user-defined 
parameters. 

 

Adding a General property to a drawing template 

1 Click  to display the annotation toolbar. 

2 Click  and click a position on the drawing where the text will 
be positioned. 

3 Enter a label, if required. 

 

4 Click  (Annotation toolbar) to display the Text Substitutions 
dialog. 
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5 Select the required substitution string. 

 
6 Select Live value option to re-evaluate the substitution whenever 

the text is drawn. 

7 Click Apply. 

 
8 Click Cancel and click the drawing to display the substituted text. 

In this example, the name of the model was sub-text. 

 
 

Adding an electrode substitution string to a drawing 
template 

1 Click  to display the annotation toolbar. 

2 Click  and click a position on the drawing where the text will 
be positioned. 
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3 Enter a label, if required. 

4 Click  (Annotation toolbar) to display the Text Substitutions 
dialog. 

5 Select the Electrode tab. 

 
6 Use one of the following methods to enter the required 

substitution string: 

 Select the required substitution string. 
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 Click  to enter an expression using the Electrode Calculator 
dialog 

 
Use the options on the dialog to enter an expression. For 
example, the following expression gives a safe height of 10 
above the part: 
%part_max_z + 10 

7 Click Apply. 

 
8 Click Dismiss and click the drawing to display the substituted text 

 

Adding a fixed parameter substitution string to a drawing 
template 

1 Click  to display the annotation toolbar. 

2 Click  and click a position on the drawing where the text will 
be positioned. 

Enter a label, if required. 

3 Click  (Annotation toolbar) to display the Text Substitutions 
dialog. 
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4 Select the Parameter tab. 

 
5 Select the required substitution string. 

 
6 Click Apply. 
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7 Click Dismiss and click the drawing to display the substituted 
text. 

 

Creating Component Drawings 
You can create component drawings for standard and non-standard 
components. 

To create a Component drawing: 
1 Select Drafting from the Module menu. 

2 Select Toolmaker from the Module menu. 

3 Select the model or portion of the model. The drawing that is 
produced will be based upon the selection that you have made at 
this point. If you only select part of the assembly, your drawing 
will be based on the selection. If you do not select a particular 
part of the assembly, the component drawing will include all the 
components. 

4 Select Component Drawing from the Tools menu. The Component 
Drawings dialog is displayed. 

 
Standard components — Create a component drawing for all 
standard components. These are components contained in the 
catalogues that are available. 

Non-standard components — Create a component drawing of all 
non-standard components. These are standard catalog 
components that you have modified in some way (for example a 
bolt where you have increased the length or diameter) 

User-defined components — Create a component drawing for 
user-defined components. These are components that you have 
created from a solid. 

Create GA sheet — If ON, the GA sheet for your selection is 
created. This will include an embedded Bill of Materials. You can 
define the columns of the data that are displayed by modifying 
the component drawing template. For further details, see 
Defining the BOM parameters on the GA sheet (see page 31). 
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If ON and the component drawing template contains drawings 
prefixed with ga_sheet, the appropriate drawings will be created.  

Create shaded GA sheet — If ON, the shaded GA sheet for your 
selection is created. If ON and the component drawing template 
contains drawings prefixed with shaded_ga_sheet, the 
appropriate drawings will be created. 

OK — The drawing is created, based on your selection. The 
appropriate component template is automatically selected for 
each type of component to allow your component drawing to be 
closest to 1:1 scale.  

An information dialog is displayed that shows the number of 
component drawings that are created. 

 

Viewing the Component Drawings 
To view the individual component drawings: 

1 Select Open Drawing from the File menu.  

2 Select the required component drawing from the list. 

 
 

Customising the Component Drawings 
To change the appearance and contents of the component drawings 
you need to edit the component drawing template. The component 
drawing template must be in your shareddb before it can be 
modified. 

The component drawing template can be added to your shareddb 
by: 

 Creating a component drawing with the supplied component 
template. 
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 Importing the template from the C:\Program 
Files\Delcam\powershapeXXXX\file\assembly,where PowerSHAPE 
is installed on drive C of your computer. 

Once the template is in your shareddb, you can modify the template 
as follows: 

1 Select Open from the File menu. From the list, select component 
drawing template file and click Open. 

 
2 Select Open Drawing from the File menu. From the list select the 

template you wish to modify.  

 
The following templates are included. By default, X indicates the 
size and is in the range 0 to 4 to reflect A0 to A4 sizes. 

component_sheet_plate_X - plate components. 
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component sheet_rotational_X - rotational components. 

component_sheet_userdefined_X - user-defined components. 

component_sheet_X - other types of components. 

3 Use the techniques that are used to change Drawing Templates 
to customise the views, hole schedules, and table positions in the 
templates as follows: 

 If text exists that starts Parameter table position then the 
parameter table will be placed at that position. The maximum 
height of the table can be given by having End as the final 
part of that text item.  

 For components with a trimmed length parameter, a table will 
be produced of the trimmed lengths if a text exists that starts 
Trimmed table position.  

 If the component drawing template contains drawings 
prefixed with the following, 

ga_sheet  

shaded_ga_sheet  

the appropriate drawings will be created if the Create GA Sheet 
or Create shaded GA Sheet option on the Component Drawing 
dialog is selected. 

 

Defining the BOM parameters on the GA sheet 
You can define the columns of data to be included in the embedded 
Bill of Material on the GA sheet by specifying the parameters on the 
Component Drawing template. 
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1 Select Open from the File menu. From the list, select the 
component drawing template file and click Open. 

 
2 Select Open Drawing from the File menu. From the list select the 

template you wish to modify and click OK. 
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3 Select ga_sheet. 

 
If text exists that starts BOM position then the parameter table 
will be placed at that position. The maximum height of the table 
can be given by having End as the final part of that text item.  

4 Select the BOM position list by double-clicking or clicking with the 
right mouse button and selecting Modify from the context menu. 
You can now change the content of the embedded Bill of 
Materials by changing the individual entries in the list. The 
example shows a column with the label Description. You could 
modify this text to Desc by changing the parameter to Column 
Desc.  

 

Additional BOM parameters for use in Component 
Drawings 

The following BOM parameters can be added to Component 
Drawings: 

 
Menu  String 
Label Label 

Item Item 

Part Part 

Description Description 

Catalogue Catalogue 

Material Material 

Diameter Dim1 

Length Dim2 

Width Dim3 

Height Dim4 
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Rough Diameter RoughDim1 

Rough Length RoughDim2 

Rough Width RoughDim3 

Rough Height RoughDim4 

Volume Volume 

Weight Weight 

Quantity Quantity 

Level Level 

Level Name LevelName 

Comments Comments 

Drawing LabelDrawing 

View LabelView 

 
 

Adding extra columns to a schedule of holes on 
Component Drawings 

Find the string to add to the template in one of the following ways: 

 Identify the string to be added using the lists in Additional 
schedule parameters for use in Component Drawings (see page 
37). 

 Record a macro as described below.  

Recording a macro to add a column 
If you want to add a column to display the Thread Top Diameter of 
holes: 

1 With a model selected, enter Drafting mode . 
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2 Click  Create new drawing on the dialog to display a new 
drawing in the graphics window. 

 
3 Create an object on the drawing and make it active. 

4 Select Macro > Record from the Tools menu. This displays Select a 
file to record to dialog. 

5 Enter an appropriate filename for your macro. 

6 Click Schedule  (Drafting toolbar), to display the Schedule 
toolbar 
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7 Click Hole schedule  (Schedule toolbar) to display the Hole 
schedule dialog. 

 
8 Click Column > Thread Details > Thread Top Diameter to select the 

option that you require from the sub-menu. 

9 Click OK. 

10 Select Macro > Record from the Tools menu to stop recording the 
macro. 

11 Open the macro file with a text editor. The commands will look 
like this: 

Create Schedule Schedule 
SCHEDCOLUMNS ON THREADTOPDIAMETER 

CANCEL 

The item that you are interested in is THREADTOPDIAMETER 

This needs to be added to the Component Drawing template. 

12 Open component_drawing_template.psmodel as described in 
Customising the Component Drawings (see page 29). 

13 Using the method described in Defining the BOM parameters on 
the GA sheet (see page 31), open the required drawing 
templates. Schedules appear in the drawing templates: 

component_sheet_plate_X - plate components. 

component_sheet_userdefined_X - user-defined components. 
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14 For each drawing template that is to display the additional 
column, double-click the Schedule list and add the following into 
the list: 

COLUMN THREADTOPDIAMETER  

The next time you create component drawings, you should see the 
new columns. 

 

Additional schedule parameters for use in Component 
Drawings 

The following schedule parameters can be added to Component 
Drawings: 

 
Menu String 
Label Label 

X TopX 

Y TopY 

Z TopZ 

Bottom X BottomX 

Bottom Y BottomY 

Bottom Z BottomZ 

Rotation X RotationX 

Rotation Y RotationY 

Direction Direction 

Thread Diameter ThreadDiameter 

Thread Top Diameter ThreadTopDiameter 

Thread Base 
Diameter 

ThreadBaseDiamete
r 

Thread Pitch ThreadPitch 

Through Thread ThroughThread 

Thread Depth ThreadDepth 

Thread Start Z ThreadStartZ 

Thread ThreadName 

Limit/Fit LimitFit 

Tolerance Tolerance 

Max Tol MaxTol 
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MinTol Min Tol 

2nd Max Tol MaxTol2 

2nd Min Tol MinTol2 

Through Hole ThroughHole 

Depth Depth 

1st Depth FirstDepth 

2nd Depth SecondDepth 

3rd Depth ThirdDepth 

Diameter Diameter 

FirstDiameter 1st Diameter 

SecondDiameter 2nd Diameter 

3rd Diameter ThirdDiameter 

Chamfer Size ChamferSize 

FirstChamferSize 1st Chamfer Size 

2nd Chamfer Size SecondChamferSize 

3rd Chamfer Size ThirdChamferSize 

Chamfer Angle ChamferAngle 

1st Chamfer Angle FirstChamferAngle 

2nd Chamfer Angle SecondChamferAng
le 

3rd Chamfer Angle ThirdChamferAngle 

Hole Category HoleCategory 

Hole Use HoleUse 

Name Name 

Predrilled Pre-drilled 

Level Level 

LevelName Level Name 

Comments Comments 

 
 

Notes 
Use the following sections to create and edit Notes drawings in 
PowerSHAPE. 



 

PowerSHAPE 2015 R2 Reference Help Delcam Draft • 39  

Introduction to Notes drawing (see page 39) 

Create a Notes drawing (see page 39) 

Update a Notes drawing (see page 40) 

Close a Notes drawing (see page 41) 

Open a Notes drawing (see page 41) 

Edit a Notes drawing (see page 41) 

Customising a Notes drawing (see page 42) 
 

What is a Notes drawing? 
A Notes drawing is one with pre-defined views and a title block. 

 
You can annotate this drawing using dimensions and text. 

 

Creating a Notes drawing 
To create a Notes drawing open the model you want to create a 
drawing for, as shown in the example below.  

 
From the Window menu, select Notes. 
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If a Notes drawing does not exist, this creates a drawing containing 
4 views of the objects currently displayed in your model. 

 
If a Notes drawing exists, then the existing Notes drawing is 
displayed. For further details, see Opening an existing Notes 
drawing (see page 41) and Updating an open Notes drawing (see 
page 40). 

The directions of the views in the Notes drawing are given below. 

 
The contents of the views are automatically scaled to fit the view 
boundaries. 

Only one Notes drawing can be created per model. 

You can store the layout of a Notes drawing to use in all your future 
models. For further details, see Customising a Notes drawing (see 
page 42). 

 

Updating an open Notes drawing 
If you have a Notes drawing open in your model when you update 
the model, the Notes drawing is updated too.  To open the Notes 
drawing in your model : 
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1 Select Notes from the Window menu. 

By default, all new objects created in the model are 
automatically added to the views. The contents of the view are 
automatically rescaled to fit the view boundaries. 

2 You can change settings for any one of the views by turning off 
the Add Items and Auto Rescale options on the Edit View dialog. 
For further details, see Editing a view (see page 100). 

 

Closing a Notes drawing 
You can close the Notes drawing by selecting Close from the Window 
menu. 

The Notes drawing and any objects created on it are stored with the 
model.  

To open a stored Notes drawing, see Opening an existing Notes 
drawing (see page 41). 

 

Opening an existing Notes drawing 
To open a stored Notes drawing, simply select Notes from the 
Window menu. 

By default, 

 all new objects created in the model are automatically added to 
the views. 

 the contents of the view are automatically rescaled to fit the view 
boundaries. 

For any one of the views, you can change the above behaviour by 
turning off the Add Items and Auto Rescale options on the Edit View 
dialog. For further details, see Editing a view (see page 100). 

 

Editing a Notes drawing 
Notes drawings can be edited like a drawing. For further details, see 
Editing a drawing (see page 15). 

The views on the Notes drawing are edited like other drawing views. 
For further details, see Editing a view (see page 100). 

If you change the name of the Notes drawing, then a new Notes 
drawing is created next time you select Notes from the Window 
menu. 
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Customising a Notes drawing 
You can modify the layout of a Notes drawing to your requirements 
and store this to use in all your future models. 

To create a customised Notes drawing: 
1 Create a Notes drawing in the template model, 

NEW_MODEL_MASTER. 

2 Edit the Notes drawing to your requirements. 

You can add objects to the Notes drawing in the template model. 

When you create a Notes drawing in future models, the Notes 
drawing from the template model will be used. 

For further details, see Using drawing templates (see page 20). 
 

Views 
Different views of a model are created by looking at a model from a 
different direction. You can have many views on a drawing, each 
showing a different projection of the model. 

You can also edit a model through a view on a drawing. 

The drawing below shows views of different projections of a model. 

 
Use the following sections for more details on Views: 
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View creation (see page 43) 

Changing the settings of a view (see page 82) 

Activating a view (see page 93) 

Creating new objects in a view (see page 93) 

Updating a view (see page 94) 

Graphically editing views (see page 95) 

Editing a view (see page 100) 

 You can improve the quality and speed of hidden line views if 
you create a solid of your model where possible before 
drafting from it. This will also improve the accuracy of 
dimensioning. For further details, see Creating a solid. 

 

View creation 

1 Click  (Main toolbar) to display the Drafting toolbar.  

 This is the same as hovering over  and selecting  
from the flyout. For further details, see Flyout overview. 

 
The Drawing Selector dialog is displayed where you select an 
existing drawing or create a new drawing. The Drafting toolbar is 
also displayed.  
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This is the same as selecting Object > View, to display the View 
creation options. 

 
Each option in the View creation menu is described below: 

 Single view (see page 44) 

 Relative view (see page 48) 

 Section view (see page 52) 

 Section with background view (see page 64) 

 Limited view (see page 78) 

 OLE view (see page 80) 

 You can improve the quality and speed of hidden line views 
if you create a solid of your model where possible before 
drafting from it. This will also improve the accuracy of 
dimensioning. For further details, see Creating a primitive 
solid in the Solid Modelling manual. 

 

Creating a single view 
You can create a single view of either the whole model or of 
selected objects from the model.  

1 Click  (Main toolbar) to display the Drafting toolbar.  

 This is the same as hovering over  and selecting  
from the flyout. For further details, see Flyout overview. 
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The Drawing Selector dialog is displayed where you select an 
existing drawing or create a new drawing. The Drafting toolbar is 
also displayed.  

2 Select the required drawing window from the Windows menu.  

If you do not have a drawing already open, you need to create a 
drawing or open an existing drawing. For further details, see 
Creating a new drawing (see page 8) and Opening existing 
drawings (see page 10) 

To create a drawing of the model below: 

 

1 Click  (Drafting toolbar) to display the view creation tools. 

2 Click  (View creation menu). 

As you move the cursor around the drawing window, the view is 
attached to the cursor and is ready to be placed on the drawing. 
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3 Click on the drawing where you want to place the view. 

 
When you input the position, the view is drawn on the drawing. 

 

 Blanked objects in the model are not drawn in the view. 

 By default, the view is looking down the top of the world 
space (that is the -Z axis). You can change this by editing the 
view. For further details, see Editing a view (see page 100). 
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In our view, you can see a mark made of a circle and two lines 
that cross. This marks the origin of the view. For further details, 
see Edit View dialog (see page 104). 

 
When you create a single view, you can create a relative view to it. 
The Relative view option is automatically selected in the View creation 
menu, ready for you to create relative views. For further details, see 
Creating a relative view (see page 48). 

 

Creating a single view of selected objects 
To create a single view of selected objects: 

1 Click  (Main toolbar) to display the Drafting toolbar.  

 This is the same as hovering over  and selecting  
from the flyout. For further details, see Flyout overview. 

 
The Drawing Selector dialog is displayed where you select an 
existing drawing or create a new drawing. The Drafting toolbar is 
also displayed.  

2 If you do not have a drawing already open, you need to create a 
drawing or open an existing drawing. For further details, see 
Creating a new drawing (see page 8) and Opening existing 
drawings (see page 10) 

3 From your model window, select the objects you want to display 
in the view. For further details, see Selecting objects. 

4 Click  (Drafting toolbar) to display the view creation tools. 

5 Click  (View creation menu). 

6 From the Window menu, select the drawing window. 
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As you move the cursor around the drawing window, the view is 
attached to the cursor and is ready to be placed on the drawing. 

7 Click on the drawing where you want to place the view. 
 

Creating a relative view 
A relative view is a projection of the model from the side of an 
existing view. 

The image below shows four relative views to the view of the top of 
the model (using third angle projections). 

 

To create a relative view: 

1 Click  (Main toolbar) to display the Drafting toolbar.  

 This is the same as hovering over  and selecting  
from the flyout. For further details, see Flyout overview. 

 
The Drawing Selector dialog is displayed where you select an 
existing drawing or create a new drawing. The Drafting toolbar is 
also displayed.  

2 Make sure you have a drawing with at least one view on it. 
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If you do not have a drawing already open, you need to create a 
drawing or open an existing drawing. For further details, see 
Creating a new drawing (see page 8) and Opening existing 
drawings (see page 10) 

If you have no views on your drawing, create a single view. For 
further details, see Creating a single view (see page 44). 

3 Click  (View creation menu). 

4 Hover the mouse over a view on your drawing. The cursor 
changes to an arrow to indicate the direction of the new view in 
relation to the existing view. 

 
As you move the mouse around the view, the arrow changes 
direction for the other relative views. 

You can create an Isometric view by moving the mouse over a 
corner of the view. 

5 When the arrow changes to the direction you want, click the 
mouse. The new relative view appears on the specified side, 
ready for you to position. 

The side the view appears depends on whether the Third angle 
option (see page 50) on the Views Options dialog > General page 
(see page 83) is selected. 

6 Click on the drawing to position and create the new view. 

The new view usually is created next to the edge of the view 
where the projection is taken. 
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Third angle option 
The side the view appears if the Third angle option on the Tools > 
Options > Drafting > Views > General (see page 83) page is 
selected. 

If Third angle is OFF, projections are in the first angle. The default 
setting for Third angle is ON. 

If Third angle is ON, the relative view appears on the side nearest to 
where you clicked the mouse. If Third angle is OFF, it appears on the 
opposite side. 

 
 Third angle OFF 

 Third angle ON 
 

Section views 
You can create a section view to show a cross section view of the 
model. This option does not show background detail. For further 
details, see Creating a section view with background detail (see 
page 64).  
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Specify the settings for section views, and annotation displayed on 
section views, on the Tools > Options > Drafting > Views > Section 
(see page 85) page. In the diagram below, the view on the right is 
a section view of that on the left. 

 
The ink bottle (on the left) has been cut along the vertical line to 
give two pieces, one on either side of the line. 

 
The edges of the pieces along the cut are used to define the 
sectional view. Arrows are added to the line to define the viewing 
direction. 

A line, which cuts a part to define a section view, is called a section 
line. For further details, see Creating a section line using the Section 
Line toolbar (see page 56). 

You can have more than one sectional view on a drawing. To 
identify which section line belongs to a sectional view, a letter is 
placed at the top and bottom of the line and the sectional view has 
underneath it the word SECTION followed by the letter. 

A warning cross is displayed across section and hidden views when 
they need to be updated because there has been a change to the 
model. The drawing of crosses is on by default and can be turned 
off by typing the following in the command window. 

view_options mark_updated off 
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To create a section view of the following view on a drawing: 

 
The following section view creation methods are available. 

 Creating a section view (see page 52). 

 Creating a section view with background detail. (see page 64) 

 Creating Angular and Stepped section views. (see page 69) 

 Creating Scrap Sections (see page 73) 
 

Creating a section view 

1 Click  (Main toolbar) to display the Drafting toolbar.  

 This is the same as hovering over  and selecting  
from the flyout. For further details, see Flyout overview. 

 
The Drawing Selector dialog is displayed where you select an 
existing drawing or create a new drawing. The Drafting toolbar is 
also displayed.  

2 Make sure you have a drawing with at least one view on it. 

If you do not have a drawing already open, you need to create a 
drawing or open an existing drawing. For further details, see 
Creating a new drawing (see page 8) and Opening existing 
drawings (see page 10) 

If you have no views on your drawing, create a single view. For 
further details, see Creating a single view (see page 44). 

3 Use one of the following methods to create a line through the 
view where you want the section: 
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 Create a section line automatically by using the Section Line 
toolbar (see page 56). For further details, see Creating a 
section line using the Section Line toolbar (see page 56). 

 Draw a single line through the view. For further details, see 
Creating a line in the Wireframe modelling manual, and 
continue to follow the steps described below. 

 Create a composite curve from a series of orthogonal lines to 
define a Stepped section (see page 69). For further details, 
see Selecting objects in the Modelling Concepts manual, and 
continue to follow the steps described below. 

 
The line or composite curve can be shorter than the view it lies 
in. This creates a section view of the portion of the view where 
the line or composite curve lies.  

4 Select the line or composite curve. 

 

5 Click View  (View creation menu). 

6 Click Section View with Background  (View creation menu). 
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Arrows are drawn on the line to define the viewing direction. 

 
The outline of the new view moves with the cursor. 

7 Click one of the arrows if you wish to change the viewing 
direction. 

 
The arrows change direction to indicate that the viewing direction 
has changed. 
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8 Click on the drawing to place the view. Alternatively, you can 
select a different drawing to place the section view. For further 
details, see Positioning section views on a different drawing (see 
page 69). 

 
The section view is drawn. 

 
If you selected the section with background view, the 
background detail is drawn too. For further details, see Creating 
a section view with background detail. (see page 64) 

 
If you select either of the Hide options from the View context menu, 
or Hidden on the Edit View dialog (see page 104), background detail 
is hidden in section views.  For further details, see Editing a view 
(see page 100). 
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Creating a section line using the Section Line toolbar 
Use the Section Line toolbar for creating section lines through 
features and points in drawing views. When you accept the section 
line, a section view is created ready for you to put in position on 
your drawing.  

Use the following sections to explore how to create section lines for 
section views. 

 Section Line toolbar (see page 56) 

 Creating a section line through features (see page 57) 

 Creating a section line through points (see page 58) 

 Creating a stepped section line using the Section Line toolbar 
(see page 59) 

 Editing a section line. (see page 61) 

 It is still possible to create a section line manually, by drawing 
a single line through the view, or by creating a composite 
curve from a series of orthogonal lines. For further details, 
see Creating a section view (see page 52). 

 

Section Line toolbar 
1 Click Object > View > Section. 

2 Click OK on the Information dialog to display the Section Line 
toolbar. 

 
3 Select the View to section using the drop-down list on the Section 

Line toolbar. 

4 Use Set feature recognition  to choose the mode for creating a 
section line (see page 56). 

This option has two modes: 

 for creating a section line through features (see page 56) 

In feature mode, solid features are highlighted as you move the 
cursor over them in the view. Select a feature to create a section 
line through the centre of the feature. If there is no feature 
under the cursor, the section line is created through the point. 

 for creating a section line through points (see page 56) 

In point mode, features are not recognised and section lines are 
created through the points entered.  
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 You can combine features and points in your section lines. 

5 When you have created a section line, the other options become 
available on the toolbar. 

 
The following buttons are also displayed on the Section Line 
toolbar: 

 Toggle direction of the section line. This is the same as 
clicking on the view's instrumentation to change the direction of 
the section line direction from horizontal to vertical, or from 
vertical to horizontal. 

 
 Accept changes and finish — A section view is created ready for 

you to place in position on the drawing. 

 Cancel all changes and finish. 
 

Creating a section line through features 
1 Click Object > View > Section. 

2 Click OK on the Information dialog to display the Section Line 
toolbar. 

 

3 Click Set feature recognition  to change the section line 
creation mode to Features. 
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4 Move the cursor over the view. The features are highlighted 
automatically. 

 
5 Click on any feature in the view and a section line is drawn 

automatically through the centre of the feature. 

 
6 Click  to accept the changes. 

Section view creation is started automatically, ready for you to 
place the section view in position on the drawing. 

 

Creating a section line through points 
1 Click Object > View > Section. 

2 Click OK on the Information dialog to display the Section Line 
toolbar. 

 

3 Click Set feature recognition  to change the section line 
creation mode to Point. 

 Point mode is useful for avoiding clashes between section 
features. 
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4 Click in the view to create a point for the section line. 

 
A section line is drawn automatically through the point. 

 
5 Click Accept changes and finish . 

Section view creation is started automatically, ready for you to 
place the section view in position on the drawing. 

 

Creating a stepped section line using the Section Line toolbar 
1 Click Object > View > Section. 

2 Click OK on the Information dialog to display the Section Line 
toolbar. 

 

3 Use Set feature recognition  to choose the mode for creating a 
section line (see page 56). You can create a stepped section line 
to include features, points or a combination of both. 
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4 Click to create a point or click on a feature in the view to create a 
section line automatically, as described in Creating a section line 
(see page 56). 

 
5 Click on another feature or create another point for the stepped 

section line. 

 
The section line is drawn and steps automatically through each 
feature or point selected. 
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6 You can continue to click on other features or points to created a 
stepped section line automatically. 

 
7 Click Accept changes and finish . Section view creation is started 

automatically, ready for you to place the section view in position 
on the drawing; shown in the example below: 

 
 

Editing a section line 
To change a section line before a section line is accepted: 

1 Click on the section line. 
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2 Drag the line to a different position. 

 

 
To changing a section line after a section line is accepted and a 
section view has been created: 

1 Double-click on the section line to display the Section Line 
toolbar.  

2 Drag the line to the new position.  

The section view displays a red cross to show that the view is out of 
date because the section line has been changed. 
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 To update the section view, click on the view using the right 
mouse button and select Update. This is the same as selecting 
Update on the Edit View dialog. 

 
Using undo: 

Use Undo to step back during section line creation. 

 Redo is not currently available 

Deleting a section line 
1 Click on a section line to select it  

2 Click Delete . 

When you delete a section line, a Query dialog is displayed to ask 
you to proceed with deleting the section view. If you delete the 
section view, the section line is also deleted. 

 

Section views with background detail 
You can create a section view that displays the background detail of 
a section. 
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The background detail is the view of the model through the section. 

 

 

See Also: 
Section views (see page 50) 

Creating a section view (see page 52) 

Creating a section view with background detail (see page 64) 
 

Creating a section view with background detail 
To create a section view with background detail: 

1 Click  (Main toolbar) to display the Drafting toolbar.  

 This is the same as hovering over  and selecting  
from the flyout. For further details, see Flyout overview. 

 
The Drawing Selector dialog is displayed where you select an 
existing drawing or create a new drawing. The Drafting toolbar is 
also displayed.  

2 Make sure you have a drawing with at least one view on it. 
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If you do not have a drawing already open, you need to create a 
drawing or open an existing drawing. For further details, see 
Creating a new drawing (see page 8) and Opening existing 
drawings (see page 10) 

If you have no views on your drawing, create a single view. For 
further details, see Creating a single view (see page 44). 

3 Use one of the following methods to create a line through the 
view where you want the section: 

 Create a section line automatically by using the Section Line 
toolbar (see page 56). For further details, see Creating a 
section line using the Section Line toolbar (see page 56). 

 Draw a single line through the view. For further details, see 
Creating a line in the Wireframe modelling manual, and 
continue to follow the steps described below. 

 Create a composite curve from a series of orthogonal lines to 
define a Stepped section (see page 69). For further details, 
see Selecting objects in the Modelling Concepts manual, and 
continue to follow the steps described below. 

4 Select the line or composite curve on the section view. 

5 Click View  (View creation menu). 

6 Click Section View with Background  (View creation menu). 

 
The line or composite curve can be shorter than the view it lies 
in. This creates a section view of the portion of the view where 
the line or composite curve lies.  
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1 Select the line or composite curve. 

 

2 Click View  (View creation menu). 

3 Click Section View with Background  (View creation menu). 

Arrows are drawn on the line to define the viewing direction. 

 
The outline of the new view moves with the cursor. 

4 Click one of the arrows if you wish to change the viewing 
direction. 
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The arrows change direction to indicate that the viewing direction 
has changed. 

 
5 Click on the drawing to place the view. Alternatively, you can 

select a different drawing to place the section view. For further 
details, see Positioning section views on a different drawing (see 
page 69). 

 
The section view is drawn. 
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If you selected the section with background view, the 
background detail is drawn too. For further details, see Creating 
a section view with background detail. (see page 64) 

 
If you select either of the Hide options from the View context menu, 
or Hidden on the Edit View dialog (see page 104), background detail 
is hidden in section views. For further details, see Editing a view 
(see page 100). 

 

Creating a section view of an assembly with revolved components 
Use the Sectioned option on the component definition context menu 
to avoid sectioning a revolved component (for example a bolt), 
when creating a Section View of the assembly in Delcam Drafting. 

 
Sectioned — If ON, revolved components are hatched when a 
Section View is created. 
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If OFF, revolved components are not hatched when a Section 
View is created. 

 
 

Positioning section views on a different drawing 
When creating section views from a model, you can position and fix 
the section view on another drawing. To do this: 

1 Create a section view. 

2 Select the required open drawing from the Window menu.  

3 Position and click to fix the section view on the different drawing.  

The section label is generated for the sectioned view drawing. 
 

Angular and Stepped Section Views 
You can create angular, stepped section and angular stepped 
section views. 

For further details, see: 

 Creating angular section views (see page 71). 

 Creating a section view. (see page 52)  

Angular section view 

 



 

70 • Delcam Draft PowerSHAPE 2015 R2 Reference Help  

Stepped section view 

  

Angular stepped section view 
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Creating angular section views 
You can create two different angular section views. 

 
Align Angular Sections with Principal Axis — This functionality 
produces a section that is the same size as the original because 
it is viewed in a single direction. Using this option produces the 
top section in the above example. 

Align Angular Stepped Sections — This functionality is used for 
accurate dimensioning. This option rotates the view in order to 
display the stepped section in a flattened state to allow a 
stepped section to be measured. Using this option produces the 
bottom section in the above example. 

For further details, see Angular section view alignment option (see 
page 72). 
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Angular section view alignment options 
The two angular section view alignment options are used in a 
similar way, but produce very different results. 

 
Create a composite curves from a series of lines to define a 
stepped section. 

 
With Align Angular Sections with Principal Axis set to ON, create a 
section as shown below. 
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Notice that the stepped section is projected to produce a section 
that is the same size as the original view. This projection cannot 
be used for accurate measuring. 

Set Align Angular Sections with Principal Axis to OFF and set Align 
Angular Stepped Sections to ON. Create another section below the 
first one. 

 
The highlighted section above shows how the stepped section 
has been flattened out to give a true representation of the 
section of the hole. The flattened section can now be measured 
accurately. 

If a stepped section is less than 1mm in the view direction, the 
section line is invalid. So, in the example below, if X is less than 
1mm, the section line is invalid and an error message is 
displayed. 

 
 

Creating Scrap Sections 
A scrap section lets you see the section of an individual hole on a 
hidden view. You can also create scrap sections from hole patterns. 
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Scrap sections cannot be created in a view that is non-orthogonal to 
the model. The Scrap Sections option on the context menu is greyed 
out when it is not a viable option. 

 

 

To create a Scrap Section: 
1 Create a model similar to the one below. Create a corresponding 

drawing. Add a view and a relative view to the drawing. 

 



 

PowerSHAPE 2015 R2 Reference Help Delcam Draft • 75  

2 Right click the relative view to display the Drawing View context 
menu. 

 

 Scrap sections cannot be created in a view that is non-
orthogonal to the model. The scrap section option on the 
context menu is greyed out when it is not a viable option. 

3 Select Scrap Sections from the menu to display the Scrap 
Sections dialog (see page 76). 

4 Select one hole feature and click Add Feature. The selected 
feature is added to the Scrap Section Features list. Add additional 
features to the Scrap Section Features list as required. 

5 Click OK to mark the hole features to be displayed as a scrap 
section when the view is Hidden. 

6 Right click the relative view to display the Drawing View context 
menu. Select Hide. 
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7 The view will display any hole features that were added to the 
Scrap Section Features list. All other features are hidden. 

 
 

Scrap Sections dialog 
Use this dialog to add, edit and remove scrap sections from the 
view. 

You can also create scrap sections from hole patterns. 
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Scrap sections cannot be created in a view that is non-orthogonal to 
the model. The scrap section option on the context menu is greyed 
out when it is not a viable option. 

 
Feature — Select a hole feature on the drawing or enter the name of 
the feature. The  changes to  when you select a valid hole 
feature. 

Composite curve — When you select a Feature, the corresponding 
Composite curve is automatically selected. The  changes to  
when you select a valid hole feature. 

Clear Feature — Clear the Feature and Compcurve boxes. 

Add Feature — Add the selected feature to the Scrap Section 
Features list. 
Edit — If you select this option, you can edit the scrap section 
composite curve. The curve must remain planar and closed. Select 
Finish to complete the editing.  

 When you select Edit, this is replaced by Finish. 

Remove — Remove the selected scrap section from the Scrap 
Section Features list. 
Remove All — Remove all the scrap sections from the Scrap Section 
Features list. 
Update View — Update the view with any changes that have been 
made. 
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OK — Mark the hole features to be displayed as a scrap section 
when the view is Hidden 

Cancel — Any features that are already in the Scrap Section Features 
list are retained and the dialog is removed. 

 

Deleting section views 
When you try to delete a drawing or a view where section views 
have been created, a Query dialog is displayed to warn you of 
section view dependencies. 

 
Click Yes to delete both the section view and the view or drawing it 
is dependent on. 

 

Creating a limited view 
You can create a view (known as a limited view) of a portion of an 
existing view. 

 
To create a limited view of the drawing view shown below: 

 
1 Display the Drafting toolbar. 

2 Click  (Main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools. 

3 Make sure you have a drawing with at least one view on it. 
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If you have no views on your drawing, create a single view. See 
Creating a single view (see page 44) for further details. 

If you do not have a drawing already open, you need to create a 
drawing or open an existing drawing. For further details, see 
Creating a new drawing (see page 8) and Opening existing 
drawings (see page 10) 

4 Click  (View creation menu). 

5 Use the left mouse button to drag a box in an existing view to 
select the portion you want in the limited view. 

 
Once you selected part of the view, a dialog is displayed for you 
to enter a value to set the scale of the model in the limited view. 

 
6 Change the value in the dialog, if you want. 

7 Click OK. 

The outline of the new view is attached to the cursor. 

8 Click a position to place the new view. 
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The new view is added to the drawing with markings indicating 
where it originally came from. 

 
The scale of the limited view is displayed below the view. This 
updates if you change the scale of the view. For further details, 
see Edit View dialog (see page 104). 

 

Creating an OLE view 
An OLE view contains an OLE object such as a Word document. In 
the example below, a bitmap is inserted on the right hand side as 
an OLE view. 

 
1 Display the Drafting toolbar. 

Click  (Main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools. 

2 If you do not have a drawing already open, you need to create a 
drawing or open an existing drawing. For further details, see 
Creating a new drawing (see page 8) and Opening existing 
drawings (see page 10) 
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3 Click  (View Creation menu). 

 
4 Use the dialog to select the object you want to insert. 

The Object Type list contains all the type of objects you can insert 
into the drawing. 

To create a new object, select an object type from the list. 

To create from an existing file, click the Create from File option 
and the dialog changes to the following. 

 
Type in the path name of the file or use the Browse button. 

 You can only insert the type of files given in the Object Type 
list. This list is displayed when the Create New option is 
selected. 

 If you select the Link option, the OLE view displays the 
external file. If you make any changes to the external file, 
the view is updated too. Similarly, if you edit the OLE 
object in the view within PowerSHAPE, the external file also 
updates. 
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If you don't select the Link option, a copy of the file is embedded 
in the view. Any changes to the external file do not change the 
view. 

5 Click OK. 

6 Click on the drawing where you want to place the OLE view. 

If you are creating a new object, the object is added to the 
drawing and opened in its application, ready for you to insert 
data. When you save and close the file, you can see the contents 
of the object in the view. 

If the object is created from a file, it is drawn in the view, 
showing its contents. 

To edit the OLE object in the view, select the view and double 
click it to open the file in its application. 

 

Changing the settings of a view 
1 Select Tools > Options > Drafting > Views branch. There are the 

following pages of options: 

 General (see page 83) 

 Section (see page 85) 

 Hidden (see page 87) 

 Centrelines (see page 88) 

 Styles (see page 92) 

 The drawing view levels are now independent of the global 
level setting. This means that levels can be displayed in views 
when the global levels are set off.  
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Views Options dialog - General page 
Use this dialog to specify General default view settings. 

 
Default scale — This sets the scale of the model in the view. 

Add model items — When you create an object in a view or a model, 
you can use the Add model items option to decide where else that 
object is displayed. The table below shows where objects are 
displayed when the Add model items option is on or off. 
Add model 
items option 

Create object in Where else the object is 
displayed 

ON Model 
window 

In all views of all 
drawings 

OFF Model window Nowhere else 

ON Active view In all views in the 
current drawing and in 
the model, but not in 
any views of other 
drawings 

OFF Active view Nowhere else 



 

84 • Delcam Draft PowerSHAPE 2015 R2 Reference Help  

Display boundaries — When on, the drawing and view boundaries 
are displayed in the drawing window. The boundary of an active 
view will be displayed if the option is OFF. 

Display workplanes — Select this option to display any workplanes 
created in drawing views. The default is OFF. If the option is OFF a 
dot is drawn at the origin of the workplane in the view so that  you 
can snap to the origin. 

Third angle — When ON, a relative view is created using the third 
angle projection, otherwise the first angle is used. 

Ignore view levels — Select this option to display the content of all 
levels in the drawing view. Default is OFF.  

 Delcam Electrode users should update the levels in each view 
separately (from version 7.1). 

Convert 
Convert to: This sets the default option for the Convert command on 
the Drawing context menu.  

 
The Convert option exports a 2D wireframe representation of a 
drawing to a View or another Drawing. For further details, see 
Editing a Drawing (see page 15). 

 Drawing — Select to convert a drawing to another drawing when 
the Convert... option is selected on the Drawing context menu. 

 View — Select to convert a drawing to a view when the Convert... 
option is selected on the Drawing context menu. 

Remove duplicates — This removes any duplicates when the view is 
converted. This also defines the default setting for removing 
duplicates using the Remove duplicates option available on the 
Convert View dialog (see page 102). 
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Views Options dialog - Section page 
Use this dialog to specify default Section view settings. 

 

Settings 
Automatically hatch — When ON, section views are automatically 
hatched. 

 
Display hidden detail — If ON, hidden lines in section views will be 
displayed. 
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Align angular sections with principal axis — If ON, an angular section 
view is aligned to the nearest principal axis. If OFF, the angular 
section is aligned with the section line. In the figure below, the 
middle view is a section view with Align angular stepped sections 
turned OFF. If you create the section view with Align angular 
sections ON, the view on the right is created. For further details, see 
Creating angular section views (see page 71). 

 The dashed lines are added to the drawing to show how the 
section view is aligned. 

 
Align angular stepped sections - If ON, this option rotates the view in 
order to display the stepped section in a flattened state to allow a 
stepped section to be measured. This functionality is used for 
accurate dimensioning. If OFF, the view displays the stepped 
section. The default setting is OFF. 

See Angular section views (see page 71) for more information on 
creating angular section views. 

Section arrows point towards section line — If ON, the section arrow 
points to the section line. If OFF, the section arrow points from the 
section line. 

Display centreline where section changes direction — If selected, the 
centreline is displayed where the section changes direction.  

Annotation 
Text height — Define the height for the section annotation text. 

Colour — Select a colour of the section text from the drop-down list. 

Initial section label — Enter an initial label for an incremental label 
series that is displayed with each new section created. You can use 
a maximum of 32 characters for the label which should end with an 
alpha/numerical combination that can increment, for example Filter 
D2. 
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Views Options dialog - Hidden page 
Use this dialog to specify default Hidden view settings. 

 
When you use Hide on the Edit View dialog (see page 104) to 
perform hidden line removal, you can set the following two options. 

Remove coincident edges — Remove coincident edges in the hidden 
view. It can be time consuming to remove coincident edges in large 
models. The benefit of removing the edges is that when you plot the 
drawing, the extra edges are not drawn. If this option is off, the plot 
may contain double edges where edges overlap. 

Check for edges between continuous faces — If ON, this option: 

 Removes edges between continuous planar faces. 

 Checks for edges between non-planar continuous faces. It 
flags any found as being internal. The style of the internal 
lines is set in the Internal drop-down list. 

Detect outline — Select this option to detect the outline of a model in 
a hidden view. This locates the outline edges so a style can be 
applied. If ON, the edge is checked to see if it if an outline. 

Hide triangles — Select this option to hide triangles in a hidden view. 
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Views Options dialog - Centrelines page 
Use this dialog to specify default Centrelines view settings. 

 

General Views 
Create centre lines for views — When selected, centre lines are 
automatically created through certain solid features and primitives 
in all views except section views. How the centre line detail is drawn 
depends on the feature and the direction of the view. 
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Two lines which cross are drawn if either a hole is viewed from the 
top or a primitive block is in the view.  

 
Centrelines are displayed on blocks only in plan view (looking down 
the Z axis). 

A line is drawn along the centre if a hole, cylinder or cone is viewed 
from the side. A line is drawn along the axis of revolution for 
surfaces of revolution. 

 

Section Views 
Create centre lines — When selected, centre lines are automatically 
created through solid features and primitives in all section views. 
The centre lines drawn are only drawn if the section plane cuts the 
primitive or the feature. See Create Centre Lines for Views for details 
on how the centre lines are drawn for each feature. 

Create centre lines for cut items only — If selected, the centre lines 
are only created for cut items in the section views, otherwise 
centrelines are created for all rotated objects. 

Create Centrelines For 
Use these options to control the creation of centrelines on: 
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Solid primitives 
Solid holes 
Solid features 
Circular surfaces 
Wireframe circles 

General 
Create dependent centrelines — Select this option to create 
dependent centrelines. The option is selected by default. 

Centreline offset — Enter the required centreline offset value to 
change the amount the centreline extends past the object. The 
default centreline offset is 4.0mm. The value is stored in the model.  

Centreline style — Select a style for centrelines from the drop-down 
list.  

 Set Styles — Click to display the Style toolbar where you can 
customise a style for the centreline. 

 
Style changes are made the current style and are applied to the 
current selection. 

Creation Level  
Select one of the following options from the drop down list: 

 Line creation level — Creates a centreline on the current line 
creation level.  

 Level number — Enter the level required in the Level Number 
entry box. This creates a centreline on the specified level. 

 Level of the associated object — Creates a centreline on the level 
of the associated item. This option is available only when Create 
Dependent Centrelines option is selected. 

Level number — This option is available when the Level Number 
option is selected from the Creation Level drop-down list. Enter the 
specific level number required for centreline creation. 
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Views Options dialog - Tapped Detail 
Use this option page to specify the line style and plan view detail of 
tapped holes. 

 
Tapped hole style — Use the drop-down list to select the style for 
tapped holes. 

Alternatively, create a customised hole style by clicking  to 
display the Style toolbar. 

Circle type — Select partial circle  or full circle  from the drop-
down list. The selection is used to draw the tap detail in plan view. 
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Views Options dialog - Line Styles page 
Use this dialog to specify default line styles. 

 
Use surface colours (Hidden View) — The surfaces in the hidden 
view uses the same colour as the wireframe of the original surface. 

Visible — Use the drop-down list to select the style of the visible 
lines in the hidden view. 

Hidden — Use the drop-down list to select the style of the hidden 
lines in the hidden view. 

Outline — Select a style to be applied to the outside edges detected 
in a hidden view. For the selected style to be applied, the Detect 
outline option on the Hidden Views page of the Options dialog must 
be selected. 

Internal — Use the drop-down list to select the style of the internal 
edges in the hidden view. An internal edge is an edge that lies 
between faces that are tangent continuous. 

Section Cut — Use the drop-down list to select the style for the 
geometry that lies on the section plane. 
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 Set style — Click to display the Style toolbar, where you can 
customise your own style each of the Styles options. 

 
Style changes are made the current style and are applied to the 
current selection. 

 

Activating a view 
When a view is active you can: 

 Create and edit objects in it.  

 Select objects and key points in the active view. 

See Creating objects in a view (see page 93) for further details. 

To activate a view: 

1 Right-click in the view.  

2 From the context menu, select Active. 

The view displays a thick red border around it to show it is 
active. 

You can also use the Edit View dialog (see page 104) to activate 
a view. See Editing a view (see page 100) for further details. 

 If you delete an object from an active view, it is also deleted 
from the model and any view that contains it. 

 

Deactivating a view 
Right-click the view to display the context menu and select Active.  

 

Creating objects in a view 
1 Activate the view. For further details, see Activating a view (see 

page 93).  

2 Create objects. 

The objects are created in the 3D model and not on the drawing 
sheet. To edit these objects later on, the view must be active. 
You can also edit these objects in a model window. 

If the Add model items option is ON in the View page of the 
Options dialog, then the object is only displayed in the active 
view. If the option is OFF, then the object is displayed in the 
model and all the other views on the drawing. For further details, 
see Changing the settings of a view (see page 82). 
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You can use objects in the model. For example, snap to key 
points of objects in the model and create composite curves using 
the model. 

 

Updating a view 
Objects, in the model and not in the view, can be displayed in the 
view. You can also remove objects from a view and not the model. 

 

To add all objects to a view 
1 Activate the view. For further details, see Activating a view (see 

page 93). 

2 From the View menu, select Unblank. 

All objects, that are in the model and not in the view, are now 
displayed and selected in the view. 

 

To add only some of the objects in a view 
If you want to unblank only a few of the blanked objects, you can 
use the fact that unblanked objects are automatically selected. 

1 Activate the view. For further details, see Activating a view (see 
page 93). 

2 From the View menu, select Unblank. 

All objects, in the model and not in the view, are displayed and 
selected in the view. 

3 Be careful not to clear the selection. 

4 While all the unblanked objects are highlighted as selected, de-
select the objects you want to leave unblanked (using Ctrl-Shift-
left mouse click). 

5 From the View menu, select Blank Selected (to blank all the 
objects you want to leave blanked). 

 

To add only some of the objects in a cluttered view 
If the view is cluttered, and selecting objects to blank is difficult, 
you may find it more convenient to use Blank Toggle. 

1 Activate the view. For further details, see Activating a view (see 
page 93). 

2 From the View menu, select Blank Toggle. This blanks all 
unblanked objects and unblanks all blanked objects. 

3 De-select the objects you want to eventually leave unblanked 
(using Ctrl-Shift-left mouse click). 
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4 From the View menu, select Blank Except to blank the de-
selected objects. 

5 From the View menu, select Blank Toggle again. 

 Blanking items in model view does not cause the items to be 
blanked in drawing views. 

 

To remove objects from a view 
1 Activate the view. For further details, see Activating a view (see 

page 93).  

2 Select the objects in the view you wish to remove. 

3 From the View menu, select Blank Selected. 

The objects are removed from the view. 
 

Out of date views 
If you make changes to the model, a red cross is displayed on 
corresponding views to indicate the view is out of date. This is 
useful on more complex models.  

 
 

Graphically editing views 
Select the view to display its graphical handles.  

The cursor changes to a hand when you move the mouse over view 
instrumentation. 



 

96 • Delcam Draft PowerSHAPE 2015 R2 Reference Help  

 To select the view, right-click the view and click Select from 
the pop up menu. 

 
There are five types of handles: 

 Centre (see page 96)  

 Origin (see page 96)  

 Corner (see page 97)  

 Side (see page 98)  

 Rotate (see page 99)  
 

Centre handle 
The centre handle is used to position the view. Grab the handle and 
move the view to its new position. 

 
 

Origin handle 
The origin handle, like the centre handle, is used to position the 
view. Grab the handle and move the view to its new position. 
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Unlike the centre handle, this handle uses the intelligent cursor to 
enter positions. For example, it displays construction lines and 
labels as you pass it over key points.  

For further details, see Using the Intelligent Cursor to enter 
positions. 

 

Corner handle 
Each corner handle is used to resize the view. When you move the 
handle, the two sides attached to the handle resize. 
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When you resize the view, you see more or less of the model. The 
image below shows what you see if you shrink a view. The view of 
the model is restricted to the boundary of the view. 

 
 

Side handle 
Each side handle also resizes the view. This time only the side of 
the view with the handle is resized. 
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Rotate handle 
Click the right rotate handle to rotate the view 90  anti-clockwise 
and the left rotate handle to rotate it 90  clockwise. 

 
The model rotates within the view. 

 
 

Manipulating the model in a view 
You can manipulate your model in a view by turning and rotating it. 
To manipulate the model in a view: 
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1 Right-click the view to display the edit options. 

 
2 Select Modify to display the Edit View dialog (see page 104).  

3 Move the Edit View dialog out of the way of the view, if 
necessary. 

4 Press and hold down the middle mouse button on the view and 
use the mouse to rotate the model in model space. 

 
When you rotate a view in a drawing, the border of the view also 
rotates with the model to maintain the appropriate orientation 
with the view. For example, if you rotate a view from horizontal 
to vertical, the border also rotates to vertical eliminating the 
need to resize the borders. 

5 Click OK on the Edit View dialog to save the changes. 
 

Editing a view 
There are various ways to edit a view. 
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 Select the view (see page 103). 

Use the graphic handles (see page 95) to edit the view. The 
cursor changes to a hand when you move the mouse over view 
instrumentation. 

 Select an editing option from the Edit menu:  

 Edit > Modify displays the Edit View dialog (see page 104).  

 Edit > Convert > To Wireframe displays the Convert View to 
Wireframe dialog (see page 102), which is used to convert the 
view into wireframe.  

 Double-click the view to display the Edit View dialog. (see page 
104)   

 Right-click the view to display the edit options available for 
views. You can be in normal selection mode to right-click the 
view. When you select an option, the selection mode changes to 
drawing. 

 
Select — Select the current view. 

Copy — Copy the current view. 

Delete — Delete the current view. 

Modify — Display the Edit View dialog. (see page 104) When you 
select Modify, the ability to manipulate (see page 99) the model 
in the view is activated. 

Hide background — Remove hidden lines from the view. Hidden 
lines are lines that are not seen on the real-life model from the 
current view. Background detail is also hidden in section views. If 
there are no items to hide, an error message is displayed. This 
option is an alternative to setting the view to Hidden from the 
Edit View dialog (see page 104). 

Hide Background (with Hidden Detail) — This option does the same 
as Hide, except that hidden lines are displayed as dashed lines.  
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Convert... — Display the Convert View to Wireframe dialog (see 
page 102) to convert a view to wireframe. 

Add/Remove Items... — Display the Add/Remove Items dialog (see 
page 109) to add selected items to the view, or to remove 
selected items from the view. 

Active — Activate or de-activate the current view. 

Convert — Displays the Convert View to Wireframe dialog (see 
page 102). 

 

Convert view to wireframe dialog 
This dialog is used to convert the contents of the selected view into 
wireframe objects (lines, arcs and curves). For further details, see 
Editing a view (see page 100). 

1 Right-click the view. 

2 Select Convert… to display the Convert View to Wireframe dialog. 

 
To Drawing — This option converts the contents of the view into 
wireframe objects on the drawing. 

To View — This option also converts the contents of the view into 
wireframe objects, but the objects remain in the 3D model and 
not on the drawing sheet. To edit the wireframe objects, you 
must activate the view first. For further details, see Activating a 
view (see page 93). 

Remove Duplicates — Select or deselect to control how duplicates 
are removed when a view is converted. The default setting for 
this option defined on the Views Options dialog > General page 
(see page 83) 

OK — Convert the view to wireframe and close the dialog. 

Cancel — Ignore the command and close the dialog. 

 To prevent overlapping centreline patterns obscuring each 
other, dependent centreline geometry is merged before a 
view is converted. 
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Selecting a view 
Select a view in one of the following ways: 

 Click  and click  (Selection flyout). 

 
The Select Drawing View dialog (see page 103) is displayed. 
Select the view.  

 Right-click the view and click Select from the context menu. 

 When selecting multiple drawing views, you can use box 
selection to select the required views.  

To deselect drawing views from the total selection, use Ctrl+Shift 
and click on the view. 

 

Select Drawing View dialog 
Use this dialog to select a view and display the Edit View dialog (see 
page 104). 

 
Drawing views — This contains a list of names of views in the 
drawing. Click a name to select the view. 

Modify — Display the Edit View dialog to edit the selected view. For 
further details, see Edit View dialog (see page 104). 

OK — Select the view and close the dialog. 
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Background dialog 
Use this dialog to locate and select a background image to be 
displayed in a drawing view. It is displayed when you select  on 
the View Background dialog (see page 110). 

 
Look in — Use the drop-down list to locate the image you want to 
be displayed as a background in a drawing view. The view can be 
one of the following file types: PDF, PNG, TIF, BMP. 

Open — Open the selected file. 
 

Edit View dialog 
Use this dialog to edit the selected view. 
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Name — Displays the name of the view. You can change it to 
something more meaningful. 

Active — Activate the selected view (see page 93).  

 — Click this button to display the Level dialog. You use this 
dialog to turn levels ON/OFF in the view. 

Direction — Use this option to specify the direction of the view of the 
model relative to the workspace defined by Relative To. You can 
change the direction of the view. Each direction is shown below. 

 
Relative To — This defines the workspace used by the Origin and the 
Direction. You can change this to World or any workplane defined on 
the model. 

 — Click this button to maintain the position of balloons in relation 
to the view. When a view is locked : 

 the direction and workplane cannot be changed on the dialog 

 the view cannot be dynamically rotated.  

Scale — This changes the scale at which objects are displayed in the 
view. If you enter a value to scale the drawing view when a 
background image is used, the background image will also scale. 

To Fit — Scale the contents of the view to fit the view boundaries. 

Centre — Move the contents of the view to the centre of the view. 

Align — This allows you to align the selected view with another view 
with respect to the world or view workspace. See Aligning two views 
(see page 115) for further details. 

Items — This displays the Add/Remove Items dialog (see page 109) 
to add or remove items from views. 
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Origin — Use this option to specify the origin of the view relative to 
the workspace defined by Relative To. By default, the view origin is 
placed at the position of the origin of the current model. You can 
edit the origin so that positions are entered relative to the origin 
when the view is active. 

The origin of the view is marked by a circle and two lines which 
cross. 

 
The origin is also used to align views. For further details, see 
Aligning two views (see page 115). 

If you cannot see the view origin when you create a view, the origin 
of the world workspace lies outside the boundary of your view and 
so does the view origin. 

To change the position of the view origin 

Enter the X Y Z coordinates or click the Position  button to open 
the Position dialog where you can use position entry tools. 

To enter a new position for the view 

1 Click  to display the Position dialog  

2 Click a position for the view while the Position dialog is displayed. 

3 Click OK on the Position dialog. 

Centres — Use this option to specify whether to mark the centres of 
cylindrical surfaces. 
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 Mark — If selected, this option marks the centres of cylindrical 
surfaces. If you move the cylindrical surfaces, the centre marks 
do not move.  

 
 Mark OFF. 

 Mark ON. 

 Lines — If selected, centre lines are drawn on the following: 

 cylindrical surfaces  

 circles 

 solid cut features 

 solid boss features 

 solid bulge features 

 

 Lines OFF. 

 Lines ON. 

If you move the cylindrical surfaces, the centre lines do not 
move.  
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When you mark a centreline on a solid in a drawing view using 
the Lines option, the centreline becomes dependent on the solid. 
Therefore, if the solid is resized, the centreline adjusts 
accordingly. 

 
To prevent overlapping centreline patterns obscuring each other, 
dependent centreline geometry is merged before a view is 
converted. 

Background — Display the View Background dialog. Use this dialog 
to:  

 select a background for the view 

 change the magnification of the image 

 display specific pages of PDF files.  

For further details, see View Flags dialog (see page 111). 

Detail selector — This determines how the objects are displayed in 
the view. The menu contains a selection of hidden, wireframe, 
shaded and transparent view options. 

Hidden — The following three options are only available if the 
view is a hidden line view  
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Display hidden lines — If this option is OFF, then the hidden lines 
are not drawn. If ON, they are drawn using dashed lines. 

Hidden lines are lines that are not seen on the real-life model 
from the current view.  

Arc centre points of solid features and centre points for hole 
patterns are drawn in hidden views. If there are no items to hide, 
an error message is displayed. 

A warning cross is displayed across hidden and section views 
when they need to be updated because there has been a change 
to the model. The drawing of crosses is on by default and can be 
turned off by typing the following in the command window: 

view_options mark_updated off 
Edit — This displays the Edit Hidden View dialog (see page 112), 
that is used to edit hidden and visible lines.  

Update — Click to update the contents of a hidden or section view. 

 When a section view is updated, any hatch styles are 
maintained. 

A red cross is drawn across a view when it is out of date and 
requires updating. For further details, see Out of date views (see 
page 95). 

Flags — This displays the View Flags dialog (see page 111) to 
change various settings for the view. 

 We suggest you create a solid of your model where possible 
before drafting from it. This will improve the quality and 
speed of hidden line views. For further details, see Creating a 
solid. 

 Solid features in hidden views are highlighted when the cursor 
is moved over them. 

OK — Store the changes made to the view and closes the dialog. 

Cancel — Discards any changes made to the view whilst the dialog 
was displayed and closes the dialog. 

 

Add/Remove Items dialog 
Use this dialog to add or remove items in a drawing view to control 
the content of a view. 

To add/remove items 
1 Select the Items button on the Edit View dialog. 
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2 Use the Add/Remove dialog to add or remove items. 

 
Add items to view — Select this option to add items to the view 
that have previously been removed. 

Remove items from view — Select items in the view then select 
this option to remove the items from the view. The items are 
flagged once they are removed so they can be added back in if 
required. Select the Add items to view option to add the items 
back to the view. 

If the view is a hidden view or contains hidden detail, the display 
changes to wireframe so the items can be seen in order to be 
selected. 

Apply — Select to apply the changes to the view. 

OK — Apply the changes to the view and close the dialog.  

 When you click OK, A dialog is displayed to prompt you to 
select Update to update the view with the changes. 

3 Select Update on the Edit View dialog to update the view. 
 

View Background dialog 
Use this dialog to select a background to the view, change the 
magnification of the image, and display pages of a PDF file.  

 
Path — Displays the path for the view filename selected in the 
Background dialog. The view can be one of the following file types: 
PDF, PNG, TIF, BMP. 

 PDF files will only work if the full version of Adobe Acrobat is 
installed and not the free reader.  

You should ensure that the Updates Preference option for 
Acrobat is set to Manually. 
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 — Click to display the Background dialog (see page 104). You 
use this dialog to locate the file you require.  

Zoom(%) — Enter the percentage of zoom you want the background 
image to be and press Enter. 

 — Click to zoom into the background image. 

 — Click to zoom out of the background image. 

Page — Enter the page number of the PDF file you want to display, 
and press Enter. 

 — Display the first page of the PDF file. 

 — Display the previous page of the PDF file. 

 — Display the next page of the PDF file. 

 — Display the last page of the PDF file. 
 

View Flags dialog 
Use this dialog to change various settings for the view. 

 
Add Items — If selected, all new objects created in the model are 
added to the view. 

Auto Rescale — If selected, the contents of the view are scaled to fit 
the view boundaries when a closed drawing is opened. 

Standard Scale — If selected, the contents of the view use a 
standard scale (such as 1.0 2.0 5.0) to fit the view. If delselected, 
the contents can use the largest scale to fit the view. This allows the 
contents to scale to a larger size when you click the To Fit button on 
the Edit View dialog. (see page 104) 

Maintain Scale — If selected, the scale of a view is maintained when 
using drawing templates. You specify the scale for a view in the Edit 
View dialog. (see page 104) 

OK — Changes the settings for the view and closes the dialog. 

Cancel — Discards any changes and closes the dialog. 
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Edit Hidden View dialog 
Use this dialog to edit hidden and visible lines. You can also rotate a 
model dynamically in the selected view using the middle mouse 
button when this dialog is displayed. For further details, see 
Manipulating the model in a view (see page 99). 

 

Action 
This contains operations you can do on selected hidden and visible 
lines from the view. Lines are selected in the usual way. 

Convert to wireframe — Converts the selected lines into wireframe. 

Delete — Deletes the selected lines from the view. 

Toggle visibility — Toggles the styles of the selected lines from 
hidden to visible or visible to hidden. 

Remove feature — Removes solid features permanently from the 
selected hidden view. 

Project wireframe — When you convert the selected lines to 
wireframe, this option projects the wireframe onto the view plane. 

Restore 
Features — Redisplays any features that were hidden in the view 
due to selecting the Hidden detail option on the Edit View dialog. 
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Deleted Elements — Select this option to restore items in a hidden 
view that have been previously deleted. 

Styles 
This sets the style of the visible and hidden lines. 

Use item colours — If selected, the lines are the same colour as the 
wireframe of the item. 

Visible — Select the style of the visible lines from the list. 

Hidden — Select the style of the hidden lines from the list. 

Outline — Select a style to be applied to outside edges detected in a 
hidden view. The default option is As Visible. 

Internal — Select the style of the internal edges from the list. An 
internal edge is an edge that lies between faces that are tangent 
continuous. 

Tapped hole — Select the style for tapped holes from the list.  

 Tapped hole detail is dependent on the hole feature. 

Section cut — Select the style for section cuts from the list. 

 Set Styles — Click to display the style toolbar where you can 
customise a style for hidden views. 

Apply — Applies the changes to lines in the view. 

OK — Applies the changes to lines in the view and closes the dialog. 

Cancel — Closes the dialog. 

Undo — This undoes the changes to the view back to when you last 
clicked the Apply button. 

 

Deleting hidden detail 
Hidden detail can be deleted so that it does not reappear when the 
view is regenerated. When you delete hidden detail, select the 
Update button on the Edit View dialog (see page 104) to regenerate 
the view. 

The deleted geometry can be restored by selecting the Deleted 
Elements button on the Edit Hidden View dialog (see page 112). 

 

Editing Multiple Views 
You can select multiple views and edit them simultaneously using 
the Edit Multiple Views dialog.  
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 You can use box selection to select the required views. To 
deselect drawing views from the total selection, use 
Ctrl+Shift+left-click on the view. 

You can use the following editing actions on a multiple selection of 
views:  

 Delete  

 Convert  

 Move  

 Rescale  

 Set centrelines and centre marks  

 Set view detail  

 Update the view to display the edits.  

To edit a multiple selection of views 
1 Right-click the view to display the edit options available for 

views. 

 
2 Select Modify to display the Edit Multiple Views dialog that 

contains view editing options from the Edit View dialog.  

 
Scale — Enter a value to change the scale that objects are 
displayed in the selection of views. 
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Centres 

Mark — Select to mark the centres of cylindrical surfaces. 

Lines — Select to draw centre lines on cylindrical surfaces and 
circles. 

Detail — Select an option to determine how objects are displayed 
in the selected views.  
Display Hidden Lines — When Hidden is selected from the Detail 
drop-down list, you can select this option to display hidden lines 
in the views. 

Update — Select this option to update the display of views with 
any changes made. 

 

Aligning two views 
Views are aligned by aligning origins within two views. This can be 
used to accurately align objects within a view to their corresponding 
objects in another view. 

This feature is useful if you import models which contain 2D 
drawings, particularly from Delcam Toolmaker. 
1 Right-click the view and select Modify to display the Edit View 

dialog (see page 104). 

2 From the dialog, click Align to display the Align View dialog (see 
page 115) 

 

Align View dialog 
Use this dialog to accurately align objects within two views on a 
drawing. 

 
1 Select a View to be aligned. Alternatively, select a view on the 

drawing by clicking it. 

2 Select World to align the world origins of the two views. Deselect 
this option to align the view origins. 

By default, the view and world origins are in the same position. If 
the world origin is not suitable for aligning the views, you can 
move the view origins of the two views to somewhere more 
suitable. Use the Edit View dialog (see page 104) to change the 
origins of the two views. 
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If you have several views to align, move the view origin to a 
position common to the views. 

3 Click OK on the Align View dialog to see the two views align. 

The view does not move, just the contents of view. The contents 
of the modified view may look blank. 

4 If necessary, edit the borders of view to give the required view. 
For further details on editing the borders of the view, see 
Graphically editing views (see page 95). 

 

Annotation 
Annotation is text added to your drawing. Use annotation to give 
details about the model,such as when it was created and who 
created it. 

 

For further details, see: 
Annotation toolbar (see page 116) 

Editing text (see page 126) 

Inserting strings from the File Properties (see page 145) 
 

Annotation toolbar 
The Annotation toolbar combines the following tools and options, 
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 Text 

 Drawing 

 Dimensions 

 

To display the Annotation toolbar, click the Annotation  button on 
the main toolbar.  
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The Text Editor toolbar displays automatically as the Annotation 
toolbar is displayed. 

 
The Annotation toolbar is also available when in Modelling mode but 
some drafting options, such as symbols and hatching, remain 
unavailable outside Drafting mode. 

 

Entering annotation creation mode 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). This is used to edit attributes of text, for 
example, the font. The Text Editor toolbar (see page 129) 
displays automatically when the Annotation toolbar is displayed. 
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The text creation options are shown in  below on the 
Annotation toolbar (see page 116). 

 

3 Click  (Annotation toolbar) to open the Text creation flyout 
and display the text options. 

 Create horizontal text 

 Create vertical text 

 Create text on a curve 

 Text using the Duct font is created differently to text using 
the other fonts. For further details, see Creating Duct text 
(see page 122) and Editing Duct text (see page 144)  

 Multi-byte languages such as Japanese and Korean create and 
edit all text fonts in the same way as the Duct font. 

 

Creating a block of text 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 
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3 Click  (Annotation toolbar) to display the text options. 

4 Choose one of the options in the Text creation flyout. The cursor 
changes to show that you are in text creation mode. 

You can change the default style of the text using the Text Editor 
toolbar (see page 129). 

If you create vertical text, the individual characters are 
horizontal. 

 
You can switch between horizontal and vertical text at any time 

while creating text using the Horizontal  button and the 

Vertical  button  from the Text creation menu. You need to 

select a curve in order to use Text along a curve . 

You can angle (see page 135) the font. 

Text using the Duct font is created differently to text using the 
other fonts. For further details, see Creating Duct text (see page 
122). 

5 Click a position in the graphics window where you want the text 
to lie. This is the text position. 

An insertion point appears in the shape of a bar cursor. This is 
the position where PowerSHAPE will create the text. If you have 
selected vertical text, then the insertion point is horizontal. 

6 Type in the text. 

As you enter the first character, it is displayed on the screen and 
a rubber-banded box starts to form around the text. The 
insertion point moves to the end of the character . 
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As you enter more characters, the rubber-banded box enlarges 
to enclose the new characters. 

 
To create a new line of text, press Enter. The rubber-banded box 
extends to enclose the second line too and the insertion point 
moves to the start of the next line. 

 

 The bottom left corner of the rubber-banded box remains at 
the position you enter in Step 5. 

Continue typing. 

 
When the rubber-banded box is displayed around the text block, 
you are in text insertion mode and you can type in new text. 

At any time during the creation, you can change the style of the 
text using the Text Editor toolbar (see page 129). 

You can also change the default settings for text using the Options 
dialog. For further details, see Changing the default settings for text 
(see page 123). 

To exit text insertion mode, click outside of the text block. You can 
now edit the whole text block. For further details, see Editing text 
(see page 126). If you click again, you can start creating a new 
block of text. 

To exit text creation mode, click Select . 
 

Creating text on a curve 

1 Click  to display the Annotation toolbar. 

2 Click  (Annotation toolbar) to display the text options. 
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3 Click Text along a curve  on the text flyout. The cursor 

changes to . 

4 Click a point along the curve to add text.  

 
Text can be added to any arc or curve. When you have created 
the text, edit the text on the curve as required (see page 141). 

 DUCT text cannot be used when creating text on a curve. 
 

Creating DUCT text 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Select Duct from the Font selector on the Text Editor toolbar. 

Most tools on the Text Editor toolbar (see page 129) are 
available to use on the text. 

4 Click a position on the screen. 

This displays the Edit Text dialog. 

 
5 Type the text in the dialog. 
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You can make the text fixed-width or proportionally spaced. 

6 Click OK or click on the screen. 

The text is drawn on the screen. 

 

 DUCT text cannot be wrapped on a curve. 
 

Changing the default settings for text 
You can change the default settings of future text using the Options 
dialog. 

1 From the Tools menu, select Options… to display the Options 
dialog. 

2 From the Drafting branch of the browser tree, select the Text 
option. This displays the Text page of the Options dialog. 
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3 Use this dialog to set the default text options. 

 
General Text Properties — Use these options to modify the properties 
of the characters. 

Height — Enter the height of the largest character. 

Pitch — Enter the extra spacing between two characters. It is 
calculated as a multiple of the height of the text. 

Spacing — Enter the spacing between two lines of text in the 
same block. It is also specified as a multiple of the height of the 
text. Use the text box to change the spacing. 

Kerning — This adjusts the spacing between particular pairs of 
letters depending on the font design. 

Text Alignment — Modify the justification and origin point of the text. 
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Justification — This is how the text in the block aligns with the 
left and right margins. Use this option menu to change the 
justification of the text. 

Origin — This is the origin of the text block. The origin is the 
'anchor point' used to position the text and can be set at any of 
the four corners of the text box, the mid points of the sides of 
the text box or the centre of the text box. Use the option menu 
to change the origin of the text. 

Use live text editor for truetype fonts — Select this option to create 
and edit text using the text insertion mode. The rubber-banded box 
is displayed around the text to indicate you are in text insertion 
mode. Deselect this option to create (see page 122) and edit (see 
page 144) all text fonts in the same way as the Duct font using the 
Edit Text dialog. 

Special characters — Enter or paste special characters (see page 
136) from the Unicode Character Map dialog. They are stored in the 
model and are available in the Character list on the Text Editor 
toolbar (see page 129). 

Use substitution font For special characters — If ON, the special 
characters in the list on the Text toolbar will use the font defined 
in the Substitution Font menu. 

Substitution font — Select the font used by substituted strings. If 
you select Toolbar Font, the font on the toolbar is used. 

 — These define the substitution strings. The 
box enclosed in < > contains the string you type in and the box 
next to it contains the replacement string. 

Three standard substitution strings are provided: 

 <dia> — diameter symbol 

 <deg> — degree symbol 

 <p/m> — plus/minus symbol 

These standard strings are also used by balloons and 
dimensions. 

When you type <dia> in PowerSHAPE and then deselect the text, 
you can see the diameter symbol. If you edit the text, the <dia> 
string is displayed again. 
To define your own strings: 
1 Type in the string you want to type in PowerSHAPE in the box 

enclosed in < >. A maximum of three characters is allowed. 

2 In the box next to it, type in the replacement string. 
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Do not forget to enclose the string in < > when you type the text 
in the graphics window. 

If you use a substitution string in your model and then later 
change the definition of its replacement string, all the strings in 
your model using that substitution string will be replaced too. 
This also applies to the standard strings. 

Delete — This deletes the substitution string displayed in the box 
enclosed in < >. You cannot delete the standard substitution 
strings. 

Font Paths — If you have created new fonts, using ArtCAM font 
creator, use the Font paths section to specify the location of font 
files.  

1 Click  to display the Browse for folder dialog. 

2 Choose a font directory from the tree and click OK. 

OK — Click to accept the changes. 
 

Editing text 

1 Click Select  to enter selection mode. 

2 Select the text to display the Text Editor toolbar (see page 129). 
Use this toolbar to edit all the text within the text block. 

When text is selected it can be dragged to a new location. 

You can also use one of the following methods to edit the text: 

 Select Edit > Modify to enter text insertion mode and display the 
Text Editor toolbar (see page 129). The rubber-banded box is 
displayed around the text to indicate you are in text insertion 
mode. 

 Select Edit > Convert > To Wireframe to convert text to wireframe 
(see page 145). 

 Double-click the text to enter text insertion mode and display the 
Text Editor toolbar (see page 129). The rubber-banded box is 
displayed around the text to indicate you are in text insertion 
mode. 



 

PowerSHAPE 2015 R2 Reference Help Delcam Draft • 127  

 Right-click the text to display the edit options available for text. 
The name of the text and the level on which it lies is at the top of 
the context menu. 

 
Convert to Wire is the only option unique to this context menu. 
This option converts the text to wireframe (see page 145). 

 You edit Duct text (see page 144) differently to text using the 
other fonts.  

 

Moving the insertion point in a text block 
1 Ensure you are in text insertion mode. 

If you are not already in text insertion mode, double-click a block 
of text. You can see if you are in text insertion mode when the 
rubber-banded box is displayed around the text block. 

2 Use the arrow keys or click the mouse in the text block to move 
the insertion point. 

 

Selecting characters in text-insertion mode 
1 Double-click the text block to enter text-insertion mode. 
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2 Left-click on the text to move the insertion point, either to the 
start or end of the subset of characters that you want to select. 

 
3 Hold down the left mouse button on the insertion point and drag 

the cursor over the subset of characters. 

A box is drawn around the selected text. 

 

 You can select characters over several lines. 

4 Edit the selected text using the Text Editor toolbar (see page 
129) 

 

Deleting a character 
1 Double-click the text block to enter text-insertion mode. 

2 Left-click on the text to move the insertion point in front of the 
character that you want to delete. 

3 Press the Backspace key. 

 If you use the Delete key, then the text in front of the 
insertion point is deleted. 

 

Cut, copy, and paste a string of characters 
To cut or copy a string of characters into the Windows clipboard: 

1 Double-click the text block to enter text-insertion mode. 

2 Select a string of characters (see page 127). 

3 From the Edit menu, select Cut or Copy. 

 You can also use the keyboard shortcuts Ctrl X for cut and 
Ctrl C for copy. 

To paste the string from the Windows clipboard into any block of 
text: 

1 Double-click the text block to enter text-insertion mode. 

2 Move the cursor to where you want to insert the text. 

3 From the Edit menu, select Paste. 
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 You can also use the keyboard shortcut Ctrl V for paste. 
 

Inserting a character 
There are two insertion modes:  

 Overtype. 

 Insert.  
Overtype Mode 

Each character you type replaces an existing character to the right 
of the insertion point.  
Insert Mode 

When you enter new text, existing text is moved to the right. 

1 Move the insertion point to where you want to insert the new 
text. 

2 Press the Insert key. 

3 Type in the new text. 

According to the mode you selected, text is added to the block.  
 

Text Editor toolbar 
Select a block of text or enter text creation mode, to display the 
Text Editor toolbar. When creating balloons, a version of the toolbar 
is displayed that includes balloon options. All unrequired style items 
are suppressed when balloon options are displayed. 

 
Use the toolbar to edit the style of text using the following options: 

 The font used in the selected text is displayed in the 
font drop down list. PowerSHAPE supports a range of fonts from 
ArtCAM, including the wide character stick font, (AFN) 
Korean_single_line. 

Height — Select the height of the largest character (see page 131). 

 — Bold text (see page 131). 

 — Italic text (see page 131). 

 — Underline text (see page 132). 

Pitch — Spacing between individual characters (see page 132). 

Spacing — Spacing between lines in the selected block of text (see 
page 134). 
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Angle — Angle of the text to the horizontal (see page 135). 

 — Text justification. 

 — Text origin. 

 — Sets the selection filter to text (see page 135). 

 — Decreases the decimal places by (see page 136) 1. 

 — Increases the decimal places by 1 (see page 136). 

Character — Add special characters (see page 136). 

 — Display Text substitutions (see page 139). 

You can edit the style of the text when either a block of text is 
selected, or you are in text-insertion mode. 

 Most tools on the Text Editor toolbar are available to use on 
the Duct text. You can convert the text to PowerSHAPE text 
by changing the font. 

If you are in PowerMILL modelling mode when you add text to 
a model, the text will be converted to wireframe when you 
return to PowerMILL. 

 

Changing the font of the text 
1 Select the text you wish to change. 

The following text uses the Arial font: 

 
2 Select a Font from the list on the Text Editor toolbar. The font of 

the text is updated to reflect the new selection. 

The drop-down list displays the scalable fonts available on your 
computer. On a Windows computer, these fonts are called 
TrueType fonts. 

In this example, the font is changed to Times New Roman. 

 
It is now Courier New. 

 

 You cannot use Duct text when creating text on a curve. 
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Changing the height of the text 
1 Double-click the text block to enter text-insertion mode. 

 
2 Drag the mouse over the word PowerSHAPE. 

 
3 Use the Height list to enter or select a value. For example, 

change the value from 5 to 10. 

 
If you change the height of a whole block of text, the line 
spacing of the text block adjusts. If you change the height of just 
a few characters in a block of text, then the spacing of only the 
lines containing that text adjusts. 

 If you do not select any text, then any new text at the 
insertion point is created using the new height value. 

 

Creating bold text 
1 Select the text you want to change. 

2 Click the Bold  button. 

If your text does not change to bold, then the bold version of 
that font does not exist. 

3 To change back to normal text, click the Bold  button again. 

 If you do not select any text, then any new text at the 
insertion point is created as bold. 

 

Creating italic text 
1 Select the text you want to change. 

2 Click the Italic  button. 

If your text does not change to italics, then the italic version of 
that font does not exist. 

3 To change back to normal text, click the Italic  button again. 

 If you do not select any text, then any new text at the 
insertion point is created as italics. 
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Creating underlined text 
1 Select the text you want to change. 

2 Click the Underline  button. 

3 To change back to normal text, simply click the Underline  
button again. 

 If you do not select any text, then any new text at the 
insertion point is created as underlined. 

 

Justifying text 
You can choose whether the text is aligned to the left, right, or 
centre of the block. By default, lines of text in a block are left-
justified. 

To change the justification of the text: 
1 Select the text block to display the Text Editor toolbar. 

If you are in text insertion mode, then you do not need to do 
anything. 

2 From the Text Justification drop-down list , select the 
appropriate option. 

The following options are available: 

 — Left justification 

 — Centre justification 

 — Right justification 
 

Changing the pitch 
Pitch is the distance between each character in a line. It is a 
multiple of the character height. 

1 Select the text you want to change. 

2 Select or enter a new value in the Pitch list. 



 

PowerSHAPE 2015 R2 Reference Help Delcam Draft • 133  

The pitch of the following text has been increased to 1 from 0. 
The characters move further apart. 

 

 If you do not select any text, then any new text at the 
insertion point is created using the new pitch value. 

 

Creating text from a different origin 
Each block of text has an origin. This origin anchors the text block 
to the text position. The text is created relative to that anchor. 

When you enter new lines of text, the text block moves such that 
the origin and text position always coincide. 

There are nine origin positions: 

 
Each button is described below. 

 — Bottom left  

 — Bottom centre  

 — Bottom right 

 — Centre left 

 — Centre 

 — Centre right 

 — Top left 
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 — Top centre 

 — Top right 

By default the origin is at the bottom-left of the text block. The 
effect of typing in new lines of text is that the text block moves up 
the screen. 

1 Select a block of text. The origin of the text below is bottom left. 

2 Choose an option from the Origin list. 

 
The block of text is re-positioned to anchor the text position at 
the origin. 

 

Changing the line spacing 
Line spacing is the distance between two lines of text. It is a 
multiple of the character height. 

1 Select the text you want to change. 

2 Select or enter a new value in the Spacing list.  

The spacing of the following text has been increased to 1 from 0. 
The lines move further apart. 
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 The line spacing adjusts to fit the character with the largest 
height in the text block. 

 

 If you do not select any text, then any new text is created 
using the new spacing value. 

 

Creating angled text 
You can create angled text. The angle is measured from the 
horizontal. 

1 Select the text you want to change. 

2 Enter or select an Angle. 

The following text has been angled by 30. 

 

 Text is drawn as an outline, but is displayed as filled when 
viewed parallel to the screen and of a reasonable size. 

 

Setting the selection filter to text only 
1 Select some text. 

2 Press in the Text filter  button. 

You can now select only text on the screen. 

To exit the text selection mode, do one of the following: 

 Click the Text filter   button if text is selected. 

 From the selection option menu, click Select . 

 Enter any creation mode. 

 When you add a schedule, the selection filter automatically 
sets to text only. 
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Changing the number of decimal places of text numbers 
If the selected text in a schedule is a single number, you can either 
increase or decrease its number of decimal places by 1. 

1 Select text that is a number. 

2 Click either the Decrease decimal places button  or the Increase 
decimal places  button. 

The number of decimal places decreases or increases by 1. 

 If you enter a number, it is not dependent on any geometry 
and so you cannot increase its number of decimal places. 

 

Adding special characters to text 
1 Double-click the text if you are not already in text-insertion 

mode. 

2 Move the text insertion point to where you want to insert the 
special character. 

3 Select a character from the Character list to insert into the text. 

By default, the list contains diameter, degrees, and plus/minus 
characters.  

You can insert the default special characters directly into the text 
using the following shortcuts. 
Ø diamete

r + +  

± plus/mi
nus + +  

° degrees 
+ +  

You can add new characters into the Character list by: 

 typing the character into the Character list,  
 pasting the character into the Character list (right-click in the list 

and select Paste from the menu), 

 typing the Windows character value of the required character 
into the Character list.  

The new character is also inserted in the text on the screen. 

To store the characters in the model and add them to the Character 
list, insert the characters into the Special Characters box on the Text 
page (see page 123) of the Options dialog. 
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Using the Character Map dialog 
You can insert special characters directly into the text on the 
screen. Hold down the Alt key and use the numeric keypad to type 
the Windows character value of the required character. This also 
inserts the character into the Character list. 
To insert Unicode characters: 

1 Double-click the text if you are not already in text-insertion 
mode. 

2 Move the cursor to where you want to insert the special 
character. 

In the example below, we want to insert the  (divided by) 
character between the two words height and width. 

  
3 From the Windows Start menu, select All Programs > Accessories > 

System Tools > Character Map to display the Character Map dialog.  

The available Windows characters and their values are displayed 
in this dialog. 

4 Select the Advanced view option to display all the options on the 
dialog. 

5 From the Character set list, select Unicode. 

6 Ensure the Font in the Character Map dialog is the same font used 
in PowerSHAPE.  
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The example below shows the PowerSHAPE default font Tahoma. 

 
7 Click a character from the dialog.  

The example below shows the ÷  (division) character. 
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In the bottom-right corner of the Character Map dialog, the 
Keystroke sequence is displayed, in this example Alt+0247. 

8 In PowerSHAPE, hold down the Alt key and use the numeric 
keypad to type in the number code for the character. When you 
release the Alt key the character is displayed in the list and in 
the text. 

In this example, hold down the  key and press 

. 

  
You can also type just the number directly into the Character list 
in PowerSHAPE. 

 Only Windows character values between 32 and 256 are 
valid. 

 

Adding special characters using Copy and Paste 
Another way to insert the character is by using copy and paste. To 
do this: 

1 Click the character in the Windows Character Map dialog. 

2 In the dialog, click the Select button. This displays the character 
in the Characters to Copy box. 

3 Click the Copy button. 

4 Go to PowerSHAPE and right-click in the Character list. 
5 Select Paste from the context menu. 

 Only Windows character values between 32 and 256 are valid. 
 

Text substitutions 

1 Click  to display the annotation toolbar. 

2 Click  and click a position on the drawing where the text will 
be positioned. 
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3 Enter a label, if required. 

 

4 Click  (Annotation toolbar) to display the Text Substitutions 
dialog. 
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5 Select the required substitution string. 

 
6 Select Live value option to re-evaluate the substitution whenever 

the text is drawn. 

7 Click Apply. 

 
8 Click Cancel and click the drawing to display the substituted text. 

In this example, the name of the model was sub-text. 

 
 

Editing text on a curve 
You can edit text written on a curve using the options on the Text 
Editor toolbar (see page 129). 

In addition, you can: 

 move the text along the curve (see page 142). 

 reverse the text (see page 142). 
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 mirror the text (see page 143). 

 change the position of the text (see page 143). 
 

Moving text along a curve 

 
1 Double-click the text to edit the text. 

2 Move the cursor over the start point of the text . The cursor 

changes to a hand . 

3 Use  to move the text. The text follows the line of the curve 
until it reaches the end point . 

When text is created, the end point is created at the end of the 
curve. You can drag the end point along the curve to any point 
between the start point and the end of the curve. 

 Text that is moved beyond the end point no longer follows the 
line of the curve and continues on the same tangent.  

 
 

Reversing the text 

 



 

PowerSHAPE 2015 R2 Reference Help Delcam Draft • 143  

1 Double-click the text to edit the text. 

2 Click  to reverse the text.  

3 Click  again to return the text to the original direction. 
Any edits made to the text whilst reversed are retained. 

 Reversed text can still be edited using the Text editor toolbar. 
 

Mirroring the text 

 
1 Double-click the text to edit the text. 

2 Click  to mirror the text. 

When mirrored, the start and end points are reversed. These 
points can be moved as required. 

3 Click  to return the text to the original direction. If you have 
moved the start and end points, they will not revert back. 

 Mirrored text can still be edited using the Text editor toolbar 
 

Changing the position of the text 
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1 Double-click the text to edit the text. 

2 Click any point in the text and drag the mouse to select 
characters. 

 
A start and end point is created either side of your character 
selection boxes . 

3 Move the cursor over the new start/end point until the cursor 

changes into a hand . 

4 Use  to move the selected characters along the curve.  

 Use to move the text along the curve, maintaining the 
spacing between the selected text and the next lot of text. 

After the position has been changed, the text can still be 
moved/reversed/mirrored as a complete entity, retaining the 
changes. 

 

Editing Duct text 
1 Double-click the text.  
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The Edit Text dialog is displayed, showing the selected text.  

 
2 Edit the text in the dialog. 

You can also make the text fixed-width or proportionally spaced 
using the dialog. 

3 Change the words to: 
This is text. 

4 Click OK or click in the graphics window. The text is altered. 

 

 Most tools on the Text Editor toolbar are available to use on 
the Duct text. You can convert the text to PowerSHAPE text 
by changing the font. 

 

Converting text to wireframe 
1 Select the text. 

 
2 Select Edit > Convert > To wireframe from the menu. 

3 The outline of the text is converted to wireframe. 

 
 

Inserting strings from the File Properties 
When creating text, you can enter one of the following strings and it 
will be substituted: 

%title 
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%subject 
%author 
%manager 
%company 

%keywords 
%comments 
%version 

%date 
%short-date - this is the date in locale short date format 

All but the last three are read from fields in the File > Properties 
dialog in Windows Explorer. For further details, see Finding out what 
a model contains in Modelling Concepts..  

 If a field is empty in the dialog, a - is substituted (except for 
%author where the current user is substituted). 

 %version refers to the version number of PowerSHAPE you are 
using. 

1 Go into text-creation mode. 

2 Type some text containing a %string. 

 

3 Click Select  to go into selection mode. 

The text is now substituted. 

 
In our example, the string is substituted by the name of the user 
who saved the original model. If the model is new, then the 
name of the current user appears. 

If you double click the text, you will see the original string. 
 

Updating the strings from File Properties 
As the fields on the Windows Explorer's File > Properties dialog 
change, so do any special strings in the text. 

For example, 
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1 Suppose your model contains the following string. 

 
2 Save and close the model. 

3 In Windows Explorer, select the psmodel. 

4 From the File menu of Windows Explorer, select Properties to 
display the Properties dialog for the model. 

 
5 Change the Author field on the Summary page of the File > 

Properties dialog (Windows Explorer). 

6 Open the model again and the new name is substituted for the 
%author string. 

 

Balloons 
A balloon is a label with an arrow that points to an area on your 
drawing. The label can be a code number, letter, or description. 

You can use balloons to: 

 identify parts of your model. 

 describe features on your model. 
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 add numbered labels representing a key to information in a bill of 
material or similar table. 

The following chainsaw handle example has a fillet surface on the 
support handle on the side. 

 
You can use balloons to label the model to show the details. A key is 
provided in the bottom right corner explaining the code of each 
balloon. 

 
You can see from this example that there are different types of 
balloons that you can create. 

 

Creating a balloon 
You can create the following types of balloon: 

 Default (see page 156) 

 Point (as Options page) (see page 158) 

 Counter (see page 159) 

 Label (see page 161) 
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 Enclosed label (see page 163) 

 Point (boxed) (see page 165) 

 Schedule (see page 166) 

 Underline (see page 168) 

 Split circle (see page 171) 

 Geometric tolerance (see page 172) 

 Datum (see page 176) 

 Surface texture (see page 178) 

 Weld symbol (see page 180) 
 

Entering balloon-creation mode 

1 Click  (Main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools. 

2 From the Object menu, select Balloon to display the Balloon 
creation options. 

 
3 Select a balloon type from the menu to display the Annotation 

toolbar (see page 116).  
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4 The balloon creation options are shown in  below on the 
Annotation toolbar (see page 116). 

 

You can also see these options by selecting  from the 
Drafting toolbar.  

5 Select the option you require from the appropriate flyout. 

  
The following balloons are available from the annotation toolbar 

 Default (see page 156) 

 Point (as Options page) (see page 158) 

 Counter (see page 159) 
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 Label (see page 161) 

 Enclosed Label (see page 163) 

 Point (Boxed) (see page 165) 

 Schedule (see page 166) 

 Underline (see page 168) 

 Split circle (see page 171) 

 Geometric Tolerance (see page 172) 

 Datum (see page 176) 

 Surface Texture (see page 178) 

 Weld Symbol (see page 180) 
 

Balloon toolbar 
When creating a balloon, Balloon options are added to the end of a 
version of the Text Editor toolbar (see page 129). Any unrequired 
style items are suppressed. 

 
Counter — This formats the counter used in balloons. The rightmost 
character is the counter and can only be alphanumeric. This 
character increases by 1 unit when you create a new balloon. All the 
other characters are added as they are to the label. 

To reset the value of the counter, change the rightmost character to 
the new value.  

To define the counter, enter %c as the Default value on the Balloon 
page (see page 152) of the Options dialog. 

 — If selected, a leader is drawn from the balloon. If deselected, 

, a leader is not drawn. 

After you have created a balloon, you can edit (see page 126) its 
label text like any other text. 
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Setting the default balloon Options 
Use the Balloon page of the Options dialog to set the default balloon 
settings. 

 
To open this page: 

1 Select Tools > Options from the menu. 

The Options dialog is displayed. 

2 In the browser tree, select Drafting > Balloon. 

The Balloon options page is displayed. 

The page has these sections:  
 Balloon 
 Text 
 End mark 
 Point balloon 
 Leaders 
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Balloon 
Use this section to controls the graphic that encloses the text. 

Shape — Select the balloon shape from the options. 

 None 
 

  Underline 
 

 Arc 
 

  Split circle 
 

 Box 
 

  Triangle 
 

 

Colour — Select the colour of the balloon outline from the list. 

For example: 

    
Include leader — Select this option to use a leader. 

For example: 

 
Deselect this option if you don't want a leader: 

 
Prompt — Select this option to display the Balloon Confirmation 
dialog (see page 162) when creating a default balloon. 

 When creating Counter and Label balloons, this dialog is 
displayed by default. 
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Size to text — Select this option to fit the balloon size to the text. 
The minimum size of the balloon is 3 characters. 

Size in characters — Select this option to specify the balloon size 
in terms of number of characters. Enter the number of characters 
as the Size value. 

Size In length — Select this option to specify the balloon size in 
the current units, such as millimetres. Enter the exact size of the 
balloon as the Size value. 

Size — Enter the exact width of the balloon. 

Text 
Colour — Select the colour of the text in the balloon. 

For example: 

    
Default — Default text for balloons. The %c represents the counter. 
When you create a balloon, %c is substituted by the text in the 
Counter box on the Text Editor toolbar. Any other text in the Default 
box is added as it is to the label. 

You can change this text if you want. For example, if Default is: 
Balloon number: %c 

and the Counter on the Text Editor toolbar is set to A1, balloons are 
created with labels: 

Balloon number: A1 
Balloon number: A2 

End mark 
The end mark is the end of the pointer. 

Shape — Shape of mark at the end of the pointer. 

 Arrow 
 

  Dot 
 

 Circle 
 

 Triangle 
 

 Filled 
circle  

  Filled triangle 
 

 Slash 
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Size — Enter the width of the mark in mm. 

For example: 
5 mm 

 

10 mm 

 

 

 

Point Balloon 
Point balloons display coordinates.  

Horizontal coordinates — Select this option to position the 
coordinates horizontally. 

Include coordinate labels — Select this option to add labels in front of 
coordinates in the point balloons. 

Coordinates — Select the coordinates to include in point balloons, 
from:  

 XY — XY coordinates are displayed. 

 XYZ — XYZ coordinates are displayed. 

 Z — Only the Z value is displayed. 

Include diameter value — Select one of these options: 

 Auto — The diameter is displayed when you click the balloon's 
pointer in the centre of a circle.  

 On — The diameter is always displayed. 

 If the balloon's pointer is not at the centre of a circle, a 
hyphen (-) is displayed.  

 Off — The diameter value is not displayed. 

Diameter decimal places — Enter the number of decimal places to 
display for a diameter value in a point balloon. If the units for the 
model are inches, additional decimal places are displayed. 

Coordinate decimal places — Enter the number of decimal places to 
display for coordinate values in a point balloons. If the units for the 
model are inches, additional decimal places are displayed. 

Leaders 
Put leaders at frame corners — Select this option to display leaders at 
the corner of the frame. 



 

156 • Delcam Draft PowerSHAPE 2015 R2 Reference Help  

For example, with Put leaders at frame corners selected: 

 
With Put leaders at frame corners deselected, leaders are displayed at 
the centre of an edge of the frame. 

 
OK — Accept the changes. 

 

Creating a default balloon 
You can create a balloon using the settings on the Balloon page of 
the Options dialog. By changing the settings, you can create various 
balloons. 

 

1 Click the Drafting Mode  button (main toolbar). The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 If required, change the setting on the Balloons page of the 
Options dialog. For further details, see Setting the balloons on 
the Options dialog (see page 159). 

3 Click the Annotation  button (drafting toolbar). 

4 Click the Default balloon  flyout (annotation toolbar). 

5 Click the Default balloon  button (default flyout). 
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The Balloon toolbar (see page 151) is displayed alongside the 
Text toolbar. The options on the Balloon toolbar are mainly used 
to edit text in balloon labels. You use this toolbar to set the value 
of the counter.. 

6 Set the point you want to label, in one of these ways: 

 Click the mouse on the drawing. 

 
 Enter X Y coordinates in the Command input field on the Status 

bar, for example 80 40. 

A rubber-banded line is attached from the position to the mouse 
cursor. 

7 Set the position where you want the balloon, in one of these 
ways: 

 Click the mouse on the drawing 

 
 Enter the absolute X Y coordinates in the Command input field 

on the Status bar, for example 120 70. 

The balloon is added to the drawing, for example: 
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Creating a point balloon (as Options page) 
A point balloon uses coordinates at its pointer as its label and the 
default balloon shape from the Balloons page of the Options dialog. 

 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Click the Default balloon  flyout (annotation toolbar). 

4 Click the Point balloon  button (default balloon flyout). 

The Balloon toolbar (see page 151) is displayed. This is mainly 
used to edit text in balloon labels. 

5 Set the point you want to label, in one of these ways: 

 Click the mouse on the drawing. 

 
 Enter X Y coordinates in the Command input field on the Status 

bar, for example 80 40. 

A rubber-banded line is attached from the position to the mouse 
cursor. 

6 Set the position where you want the balloon, in one of these 
ways: 
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 Click the mouse on the drawing 

 
 Enter the absolute X Y coordinates in the Command input field 

on the Status bar, for example 120 70. 

The balloon is added to the drawing. 

 
To display the XYZ coordinates or the Z coordinate, select the 
relevant option from the Co-ordinates list on the Balloon (see 
page 152) page of the Options dialog.  

You can also remove the coordinate labels from the balloons by 
turning off the Include coordinate labels option on the same page. 
There are other options which you can set. 

 

Creating a counter balloon 
A counter balloon is enclosed in a circle and its text is as defined in 
the Options dialog. 

 
The counter increases by 1 when you create the next balloon. 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 
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2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Click the Counter balloon  flyout (annotation menu). The 
Balloon toolbar (see page 151) is displayed, which is mainly used 
to edit text in balloon labels. 

4 Click the Counter balloon  button. 

5 Set the point you want to label, in one of these ways: 

 Click the mouse on the drawing. 

 
 Enter X Y coordinates in the Command input field on the Status 

bar, for example 80 40. 

A rubber-banded line is attached from the position to the mouse 
cursor. 

6 Set the position where you want the balloon, in one of these 
ways: 

 Click the mouse on the drawing 

 
 Enter the absolute X Y coordinates in the Command input field 

on the Status bar, for example 120 70. 

The balloon is added to the drawing. 
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To reset the value of the counter, see Balloon toolbar (see page 
151). 

 

Creating a label balloon 
A label balloon is one with text not enclosed in a shape. You are 
prompted to specify the text of the label during creation. 

 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Click the Counter balloon  flyout (annotation menu). The 
Balloon toolbar (see page 151) is displayed, which is mainly used 
to edit text in balloon labels. 

4 On the flyout, click the Label balloon  button. 

5 Set the point you want to label, in one of these ways: 

 Click the mouse on the drawing. 

 
 Enter X Y coordinates in the Command input field on the Status 

bar, for example 80 40. 

A rubber-banded line is attached from the position to the mouse 
cursor. 

6 Set the position where you want the balloon, in one of these 
ways: 
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 Click the mouse on the drawing 

 
 Enter the absolute X Y coordinates in the Command input field 

on the Status bar, for example 120 70. 

When you set the position, the Balloon Confirmation dialog is 
displayed. 

7 Use the Balloon Confirmation dialog (see page 162) to enter the 
text you require to appear in the balloon. 

In the example below, Your text was entered in the dialog. 

8 Click OK . 

The balloon is added to the drawing. 

 
 

Balloon Confirmation dialog 
Use this dialog to edit the text of the balloon. This dialog is 
automatically displayed when creating counter and label balloons. 
To display this dialog when creating default balloons, select Prompt 
on the Balloon page (see page 152) of the Options dialog. 

 
Label — Enter the balloon text. 

 Changing this label does not increment the counter. 

OK — Makes the changes to the balloon and removes the dialog 
from the screen. 
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Cancel — Cancels the current balloon creation and removes the 
dialog from the screen. 

 

Creating an enclosed label balloon 
An enclosed label balloon has text enclosed in a circle. You are can 
specify the text of the label during creation. 

 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Click the Counter balloon  flyout (annotation menu). The 
Balloon toolbar (see page 151) is displayed, which is mainly used 
to edit text in balloon labels. 

4 On the flyout, click the Enclosed label balloon  button. 

5 Set the point you want to label, in one of these ways: 

 Click the mouse on the drawing. 

 
 Enter X Y coordinates in the Command input field on the Status 

bar, for example 80 40. 
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A rubber-banded line is attached from the position to the mouse 
cursor. 

6 Set the position where you want the balloon, in one of these 
ways: 

 Click the mouse on the drawing 

 
 Enter the absolute X Y coordinates in the Command input field 

on the Status bar, for example 120 70. 

When you click the position, the Balloon Confirmation dialog is 
displayed. 

7 Use the Balloon Confirmation dialog (see page 162) to enter the 
text you want in the balloon.  

In the example below, Your text was entered in the dialog. 

8 Click OK. 

The balloon is added to the drawing. 
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Creating a point balloon (boxed) 
A point balloon displays the coordinates from its pointer location as 
its label and is enclosed in a box. 

 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Click the Counter balloon  flyout (annotation menu). The 
Balloon toolbar (see page 151) is displayed, which is mainly used 
to edit text in balloon labels. 

4 On the flyout, click the Point balloon (boxed)  button. 

5 Set the point you want to label, in one of these ways: 

 Click the mouse on the drawing. 

 
 Enter X Y coordinates in the Command input field on the Status 

bar, for example 80 40. 

A rubber-banded line is attached from the position to the mouse 
cursor. 

6 Set the position where you want the balloon, in one of these 
ways: 
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 Click the mouse on the drawing 

 
 Enter the absolute X Y coordinates in the Command input field 

on the Status bar, for example 120 70. 

The balloon is added to the drawing. 

 
By default, only the X and Y coordinates are displayed. 
Alternatively, you can set the Coordinates option to XYZ or Z on 
the Balloon page (see page 152) of the Options dialog. 

You can remove the coordinate labels from balloons by 
deselecting Include coordinate labels. 

 

Creating a schedule balloon 
A schedule balloon marks a position to include in the schedule for 
balloons. In the example below, A1 and A2 are schedule balloons. 
They have no pointers displayed. 

 
You can use schedule balloons as labels to mark drill holes. 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 
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2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Click the Counter balloon  flyout (annotation menu). The 
Balloon toolbar (see page 151) is displayed, which is mainly used 
to edit text in balloon labels. 

4 On the flyout, click the Schedule balloon  button. 

5 Set the point you want to label, in one of these ways: 

 Click the mouse on the drawing. 

 
 Enter X Y coordinates in the Command input field on the Status 

bar, for example 80 40. 

A rubber-banded line is attached from the position to the mouse 
cursor. 

6 Set the position where you want the balloon, in one of these 
ways: 

 Click the mouse on the drawing 

 
 Enter the absolute X Y coordinates in the Command input field 

on the Status bar, for example 120 70. 

The balloon is added to the drawing. 

 
This type of balloon does not have a pointer. 

When you have created a collection of schedule balloons, you can 
create a schedule (see page 283) to display the labels of the 
balloons and their coordinates. 
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Creating an underline balloon 
An underline balloon is one whose label is underlined and its text is 
as defined in the Options dialog. 

 
The counter increases by 1 unit when you create the next balloon. 

If the Standard (see page 152) is set to USDD, you can enter text 
labels along the balloon and the leader. 

 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Click the Counter balloon  flyout (annotation menu). 

4 Click  (counter flyout) 

The Balloon toolbar (see page 151) is displayed, which is mainly 
used to edit text in balloon labels. The value of the counter is set 
using this toolbar. 

5 Set the point you want to label, in one of these ways: 
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 Click the mouse on the drawing. 

 
 Enter X Y coordinates in the Command input field on the Status 

bar, for example 80 40. 

A rubber-banded line is attached from the position to the mouse 
cursor. 

6 Set the position where you want the balloon, in one of these 
ways: 

 Click the mouse on the drawing 

 
 Enter the absolute X Y coordinates in the Command input field 

on the Status bar, for example 120 70. 

If the Standard is not USDD, the balloon is added to the drawing. 

 
To reset the value of the counter, see Balloon toolbar (see page 
151). 

If the standard is USDD, the Leader dialog (see page 170) is 
displayed. Complete this dialog to add the text to the balloon. 
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Leader dialog 
Use this dialog to add text to the balloon. 

 
1 Enter the text that you want to display in the balloon. 

 
2 Select the style of Leader Marker from: 

 No marker 
 

 Bonding 
marker  

 Glue marker 
 

3 Click OK to create the balloon. 
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Creating a split circle balloon 
A split circle balloon is one with text in the top and bottom halves of 
a circle. You are prompted to specify the text of the labels during 
creation. 

 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Click the Counter balloon  flyout (annotation menu). The 
Balloon toolbar (see page 151) is displayed, which is mainly used 
to edit text in balloon labels. 

4 Click the Split circle balloon  button. 

5 Set the point you want to label, in one of these ways: 

 Click the mouse on the drawing. 

 
 Enter X Y coordinates in the Command input field on the Status 

bar, for example 80 40. 

A rubber-banded line is attached from the position to the mouse 
cursor. 

6 Set the position where you want the balloon, in one of these 
ways: 
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 Click the mouse on the drawing 

 
 Enter the absolute X Y coordinates in the Command input field 

on the Status bar, for example 120 70. 

When you set this position, the Split Balloon Labels dialog (see 
page 172) is displayed. 

7 Use the dialog to enter the balloon text you want. 
 

Split Balloon Labels dialog 
Use this dialog to edit the text in split circle balloons. 

 
Top label — Enter the text you want to appear in the top half of the 
balloon. 

Bottom label — Enter the text you want to appear in the bottom half 
of the balloon. 

OK — Creates the balloon and removes the dialog from the screen. 

Cancel — Cancels the current balloon creation and removes the 
dialog from the screen. 

 

Creating a geometric tolerance balloon 
A geometric tolerance balloon enables you to show certain 
deviations of a feature using standard symbols, for example: 
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1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Click the Geometric Tolerance  flyout to display the Balloon 
toolbar (see page 151). The options on this toolbar are used to 
edit text in balloon labels. 

4 Click  (Geometric tolerance flyout). 

5 Set the point you want to label, in one of these ways: 

 Click the mouse on the drawing. 

 
 Enter X Y coordinates in the Command input field on the Status 

bar, for example 80 40. 

A rubber-banded line is attached from the position to the mouse 
cursor. 

6 Set the position where you want the balloon, in one of these 
ways: 

 Click the mouse on the drawing 

 
 Enter the absolute X Y coordinates in the Command input field 

on the Status bar, for example 120 70. 

The Geometric Tolerance dialog (see page 174) is displayed. 

7 Use the Geometric Tolerance dialog (see page 174) to enter the 
symbols and values of the geometric tolerances. 
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 There is a option called Put leaders at frame corners on the 
Balloons page of the Options dialog. If selected, the leader of 
the geometric tolerance balloon is at the corner of the frame. 
If deselected, it is centred on an edge of the frame. 

 

Geometric Tolerance dialog 
Use this dialog to define the geometric tolerances enclosed in the 
balloon. 

 
Symbol — Select a tolerance symbol from the list. 

 None 
 Straightness 
 Flatness 
 Roundness 
 Cylindricity 
 Line profile 
 Surface profile 
 Parallelism 

 Squareness 
 Angularity 
 Position 
 Concentricity 
 Symmetry 
 Circular run-out 
 Total run-out 

 

Tolerance —  

 Select whether you want a diameter symbol. 

 No diameter symbol 

 Diameter symbol 

 Enter the tolerance value. 

 Select a material condition symbol. 

 None 

 At maximum 

 At least 
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 Regardless of feature size 

Datum — This defines the datum from which the tolerances are 
measured. 

To have two rows of geometric tolerance in the balloon, set the 
second row of Symbol, Tolerance, and Datum options. 

Projected Tolerance Zone —  

 Enter a value. 

 Select whether you want a projected tolerance zone symbol. 

 No symbol 

 Projected tolerance zone symbol 

Draw vertically — Select this option to create the balloon vertically. 

 
Add extra leaders — Select this option to have more than one leader. 
The Add Leaders dialog (see page 187) is displayed when you click 
the OK button. 

 
The balloon above has dog-legged pointers (see page 183). 

OK — Creates the geometric tolerance balloon and removes the 
dialog from the screen. 

 

Editing a geometric tolerance 
You can edit a geometric tolerance by double clicking on the 
tolerance balloon to display the Geometric Tolerance dialog.  
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When you are editing the geometric tolerance, the Add Extra 
Leaders option is replaced by the Add Leaders button. Click Add 
Leaders to display the Add Leaders dialog. 

 
 

Creating a datum balloon 
A datum balloon usually points to a datum which is referred to in a 
geometric tolerance. 

 
The text in the balloon is set by the counter. The counter increases 
by 1 unit when you create the next balloon. 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Click the Geometric Tolerance  flyout to display the Balloon 
toolbar (see page 151). The options on this toolbar are used to 
edit text in balloon labels. 

4 On the flyout, click the Datum balloon  button. 

5 Set the point you want to label, in one of these ways: 



 

PowerSHAPE 2015 R2 Reference Help Delcam Draft • 177  

 Click the mouse on the drawing. 

 
 Enter X Y coordinates in the Command input field on the Status 

bar, for example 80 40. 

A rubber-banded line is attached from the position to the mouse 
cursor. 

6 Set the position where you want the balloon, in one of these 
ways: 

 Click the mouse on the drawing 

 
 Enter the absolute X Y coordinates in the Command input field 

on the Status bar, for example 120 70. 

The balloon is added to the drawing. 

 
To reset the value of the counter, see Balloon toolbar (see page 
151). 
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Creating a surface texture balloon 
A surface texture balloon enables you to show texture on a surface 
using standard symbols, for example: 

 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Click the Geometric Tolerance  flyout to display the Balloon 
toolbar (see page 151). The options on this toolbar are used to 
edit text in balloon labels. 

4 In the flyout, click the Surface texture  button. 

5 If you want to place the symbol directly onto the surface, ensure 

the Pointer On/Off button is deselected  on the Balloon toolbar. 

Otherwise, ensure the Pointer On/Off button is selected . 

6 If you have a pointer on the symbol, click the position on the 
surface where you want the pointer to touch. 
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7 Click the position where you want the symbols of the surface 
texture to lay. If you don't have a pointer, this position should be 
clicked on the surface. 

 
8 If you don't have a pointer, click another position on the surface. 

The symbol is drawn parallel to the line made by the two 
positions just entered. 

9 When you have set the two positions, the Surface Texture dialog 
(see page 179) is displayed. Use it to enter the symbols and 
values of the surface texture. 

 

Surface Texture dialog 
Use this dialog to define the surface texture. 

 
Surface texture symbol — Select a surface texture symbol from the 
list. 

Extension line — This extends the line to fit the texture information. 

Apply to all surfaces — This adds a circle to the symbol to indicate 
the texture is applied to all the surfaces in the model.  

Fill in the following to define the surface texture: 
 Mean deviation 
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 Production method 
 Machining allowance 
 Sampling length 
 Direction of lay 

Enclosed in brackets — Select this option to encloses the surface 
texture balloon in brackets. 

OK — Creates the surface texture balloon and removes the dialog 
from the screen. 

 

Creating a weld symbol 
A weld symbol enables you to represent a weld using standard 
symbols, for example: 

 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Click the Geometric Tolerance  flyout to display the Balloon 
toolbar (see page 151). The options on this toolbar are used to 
edit text in balloon labels. 

4 In the flyout, click the Weld Symbol  button. 

5 Set the point you want to label, in one of these ways: 

 Click the mouse on the drawing. 

 
 Enter X Y coordinates in the Command input field on the Status 

bar, for example 80 40. 
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A rubber-banded line is attached from the position to the mouse 
cursor. 

6 Set the position where you want the balloon, in one of these 
ways: 

 Click the mouse on the drawing 

 
 Enter the absolute X Y coordinates in the Command input field 

on the Status bar, for example 120 70. 

When you set this position, the Weld Symbol dialog (see page 
181) is displayed. Use it to enter the symbols and values of the 
weld symbol. 

 

Weld Symbol dialog 
Construct the weld symbol using the options on the dialog. 

 
 — Enter a weld cross section dimension. 

 — Select an elementary symbol from the list. 
 None 
 Edgeflange 
 Squarebutt 
Single V 
 Single Bevel 
 Single U 

 Single J 
 Backing run 
 Fillet 
 Plug 
 Spot 
 Seam 
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 — Select a supplementary symbol from the list. This option is 
only available if you have selected an elementary symbol 

 None 
 Flat 
 Convex 
 Concave 

 

 — Enter the number of elements. 

 — Enter the length of the elements. 

 — Select an end mark from the list. 

 None 
 End mark 

 

 — Enter a welding process and class. This field is only available if 
you have selected an end mark. 

Site weld — Select this option to add a site weld symbol to the 
balloon. 

Peripheral weld — Select this option to add a peripheral weld symbol 
to the balloon. 

Staggered weld — Select this option to add a staggered weld symbol 
to the balloon. 

Reference line — Select a reference line option from the list: 

 None 

 Top 

 Bottom 

OK — Creates the weld symbol and removes the dialog from the 
screen. 

 



 

PowerSHAPE 2015 R2 Reference Help Delcam Draft • 183  

Creating balloons with dog-legged pointers 
You can create a balloon with a dog-legged pointer. 

 
If you have a complex model with many curves and lines displayed, 
you may find it difficult to find a direct path from the object you 
want to point to and the label text. In this case, you may find it 
easier to re-direct the line of the balloon by using a dog-legged 
balloon. 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 Click any balloon creation option (annotation toolbar). 

4 Click the position where you want the pointer of the balloon to 
touch. 

 
To cancel creating a balloon at any time, right-click in the 
graphics window. You go back to balloon creation mode, where 
you can select the type of balloon to create. 

5 Hold down the Ctrl key and click the positions to dog-leg the 
pointer. 

Remember not to enter the position of the balloon label. 

A rubber-banded line is attached from the last position entered 
to the mouse cursor. 
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In our example, we have entered a position as shown below. 

 
You can continue adding as many positions as you want in the 
dog-legged pointer. 

In our example, we have added another position as shown 
below. 

 
6 Release the Ctrl key and enter the last position of the balloon. 

 
The balloon is added to the drawing. (You may have to fill in the 
Balloon Confirmation dialog (see page 162) before the balloon is 
added.) 
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Editing a balloon 
The label of a balloon is a symbol (made from individual objects) 
and its pointer is a line. 

You can: 

 move a balloon (see page 185). 

 move a leader (see page 186). 

 edit balloon text (see page 187). 

 add leaders (see page 187). 

 reposition a dog-legged leader (see page 189). 

 double-click on a balloon to display the Edit Balloon dialog. Use 
the options on this dialog to edit the items in the balloon. 

 
 

Moving a balloon 
To move a balloon: 
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1 Click once on the balloon to select it. 

 
2 Click and drag the balloon to a new position. 

In this example, the balloon is dragged up and left. 

 
The balloon is moved to the new position. The leader is updated 
automatically. 

 
 

Moving a leader 
To move a balloon's leader: 

1 Click once on the leader to select it. 

 
2 Click and drag the end of the leader to a new position. 
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In this example, the end is dragged to the right of the balloon. 

 
The leader is moved to the new position: 

 
The position where the leader touches the balloon is updated 
automatically. 

 

Editing balloon text 
To edit balloon text: 

1 Select the label of the balloon. 

 
The label is a symbol. 

2 Select Edit > Convert > Symbol from the menu. 

3 Edit the text (see page 126). 
 

Adding leaders 
When you have created a balloon, you can add more leaders to it, 
for example: 

 
To add leaders to a balloon: 
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1 Select only the label of the balloon. 

 
2 From the Edit menu, select Modify to display the Add Leaders 

dialog. This is the same as double-clicking on the label. 

 
3 Click one of the leader heads on the dialog. Do not click OK yet. 

4 Click the position where you want the pointer of the leader. 

 
The new leader leaves the balloon from the nearest edge of the 
label. 

You can force the leader to leave the corner of a balloon with a 
box label. This is done by turning on the Put leaders at frame 
corner option on the Balloon page of the Options dialog. 

A new leader is drawn from the balloon. 

 
5 Continue adding more leaders by selecting a type of leader and 

then entering its position. 

6 Click OK to close the dialog. 
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Repositioning a dog-legged pointer 
1 Select the point object which joins two lines of the pointer of the 

balloon. A point object looks like a star. 

 
2 Drag the point object to a new position. 

 
This gives the balloon shown below. The ends of two lines joining 
the point object move too. 

 
 

Dimensions 
A dimension is a measurement of a length or an angle.  

 Dimensions are added to a model to: 

 check it is the correct size. 

 pass information to another engineer. 

 You can specify dimensions as: 

 linear dimensions (see page 190). 

 radius and diameter dimensions (see page 191). 

 angular dimensions (see page 191). 

 Dimensions consist of leaders, witness lines, marks, and 
annotation. These are the dimension attributes (see page 191). 

Add dimensions to a drawing by: 

 Creating a dimension (see page 192). 

 Editing a dimension (see page 218). 
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 You can also use the measuring features on the calculator to 
check the model for the correct dimensions. 

 

Linear dimensions 
A linear dimension measures the length of a line or the distance 
between two points. 

 
Linear dimensions can also be: 

 basepoint 

 chain 

 ordinate. 

Basepoint dimensions 

 
 Basepoint 

Chain dimensions 

 

Ordinate dimensions 

 
 Origin point 
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Radius and diameter dimensions 
A radial dimension measures the radius or diameter of an arc or a 
circle. 

 
 

Angular dimensions 
An angular dimension measures an angle. 

 
 

Dimension attributes 
Dimensions consist of leaders, witness lines, marks, and annotation. 
These are the attributes of dimensions. 

 

 leader 
 marks 
 annotation 
 witness lines 

Leaders are the lines or arcs that represent the dimension values. 
Witness lines are those that connect the leader to the item. Marks 
are the ends of the leader, that touch the witness lines. Annotation 
is the text associated with the dimension. 

You can edit each attribute to control the appearance of a 
dimension on a drawing. For example, the annotation can be: 

 forced to be horizontal. 

 embedded into the dimension leader. 
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 displaced from the leader. 
 

Creating a dimension 
You can add the following types of dimension to a drawing 

 Automatic (see page 194) 

 Between two parallel lines (see page 199) 

 Radius (see page 200) 

 3 point radius (see page 200) 

 Diameter (see page 201) 

 Angular (see page 202) 

 Base-point (see page 205) 

 Chain (see page 208) 

 Ordinate (see page 211) 

 Angled (see page 214) 

 Dimension a view (see page 215) 
 

Entering dimension-creation mode 

1 Click the Drafting Mode  button on the Main toolbar. The Main 
toolbar changes to the Drafting toolbar and displays the drafting 
tools. 

2 Click the Annotation  button to display the Annotation toolbar 
(see page 116). 

3 From the Object menu, select Dimension to display the Dimension 
creation options. 

 

You can also see these options on the Drafting toolbar. Click  to 
display the Annotation toolbar (see page 116) that is used to edit 
attributes of dimensions (for example, text). 
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The dimension annotation options are shown in  below on the 
Annotation toolbar: 

 Dimensions 

 
Each Dimension creation option is described below: 

 Automatic dimension (see page 194) 

 Parallel dimension (see page 199) 

 Radius dimension (see page 200) 

 3 point radius dimension (see page 200) 

 Diameter dimension (see page 201) 

 Minor angle dimension (see page 204) 

 Major angle dimension (see page 204) 

 Base-point dimension (see page 205) 

 Chain dimension (see page 208) 
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 Ordinate dimension (see page 211) 

 Dimension a view (see page 215) 

 If dimensions are created on a model rather than a drawing, 
they are projected onto the principal plane of the current 
workspace. 

 Straight line segments of curves are treated as lines. 

 We suggest you create a solid of your model where possible 
before drafting from it. This will improve the accuracy of 
dimensioning. For further details, see Creating a solid  

 

Creating an automatic dimension 
The type of object you select determines the type of dimension 
created. For example: 

 If you select a line, a linear dimension is created.  

 If you select an arc, a radius dimension is created. 

 If you select a circle, a diameter dimension is created. 

Use automatic dimensions to create linear dimensions between two 
positions by entering two positions. 

If no automatic dimension is available for an object, PowerSHAPE 
accepts the selection position as the first position of a two-position 
dimension. 

 

Selecting a line 
1 Display the Drafting toolbar. 

2 Click  (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools. 

3 Click  (main toolbar). The Annotation toolbar (see page 116) 
is displayed. This can be used to edit attributes of the new 
dimensions, such as text.  

Click the Automatic dimension  button to display the 
Dimension toolbar (see page 222). 
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4 Select a line. 

 
Ensure you do not click a key point (the end of the line). If you 
click a key point by mistake, PowerSHAPE assumes you want to 
create an automatic dimension between two positions and 
displays a rubber band line from the position to the cursor. To 
continue, start from step 1 again. 

 Clicking the midpoint selects the whole line segment. 
Midpoints are no longer treated as key points. 

5 Enter the position of the text. 

A vertical or horizontal dimension is created depending on where 
you input the text position. Possible horizontal and vertical 
dimensions are displayed as you move the mouse. 

For our example, the regions of the possible horizontal and 
vertical dimensions are shown below. 

 

 horizontal regions 
 vertical regions 

Move the cursor until the dimension you want is displayed. 

You can either create a horizontal dimension as shown below, 
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or a vertical dimension as shown below. 

 
If you want the true dimension of the line, click the Parallel 

dimension  button in the Dimension toolbar. 
 

Selecting an arc/circle 
1 Display the Drafting toolbar. 

2 Click  (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools. 

3 Click  (main toolbar). The Annotation toolbar (see page 116) 
is displayed. This can be used to edit attributes of the new 
dimensions, such as text.  

Click the Automatic dimension  button to display the 
Dimension toolbar (see page 222). 

4 Select an arc or a circle. 

Ensure you do not click any key points. If you click a key point 
by mistake, PowerSHAPE assumes you want to create an 
automatic dimension between two positions and displays a 
rubber band line from the position to the cursor. To continue, 
start from Step 1 again. 

5 Input the position of the text. 

If an arc is selected, the dimension of the radius is created. If a 
circle selected, then the dimension of the diameter is created. 
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For a circle, the dimension is created as shown below. The text 
position determines whether the text is drawn inside or outside 
the circle. 

 
For an arc, the dimension is created as shown below. Again, the 
text position determines where the dimension text is drawn. 

 
 

Clicking two positions 
1 Display the Drafting toolbar. 

2 Click  (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools. 

3 Click  (main toolbar). The Annotation toolbar (see page 116) 
is displayed. This can be used to edit attributes of the new 
dimensions, such as text.  

4 Click the Automatic dimension  button to display the 
Dimension toolbar (see page 222). 

5 Click two positions. 



 

198 • Delcam Draft PowerSHAPE 2015 R2 Reference Help  

a Click the first position: 

 
A rubber-band line is attached from this position to the cursor. 

 
b Click the second position. The rubber-band line is no longer 

displayed. The dimension value is displayed and moves with 
the cursor. 

 If you clicked the first position on an arc (see page 196) or 
a line (see page 194) and not on any of their key points, 
the automatic dimension for those objects is created. If this 
is not what you want, start again from Step 1. 

6 Click to set the dimension position. 

A vertical or horizontal dimension is created depending on where 
you click the dimension position. This is similar to when you 
select a line (see page 194). 

You can either create a horizontal dimension: 

 
or a vertical dimension: 

 
 

Dimensioning a tapped hole 
If a tapped hole is dimensioned around the perimeter of the hole, 
the thread details are displayed. The information that is displayed 
depends on the standard of the tapped hole.  
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 The ISO metric standard uses thread designation/nominal 
diameter/pitch/optional tolerance. The following example shows, 
a 16mm IMF hole. This is dimensioned as M16 x 1.5, showing the 
diameter of the hole and the pitch of the thread. 

 
 The American standard uses nominal diameter/threads per 

inch/thread designation. For example, 3/4 -24 UNF. 

 The British standard uses nominal diameter/thread designation. 
For example, 1/4 BSP. 

 

Creating a dimension between two parallel lines 
1 Display the Drafting toolbar. 

2 Click   (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools.  

3 Click  (main toolbar). The Annotation toolbar (see page 116) 
is displayed. This can be used to edit attributes of the new 
dimensions, such as text. 

4 Click the Parallel dimension  button to display the Dimension 
toolbar (see page 222). 

5 Select a line. 

Ensure you do not click any key points. If you click a key point 
by mistake, start from Step 1 again. 

6 Select another line or click a point. 
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If you click a point, the dimension is measured perpendicular 
from the line to the point. 

7 Input the text position. 

 
 

Creating a radius dimension 
This is used to create a radius dimension on a circle. 

1 Display the Drafting toolbar. 

2 Click   (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools.  

3 Click  (main toolbar). The Annotation toolbar (see page 116) 
is displayed. This can be used to edit attributes of the new 
dimensions, such as text. 

4 Click the Radius  button. 

5 Select a circle. 

6 Input the text position. 
 

Creating a 3 point radius dimension 
This creates a radius dimension using three points. This is ideal for 
dimensioning the radius of curvature on a surface or curve. 

1 Display the Drafting toolbar. 

2 Click   (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools.  

3 Click  (main toolbar). The Annotation toolbar (see page 116) 
is displayed. This can be used to edit attributes of the new 
dimensions, such as text. 

4 Click the 3pt Radius  button. 
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5 Click the first position to define the start point of an arc. 

 
6 Click the second position to define the end point of an arc. 

 
7 Click the third position to define a position on the circumference 

of the arc. 

 
8 Click the text position to add the dimension. 

 
 

Creating a diameter dimension 
This creates diameter dimensions on circles and lines. For example, 
you may want to show the diameter of the top view of a cylinder as 
shown below. 

 
1 Display the Drafting toolbar. 

2 Click   (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools.  
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Click  (main toolbar). The Annotation toolbar (see page 116) 
is displayed. This can be used to edit attributes of the new 
dimensions, such as text. 

3 Click the Diameter  button. 

4 Select an arc or a line, or enter two positions. 

5 Input the text position. 
 

Creating an angular dimension 
Angles are measured between two lines (see page 202).  

Between any two lines, there are two angles: a minor and a major 
angle. The minor angle is less than or equal to 180  and the major 
angle is greater than or equal to 180 . 

 

 Minor angle 
 Major angle 

The intersection position of the two lines defines the pivot of the 
angle. 

You can: 

 create a minor angle dimension (see page 204). 

 create a major angle dimension (see page 204). 

 create an angular dimension on an arc (see page 204). 
 

Creating an angular dimension 
There are several ways of defining the two lines. 

Select two lines 
Select two lines. If the two lines intersect, PowerSHAPE finds their 
intersection to determine the angle (even if PowerSHAPE has to 
extend the lines to find their intersection). 
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Select one line and click an end point 

Select a line  and then click a position to set the end point of a 
second line . The end point of the first line nearest to where you 
clicked to select it  becomes the end point of the second line . 

For example, selecting this line nearest its left end point results in: 

 
Selecting the same line nearest its right end point results in: 

  

Click three end points 
You can define two lines by clicking three positions. The first line is 
defined between click  and click  . The second line is defined 
between click  and click . 

 

Select an arc 
If you select an arc, the two lines are defined from the arc centre: 
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Creating a minor angle dimension 
1 Display the Drafting toolbar. 

2 Click   (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools.  

3 Click  (main toolbar). The Annotation toolbar (see page 116) 
is displayed. This can be used to edit attributes of the new 
dimensions, such as text. 

4 Click the Minor Angle  button. 

5 Define two lines (see page 202). 

6 Click to set the text position. 
 

Creating a major angle dimension 
1 Display the Drafting toolbar. 

2 Click   (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools.  

3 Click  (main toolbar). The Annotation toolbar (see page 116) 
is displayed. This can be used to edit attributes of the new 
dimensions, such as text. 

4 Click the Major angle  button. The Dimension toolbar (see 
page 222) is displayed. This can be used to edit attributes of the 
new dimensions, for example, text. 

5 Define two lines (see page 202). 

6 Click to set the text position. 
 

Creating an angular dimension on an arc 
When you create an angular dimension on an arc, you can toggle 
between displaying the length and displaying the angle. 

1 Create a three-point arc. 

2 Click the Minor Angle  button. 

3 Click the centre of the arc and then the two end points of the 
arc. 

4 Move the cursor to required position and click to fix the position 
of the dimension information. 
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5 Place the cursor on the dimension and right-click to display the 
Dimension context menu.  

6 Use the options Display Length and Display Angle to toggle 
between displaying the length and displaying the angle  

 
 

Creating base-point dimensions 
Base-point dimensions are those from a common position (the base 
point) to another point, for example: 

 
 Basepoint 

1 Display the Drafting toolbar. 

2 Click   (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools.  

3 Click  (main toolbar). The Annotation toolbar (see page 116) 
is displayed. This can be used to edit attributes of the new 
dimensions, such as text. 

4 Click  (annotation toolbar). 
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5 Click on the drawing to position the base point. 

 
6 Input the position you want to dimension to. 

A rubber-banded line is attached from the base-point to the 
mouse cursor. 

 
7 Input the text position. 

A vertical or horizontal dimension is created depending on where 
you input the text position. Possible horizontal and vertical 
dimensions are displayed as you move the mouse. 

In our example, we input the following text position. 

 
The orientation of this dimension is used by all of the other 
dimensions in the base-point dimension. 

The example dimension is horizontal. This means that all the 
other dimensions created in this base-point set will be horizontal 
too. 

8 Input a position for the next dimension. 
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A rubber-banded dimension is attached to the base point and the 
mouse cursor. As you move the mouse, the leader and witness 
lines of the rubber-banded dimension vary. 

 
The distance of the leader from the leader of the first dimension 
is a fixed offset (as defined on the Dimensions page of the 
Options dialog). 

 
The dimension is added to the drawing. The text is automatically 
centred on the leader. You can deselect Centred text on the 
Dimensions page of the Options dialog. 

 If you deselect Centred text, you must click a position to 
place the text on the leader. 
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9 Continue inputting positions to complete the dimensions. 

 
With Centred text selected, each new dimension requires only one 
mouse click. 

 

10 To finish creating base-point dimensions, click Select . 
 

Creating a chain of dimensions 
A chain of dimensions is a group of dimensions linked together such 
that where one dimension finishes the next one starts. An example 
is shown below. 

 
1 Display the Drafting toolbar. 

2 Click   (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools.  

3 Click  (main toolbar). The Annotation toolbar (see page 116) 
is displayed. This can be used to edit attributes of the new 
dimensions, such as text. 

4 Click  (dimension creation menu). 

5 Input the start position of the chain. 
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A rubber-banded line is attached from the start point to the 
mouse cursor. 

 
6 Input the position you want to dimension. 

 
7 Input the text position. 

A vertical or horizontal dimension is created depending on where 
you input the text position. Possible horizontal and vertical 
dimensions are displayed as you move the mouse. 

In our example, we input the following text position. 

 
The orientation of this dimension determines that of all the other 
dimensions in the chain dimension. 

Our dimension is horizontal. This means that all the other 
dimensions created in this chain set will be horizontal too. 

The text is automatically centred on the leader. If you do not 
want centred text, set the Centred Text option on the Annotation 
options dialog to OFF. For further details, see Dimension defaults 
- Annotation options (see page 232).  
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 If you deselect Centred text, you must click a position to 
place the text on the leader. 

8 Input the position of the next dimension. 

You will notice a rubber-banded dimension attached to the end of 
the first dimension and the mouse cursor. As you move the 
mouse, the leader and witness lines of the rubber-banded 
dimension vary. 

 
In our example, we input the following position. 

 
The dimension is added to the drawing. Notice that the text is 
automatically centred on the leader. 
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9 Continue inputting positions to complete the chain of dimensions. 

 
With Centred text selected, each new dimension requires only one 
mouse click. 

 

10 To finish creating chain dimensions, click Select . 
 

Creating ordinate dimensions 
Ordinate dimensions are created along an axis of the principal plane 
of the current workplane. These dimensions measure distances from 
a common origin. An example is shown below. Notice that no leader 
line is drawn. 

 
 Origin point 

The dashed lines are drawn for illustration purposes and are not 
displayed when you create such a dimension. 

1 Display the Drafting toolbar. 

2 Click   (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools.  

3 Click  (main toolbar). The Annotation toolbar (see page 116) 
is displayed. This can be used to edit attributes of the new 
dimensions, such as text. 

4 Click  (annotation toolbar). 
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5 Input the origin of the ordinate dimension. 

 
6 Input the position you want to dimension. 

A rubber-banded line is attached from the base-point to the 
mouse cursor. 

 
7 Input the text position. 

A vertical or horizontal dimension is created depending on where 
you input the text position. Possible horizontal and vertical 
dimensions are displayed as you move the mouse. 

In our example, we input the following text position. 

 
The orientation of this dimension determines that of all the other 
dimensions in the ordinate dimension in this series. 

Our dimension is horizontal. This means that all the other 
dimensions created in this ordinate set will be horizontal too. 

8 Input the position for the next dimension. 
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A rubber-banded witness line is attached to the mouse cursor. As 
you move the mouse, it varies. 

 
One end of the witness line remains in line with the text position. 

 
Once you input the dimension the value is displayed. 

 
The text of the new dimension is automatically centred with that 
of the first dimension.  

If you do not want centred text, deselect the Centred Text option 
on the Drafting > Dimensions > Annotation (see page 232) page of 
the Options dialog. 

 If you deselect Centred text, you must click a position to 
place the text on the leader. 

If the text of the new dimension is too close to the text of the 
previous one, its leader line is automatically created with a dog 
leg. 
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You can set the type of dog leg on the Drafting > Dimensions > 
Lines page of the Options dialog. 

9 Continue inputting positions to complete the dimensions. 

 
With Centred text selected, each new dimension requires only one 
mouse click. 

 
10 To finish creating ordinate dimensions, click the Select button 

. 
 

Creating angled dimensions 
You can create dimensions projected at any angle. 

 
1 Create the geometry. 
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2 Create a workplane. 

 
3 Position the workplane such that the principal plane is at the 

angle you wish to project the dimensions. 

 
4 Create the dimensions. 

 
 

Creating dimensions in a view 
This is used to create dimensions automatically for a selected 
drawing view.  

 The Dimension a view  option is available only when a 
drawing is displayed. 

1 Click  (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools. 

2 Open an existing drawing (see page 10) or create a new drawing 
(see page 8).  
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3 Click  (drafting toolbar) 

4 Click  (annotation toolbar). 

5 Use the Dimension view dialog (see page 216). 
 

Dimension view dialog 
Use this dialog to: 

 Create dimensions of holes (ordinate dimensions). 

 Create overall item dimensions (default dimensions). 

 
View — Select the view from the list, or click inside the required 
view in the drawing. 

Overall dimensions — Select this option to displays the X and Y 
dimensions on the item in the selected view, if the dimensions do 
not already exist. 

Holes: 
Origin — The origin is set to the view origin by default. If you 
change the origin, the view origin updates to the new position. The 
origin is marked by centrelines. 

To change the origin: 
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Enter the X Y Z coordinates or click the Position  button to open 
the Position dialog where you can use position entry tools. 

Layout — You can choose the layout for the text of the ordinate 
dimensions at the following positions: 

 Top Left (default) 
 Top Right 
 Bottom Left  
 Bottom Right 
The example image of a view below shows the layout of hole 
dimensions using the Top Left (default) layout option. 

 
Position dimensions on nearest side of model — Select this option to 
position the dimension text on the side nearest to the hole centre. 
This is useful for plates with hundreds of holes, because it improves 
the clarity of the drawing. 

Deselect the option to position all the dimensions on one side; the 
position of the dimension text is specified by selecting Top Left, Top 
Right, Bottom Left, or Bottom Right. 
Hole direction — Select which holes to dimension: 
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Normal to the view — Select this option to include only the holes 
normal to the view. 

At any angle — Select this option to include holes at any angle. 

Dimension pre-drilled holes — Select this option to allow plates with 
pre-drilled holes to be dimensioned. 

If dimensions are close together, the dimension leader lines are 
drawn doglegged automatically to prevent overlapping. 

 

Editing a dimension 
With a dimension selected, you can edit the dimension in the 
following ways: 

 You can delete the dimension(s) by clicking Delete  or 
pressing the Delete key. 

 Edit Modify displays the Dimension toolbar. 

 Double-click the dimension to display the Dimension toolbar. 

 Right-click the dimension to display the edit options and select 
Modify. Use the Dimension dialog (see page 227) to edit the 
dimension.. 

 Right-click the dimension to display the edit options available for 
dimensions. The name of the dimension and its level is at the top 
of the context menu. 

 
Options, unique to this context menu, are discussed below. 
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Diameter — adds a diameter symbol to the dimension. 

0 - 4 Decimal Places — restricts the dimension value to the 
given number of decimal places. 

Text — displays the context menu given below, which adds 
text to your dimension. 

 
User text — displays the context menu given below. This 
contains a list of strings you can define to add before and 
after dimension values. The strings are defined on the 
Annotation page of the Dimension dialog. 

 
 You can update the geometry (see page 221) of an object that is 

dimensioned. 

 You can specify settings for dimensions using the Drafting options 
on the Options dialog. For further details, see Editing Dimension 
defaults using the Options dialog (see page 232). 
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 To move the dimension text, drag it. 

 To move the crank on the dog leg of an ordinate dimension, drag 
it. 

 The witness lines on dimensions have instrumentation handles to 
let dimensions be edited.  

 
To edit a dimension: 

1 Select the dimension. 

2 Click on the handle and drag to the new position. 

 
For multi-point dimensions such as Basepoint, Chain, and 
Ordinate, you can edit the dimension when completed. 

 This functionality does not apply to Angle dimensions. 
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Updating the geometry of an object 
When you create a dimension by clicking an object, the dimension 
becomes related to the object. If you edit the geometry of the 
object, the dimension is updated too. 

Suppose the following dimension is created by clicking the line. 

 
When one of the end points of the line  

 
The dimension is updated too. 

 
 

Dimension instrumentation 
Red crosses are shown when dimensions need attention because a 
link (dependency) between the dimension and geometry is broken.  
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The example below shows a dimension on a diagonal line showing 
its links (dependencies) on the line's ends. 

 
If the line is deleted, a red cross is displayed and the dimension 
value is underlined in red to show that a link (dependency) is 
broken. 

 
To repair the dimension and remove red crosses, do the following: 

1 Drag each cross (data point) on the dimension and snap it to the 
correct geometry to create a new link (new dependency). 

2 Delete the dimension. 
 

Dimension toolbar 
This toolbar is used to edit attributes of dimensions. 

 
If you edit an attribute of a completed dimension in either creation 
or selection mode, then only the attribute of that dimension 
changes. 

If you edit an attribute whilst creating a dimension, the attribute 
becomes fixed and is used to create all future dimensions in the 
current creation session. 
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Dimension attributes changed using the Dimension toolbar override 
future changes made using the Options dialog. If you edit any 
attribute on the Dimension toolbar, it remains fixed to the 
dimension. So if you now change that item on the Options dialog, it 
does not change that item for the edited dimension. 

Each item on the toolbar is discussed below: 

 — Font used in the text. 

Height — Edits the height of the text. 

 — When selected, the text is italic. You can also use Ctrl + I to 
turn this button on and off. 

 — Deselect this button to remove the first witness line from the 
dimension. 

 

 — Deselect this button to remove the second witness line from 
the dimension. 

 

  — Trims the leader line to the position of the dimension 
annotation. This can be used when the end of the leader is obvious, 
for example, in base-point and chain dimensions. Trimming leaders 
is only possible for linear dimensions. 

 

 Trim leader to text 
deselected — The leader 
line is not trimmed. 

 Trim leader to text 
selected. The leader line is 
trimmed to the dimension 
annotation. 

 — Embeds the text in the leader line. 
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 — This changes all text so that it is positioned horizontally to the 
principal plane. 

Suppose dimensions are angled as shown below. 

 
When text is changed to horizontal, the dimensions look like: 

 

 — This gives true measurements for linear dimensions. When 
on, a projected linear dimension changes to display the true 
dimension. When off, the true dimension changes back to projected. 
Projected dimension True dimension 

  

A linear dimension measures the length of a line or the distance 
between two points. 

 — When on, the diameter symbol is displayed before the 
dimension value. If the dimension is the radius of an arc, then the 
value changes to its diameter. 

 — This toggles the leader lines of radial and ordinate dimensions 
from straight to dog leg. 
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 — This list sets the number of decimal places or 

denominator of the fractional part of the dimension value. You can 
choose an option from the following menu. 

 
Scale — Scales the value of the dimension.In your model, you can 
create objects using a different scale. To create dimensions of the 
‘true’ values, you can enter the value of the scale in the Scale box. 

The dimension of the following line has value 60 and scale 1. 

 
If we change the Scale to 3, the dimension value becomes 20. 

 
When you change the scale factor, a warning is displayed. 

 — Resets the attributes to the settings on the Dimension pages 
on the Options dialog. 

 — Restart creating base-point, chain and ordinate dimensions. 

You can restart base-point, chain and ordinate dimensions without 
entering the origin or the text position again. 
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1 Select the dimension. 

If you are restarting a set of base-point or chain dimensions, 
select the last one. 

 

2 Select the Restart multi-part dimension button . 

3 Click positions on the screen to continue creating new 
dimensions. 

 
A new dimension is added. 

 
With ordinate dimensions, you can also input positions between 
dimensions. 
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A new dimension is added between the existing dimensions. 

 

 — Displays the Annotation page of Dimension dialog (see page 
227).  

  — Displays the Tolerance page of Dimension dialog (see page 
229).  

 — Displays the Style page of Dimension dialog (see page 231).  

  — Displays the Mark page of Dimension dialog (see page 231).  
 

Dimension dialog 
The Dimension dialog contains these tabs: 

 Annotation (see page 227) 

 Tolerance (see page 229) 

 Style (see page 231) 

 Mark (see page 231) 
 

Annotation tab 
This edits the annotation of the dimension. 
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Annotation is the text of the dimension. 

 
Display units — When on, this displays the current units after the 
dimension value. 

Display value — This displays and removes the automatically 
measured dimension value. Turn on to display the dimension value 
and turn off to remove it. 

Text box — Select this option to add a text box around the 
dimension. 

 
Proportional — (Duct font only) When on, the space occupied by 
each character is not fixed. 

Before — In the text box, enter text you want to appear before the 
dimension value. The combo box next to the text box contains three 
symbols: the diameter, the degree and the plus and minus symbols. 
If you select a symbol from the combo box, it is inserted into the 
text box. 

After — In the text box, enter text you want to appear after the 
dimension value. The combo box next to the text box contains three 
symbols: the diameter, the degree and the plus and minus symbols. 
If you select a symbol from the combo box, it is inserted into the 
text box. 

Store — This allows you to store Before and After strings to use in 
other dimensions. 

1 Input the strings you want to store in the Before and After boxes. 

2 Use the selector on the right of this button to select a string 
option. 

3 Click the Store button. The string is now stored. 
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The number 88.88 appears in the string's option to show where 
the dimension value will lie in relation to the string. 

 If the Before and After boxes are empty, the string in the 
selector becomes undefined. 

You can select the stored string later by: 

 Using the selector on this dialog 

 Right clicking on the dimension to display the Dimension pop up 
menu and then select User text followed by the required string. 

Pitch — Enter a character pitch value to change the spacing of 
annotation text on an individual dimension or a selection of 
dimensions. 

Clear user text — This button clears any text in the Before and After 
text boxes. It also turns Display units off. 

OK — Removes the dialog. 
 

Tolerance tab 
This edits the tolerance of the dimension. 

 
Each dimension can have two tolerance values associated with it. 
The tolerance values show the range within which a dimension 
value can vary. 

 
If you are in dimension creation mode and you change values on 
this dialog, the values are stored for the current session of 
dimension creation. 

Value 1 — One value of the range. 
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Value 2 — Second value of the range. 

Limit and Fit — Enter limit and fit codes here. The tolerances for 
holes and shafts are automatically added to the dimensions. 

Character height — Text height of the tolerance values. 

Decimal places — Number of decimal places the tolerance values can 
take. 

Alignment — You can edit the tolerance to display in three formats. 

 

 If you select the first format  and enter 0.15 for Value 1 and -
0.05 for Value 2, a dimension is displayed similar to that shown 
below. 

 

 If you select the second format  and enter 0.1 for Value 1, a 
dimension is displayed similar to that shown below. 

 

 For the third format , if you enter Value 1 as 0.15 and Value 2 
as -0.05, a dimension is displayed similar to that shown below. 

 
Clear tolerance — This button sets the contents of the Value 1 and 
Value 2 boxes to zero. 

OK — Removes the dialog. 
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Style tab 
This edits the style of the dimension. 

 
Select the style of the following objects are given: 
 Leader  
 Text  
 Witness 
 Tolerance 

To change the style for a particular object, select a new one from its 
selector. 

OK — Removes the dialog. 
 

Mark tab 
This edits the end marks on the leader of the dimension. 

 
There are two end marks on the leader. 

 
Mark size — Enter the size of the mark at the ends of the leader. 
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Mark type — Select the type of mark to use at the ends of the leader 
from the list. 

OK — Removes the dialog. 
 

Editing Dimension defaults using the Options dialog 
The Options dialog is used to edit the default attributes of 
dimensions.  

Unlike most defaults on the Options dialog, changes to dimension 
defaults can affect dimensions already created on the current model 
- if they were created with default ('standard') settings. This allows 
a drawing to be quickly changed from one set of defaults to 
another, as is required when changing from, for example, British 
(BSI) to American (ANSI) standards. If an attribute of a dimension 
has been edited using the Dimension toolbar, then any changes in 
the Options dialog to the default value of that attribute does not 
affect it. 

To edit Dimension defaults: 

1 Select Tools > Options to display the Options dialog.  

2 Select the Drafting > Dimensions options. 

3 Select one of the following: 

 Annotation for the annotation of the dimension. 

 Lines for the leader and the witness lines of the dimension. 

 Tolerance / Dual for the tolerance of the dimension and 
displaying dual dimensions. 

 

Annotation options 
Annotation is the dimension text . 
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Use the dialog to change the annotation options. 

 
Style — Select a line style from the list 

Font — Select the font to be used for the annotation. 

Embedded text — Select this option to embed the text in the leader 
line. 

 
Horizontal text — Select this option to change all text so that it is 
positioned horizontally to the principal plane. 
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Suppose dimensions are angled as shown below. 

 
When text is changed to horizontal, the dimensions look like: 

 
Gap ratio — Edits the gap between the leader and the text.  

If Horizontal text is set, the gap ratio is as shown below. 

 
If Embedded text is set, the gap ratio is: 

 
Fractions — Converts the decimal part of the dimension into a 
fraction, by default to the closest eighth. 

Fraction denominator — Sets the fraction denominator to a particular 
value. This is useful if you want to compare dimension values. 

Character height — Edits the height of the text. 
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Pitch — This sets the amount of space between the characters. 

Proportional characters — (Duct font only) When on, the space 
occupied by each character is not fixed. 

Angle Format — Changes how an angular dimension is displayed. 
You can choose the Angle Format to display all angle dimensions as 
one of the following: 

 Decimals 

 Degrees 

 Degrees - Minutes 

 Degrees - Minutes - Seconds 

Decimal places — Decimal places are the number of digits printed 
after the decimal point. By default, the numbers are printed to two 
decimal places. 

Remove trailing zeros — If this option is selected, any trailing zeros, 
after the decimal point, are removed from the dimension 
annotation. The option is deselected by default. 

Multi-part Dimension Options — The following options are for base-
point, chain and ordinate dimensions: 

Basepoint leader gap — This is the distance between the leader 
and the text for base-point dimensions. 

Centred text — When selected, the text is centred on the leader 
line. When deselected, you must enter a position to specify 
where the text lies on the leader. 
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Lines options 
Use this dialog to change the lines options for dimensions. 

 

Leader Line Options 
Leader lines are straight lines or arcs that represent the dimension 
values. 

In these examples, the leader lines are indicated with a red arrow. 

Linear leader line: 
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Radial leader line: 

 
Angle leader line: 

 
 

Style — Select the default style of the leader line from the list. 

Trim leader to text — Select this option to trim the leader line to the 
position of the dimension annotation. 

This can be used when the end of the leader is obvious, for 
example, in base-point and chain dimensions. Trimming leaders is 
possible only for linear dimensions. 

 

 Trim leader to text 
deselected — The leader 
line is not trimmed. 

 Trim leader to text 
selected. The leader line is 
trimmed to the dimension 
annotation. 

 

Internal leaders on small dimensions — When you have a dimension 
with leaders placed on either side of the dimension, as shown 
below, this option adds a line so that no gap exists between the 
arrows of the leader. 
Internal leader on small 
dimensions selected 

 

Internal leader on small 
dimensions deselected 
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Mark size — Enter the size of the mark at either end of the leader. 

Mark type — Select the type of mark to display the end of the 
leader. 

Select the mark type from: 

 Arrow 
 

 Filled 
arrow 

 

 Circle 
 

 Filled 
circle 

 

 Cross 
 

 Slash 
 

 Dot 
 

 

Fill marks on screen — Select this option to shows filled dimension 
marks as filled on the screen. 

 To improve graphics performance, deselect this option and 
show filled marks as unfilled. 

Witness Line Options 
Witness lines connect the leader to the object. 

In this example, the witness lines are indicated with red arrows: 
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Witness style — Select the style of the witness line from the list. 

Dog leg crank type — When creating ordinate dimensions, witness 
lines automatically use dog legs if the text does not fit. Select the 
type of crank on the dog leg from: 

  Angled 

 

  Stepped 

 
Witness offset — Enter the offset distance of the witness line from 
the object. 

 

 Witness offset distance 

 

Witness extension — Enter a value into the to set an extension 
distance in millimetres to all witness lines. 
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Tolerance/Dual options 
Use this dialog to change the tolerance/dual options for dimensions. 

 

Tolerance Options 
Each dimension can have two tolerance values associated with it. 
The tolerance values show the range within which a dimension 
value can vary. 

 
Style — Select the line style of the tolerance from the list. 

Character height — Enter the height of tolerance values. 

Decimal places — Enter the number of decimal places to display for 
tolerance values. 

Alignment — Select the alignment style for tolerances from the list. 
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  Alignment type 1 — For example, if the upper tolerance is 
0.15 and the lower tolerance is -0.05, this is displayed as: 

 

  Alignment type 2 — For example, if the upper and lower 
tolerance are both 0.1, this is displayed as: 

 

  Alignment type 3 — For example, if the dimension value is 75, 
the upper tolerance is 0.15 and the lower tolerance is -0.05, this 
is displayed as: 

 

Dual Dimension Options 
Dual dimensions are when the dimension values are displayed using 
a second set of units. The standard units are displayed without 
brackets and the dual dimension units in brackets. 

 
Dual dimension — Select this option to display dual dimensions. 

Units — Select the units for the dual dimensions. 

Decimal places — Enter the number of decimal places for the dual 
dimensions. 

Tolerance decimal places — If tolerances are displayed, enter the 
number of decimal places for the tolerances of the dual dimensions. 
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Hatching 
Use hatching to add a pattern to a selected region on a drawing. 
You can add different patterns to different regions. 

 
You can hatch open regions. An imaginary line closes the ends of 
the boundary, for example: 

 
You can create holes and islands within the hatch: 

 
A drawing is usually hatched to: 

 show cross-sections. 

 clarify which parts of the drawing are made of the same material, 
or distinguish different types of materials. 
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Creating hatching 
1 Display the Drafting toolbar. 

Click  (Main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools. 

 

2 Click  (Drafting toolbar) to display the hatch pattern options. 

3 Select a hatch pattern (hatch creation menu). 

 
To use an existing user-defined hatch: 

a Select the User Defined Hatch Pattern button  to display the 
User Defined Hatch Patterns (see page 246) dialog. 

b Select a pattern and click OK.  

4 Select the hatch boundary (see page 244). 

5 Use the Create Hatch control panel to create the hatched region. 
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This control panel is similar to the one used for creating a 
composite curve by tracing, except the 'turn left at branch' is the 
default option on the Create Hatch control panel. This option can 
help you to quickly create a hatch boundary if you select the first 
object carefully. 

 If you select a composite curve, the Create Hatch control panel 
is not displayed and the hatch is automatically created. 

 

Selecting the hatch boundary 
There are two ways to select the hatch boundary: 

 Selecting an area enclosed by wireframe. Click in free space within 
an area enclosed by wireframe objects. Clicking as shown below 
will hatch region A 

 
 Using wireframe to define the boundary. Click a wireframe object 

as the start object of the hatch boundary. 

Once an object is selected, the Create Hatch control panel is 
displayed and a boundary is automatically selected. 

Once you have decided where you want the hatch boundary to 
lie, select an object near to an intersection such that you want 
the boundary to turn left at that intersection. 
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To hatch region A, click the objects as shown below. 

 
To hatch region B, click objects as shown below. 

 
As you can see, in the turn left mode, one mouse click is enough 
to select the complete hatch boundary. 

You can use the control panel to edit the hatch boundary. This 
control panel is used in exactly the same way as the Composite 
curve control panel. 

When the required boundary is selected, click the Save button  
on the control panel. The selected hatch pattern is added to the 
selected region. 

When you have created the hatch, you change the pattern by 
editing the hatch (see page 254). 

 You can edit the default settings of each hatch pattern using 
the Hatching page (see page 249) of the Drafting Options 
dialog. 
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User Defined Hatch Patterns dialog 
Use this dialog to select a user defined hatch pattern. 

 
Patterns — Select the user-defined hatch pattern (see page 251) 
that you want to use. 

OK — Click this button to use the selected pattern and close the 
dialog. 

 

Hatching an outer region 
When an outer region contains smaller 'island' regions, you can 
hatch it without hatching the inner ones. Island regions are those 
which do not touch the outer one, as shown below. 

 
1 Start Hatching and select the hatch pattern to be used. For 

further details, see Creating Hatching. (see page 243) 

2 Select an object of the outer boundary. 

 
Once an object is selected, the Create Hatch control panel is 
displayed. 
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3 Use the control panel to select the outer hatch boundary. 

This control panel is used in exactly the same way as the 
Composite curve control panel  

4 Once a boundary is selected, click the Save button  on the 
control panel. 

The selected hatch pattern is added to the selected region. 

 
5 Shift + Select an object in the inner boundary to display the 

Create Hatch control panel. (Shift + Select is when you select an 
object whilst holding down the Shift key.) 

 
6 Use the Create Hatch control panel to select the objects in the 

inner boundary. 

7 Once you have selected the boundary, click the Save button  
on the control panel. 

8 The hatch pattern of the outer region is removed from the inner 
the region. 

 

 If a composite curve is selected, the Create Hatch control 
panel is not displayed and the hatch is automatically created. 
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Hatching an inner region 
1 To toggle the hatching so that the inner area is hatched and the 

outer area is not hatched, Shift + Select the outer boundary. This 
displays the Create Hatch control panel. 

 
2 Click the Save button  on the control panel. The hatch pattern 

is toggled. 

 

 If the outer boundary is a composite curve, the Create Hatch 
control panel is not displayed and the hatch is automatically 
toggled. 

 

Hatching an inner island 
Suppose we had another island within the island as shown below. 
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You can hatch the island within the island to give the following. 

 
1 Use Shift + Select to select one of the objects of innermost island. 

This displays the Create Hatch control panel. 

2 Use the Create Hatch control panel to create the hatch boundary 
from the innermost island.  

3 Click the Save button  on the control panel to create the hatch. 

Both areas are part of a single hatch object. If you edit one, the 
other is edited too. 

 If you select a composite curve, the Create Hatch control panel 
is not displayed and the hatch is automatically created. 

 

Changing the default hatching 
To set the default hatching options: 

1 Select Tools > Options to display the Options dialog. 

2 Select the Drafting > Hatching option. This displays the Hatching 
page of the Options dialog. 
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Use the dialog to set the default hatch pattern. 

 

Standard Hatch Patterns 
Select the default hatch pattern from the examples given. The 
selected pattern is highlighted in blue, for example: 

 
For each hatch pattern, you can edit the Spacing and Colour. The 
spacing and colour of each hatch pattern is stored and used by the 
Hatch dialog. 

Spacing — Enter the spacing between the lines in the selected hatch 
pattern. 

 
Colour — Select a colour for the selected hatch pattern. 
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User Defined Hatch Patterns 
If you do not want to use one of the Standard Hatch Patterns, select 
a user-defined hatch pattern (see page 251) from the list. 

Create — Click this button to create a new user-defined hatch 
pattern (see page 251). 

Edit — Click this button to edit the selected user-defined hatch 
pattern (see page 251). 

Delete  — Click this button to remove the selected pattern from the 
list. 

OK — Click this button to save the options and close the dialog. 
 

Creating/editing a user defined hatch pattern 
You can create your hatch patterns by changing the definitions of 
the lines which make up the hatch. 
To create/edit a user-defined hatch pattern: 
1 Select Tools > Options to display the Options dialog. 

2 Select the Drafting > Hatching option. This displays the hatching 
page of the Options dialog. 

 To create a new user-defined hatch pattern, click the Create 
button to display the Edit Hatch Pattern dialog (see page 252). 

 To edit an existing user-defined hatch pattern, select a pattern 
from the list of User Defined Hatch Patterns and click Edit to 
display the Edit Hatch Pattern dialog (see page 252). 

3 Use the dialog to create/edit a hatch pattern. 

 User defined hatch patterns are only stored in the current 
model. If you want to use the same hatch pattern in several 
models, we suggest you create the hatch in either the 
template model or a macro. 
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Edit Hatch Pattern dialog 
Use this dialog to create or edit a hatch pattern. 

 
Name — Enter the name of the hatch pattern. 

Crosshatch — Select this option to create a cross hatch. 

Filled — Select this option to create a filled hatch. 

Angle — Enter the angle, measured from the X axis. 

Angle 1 — Enter the angle of the hatch lines. 

Angle 2 — Enter the angle of the second hatch lines. 

 You must select the Crosshatch option to access this option. 

Both Angle 1 and Angle 2 are measured from the X axis. 

 
Spacing — Enter the distance between the hatch lines. 

Spacing 1 — Enter the spacing between the lines in the selected 
hatch pattern. 

 
Spacing 2 — If you are using two line styles, Spacing 1 defines the 
distance between lines of the same style. Spacing 2 defines the 
offset of the line with Style 1 from that of Style 2. This example uses 
two styles of line, a fine line and a thicker line: 
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 Spacing 1 
 Spacing 2 

 If Spacing 2 is 0, all lines are placed at equal distances from 
each other and use Style 1. The value of Spacing 2 must be 
between 0 and the value of Spacing 1. 

Spacing 3 and Spacing 4 — Spacing 3 defines the distance between 
lines of the same style at Angle 2. Spacing 4 defines the offset of the 
line with Style 3 from that of Style 4. 

 

 Spacing 1 
 Spacing 2 
 Spacing 3 
 Spacing 4 

 You must select the Crosshatch option to access the 
Spacing 3 and Spacing 4 options. 

 If Spacing 2 is 0, Style 1 is used for all Angle 1 lines. If 
Spacing 4 is 0, Style 3 is used for all Angle 2 lines. 

Style — Select the style for each hatch line. 

Style 1 — Select the style of the first line at Angle 1. 

Style 2 — Select the style of the second line at Angle 1. 
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 Style 1 
 Style 2 

 If Spacing 2 is 0, all lines are placed at equal distances from 
each other and use Style 1. 

Style 3 — Select the style of the first line at Angle 2. 

Style 4 — Select the style of the second line at Angle 2. 

 

 Style 1 
 Style 2 
 Style 3 
 Style 4 

 If Spacing 4 is 0, Style 3 is used for all Angle 2 lines. 

OK — Click this button to create or edit the hatch and close the 
dialog. 

See Creating hatching (see page 243) for details on how to add the 
hatch to the model. 

If you have created a hatch pattern, it is available in the User 
Defined Hatch Patterns dialog (see page 246). 

 

Editing hatching 

Ensure you are in selection mode, by clicking Select . You can 
edit single and multiple hatches in the following ways: 

 Select the hatch. 

 Use the Edit menu:  

Edit > Modify displays the Hatch dialog (see page 255). 

Edit > Convert To wireframe — Converts the hatch lines into 
wireframe. 

 You can edit the style of the pattern lines of the hatch using the 
Style toolbar. 

 Double-click the hatch to display the Hatch dialog (see page 
255).  
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 Right-click on the hatch to display the context menu options 
available for hatching. The name of the hatch (for example Hatch 
1) and its level (for example General) is displayed at the top of 
the context menu. 

 
The five options, at the bottom of the context menu, change the 
pattern of the selected hatch. 

 

Hatch dialog 
Use this dialog to edit the pattern of the selected hatch and to add 
extra hatch boundaries when a single hatch is selected. 

 
Name — This name of the selected hatch is displayed. You can edit 
the name. 
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Pattern 
Select one of the standard hatch patterns to change the selected 
hatching. The selected pattern is highlighted in blue, for example: 

 
For each of the standard hatch patterns, the colour and spacing (if 
not locked) match those that are set in the Options (see page 249) 
dialog. 

Patterns — If you do not want to use one of the standard hatch 
patterns, select a user-defined hatch pattern (see page 251) from 
the list. 

Spacing — This displays the default spacing (see page 249) between 
the lines of the selected hatch pattern. 

Change this value and move the mouse outside the dialog. The 
hatch pattern updates. On the dialog, the button of the selected 
pattern is updated to show that the spacing for that pattern no 
longer matches the default set on the Options dialog. 

If you press the button of the selected pattern again, the default 
spacing is applied to the hatch.  

 Lock button — If you click this button to lock, the spacing value 
is fixed and all the hatch patterns use that value. If you click the 
Lock button again and select a hatch pattern, the spacing value 
changes to its default. 

Edit Pattern — Click this button to open the Edit Hatch Pattern dialog 
(see page 252) to edit the selected hatch pattern. 

OK — Saves the edits made to hatch and closes the dialog. 

Cancel — Discards any edits made to hatch whilst the dialog is 
displayed and closes the dialog. 

 

Adding extra hatch boundaries 
You can edit a hatch pattern to add extra hatch boundaries to 
islands or completely separate areas. When this is done, all these 
hatch areas remain part of a single hatch object. Any edit 
performed on one area affects all the areas that are part of that 
hatching. 

 

Adding separate areas 
1 Double-click the hatch of the pattern you wish to copy. This 

displays the Hatch dialog. 
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Suppose we have the following. 

 
2 Change the pattern of the hatch, if you wish, using the Hatch 

dialog (see page 255). Do not click OK on the dialog. 

3 Shift + select a wireframe object as the start of the new 
boundary. The Create Hatch control panel is displayed. 

 
4 Use the Create Hatch control panel to select the boundary. 

See Creating hatching (see page 243) for details on how to use 
the control panel. 

 
The new composite curve is added as an additional boundary of 
the original hatch and has the same pattern and spacing. 

 
5 Click OK to save the changes. 
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 If you select a composite curve, the Create Hatch control panel 
is not displayed and the composite curve is selected as the 
boundary. 

 

Islands 
You can create islands from an existing hatch in two ways: 

 Within an existing hatch 

 
 Extend the hatch to an outer boundary and remove the existing 

hatch 

 

 The boundary within or enclosing the existing hatch must be a 
composite curve. 

 

Creating an island 
1 Double-click the hatch of the pattern as shown in the image 

below to display the Hatch dialog (see page 255). 

 
2 Change the pattern of the hatch, if you wish, using the Hatch 

dialog. Do not click dialog. 
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3 Shift + Select a wireframe object as the start of the new 
boundary. (Shift + Select is when you select an object whilst 
pressing the Shift key.) This displays the Create Hatch control 
panel. 

 

 If a composite curve is selected, then the Create Hatch control 
panel is not displayed and the composite curve is selected as 
the boundary. 

1 Use the Create Hatch control panel to select the boundary. 

See Creating hatching (see page 243) for details on how to use 
the control panel. 

 
In our example, the hatch is removed from the area enclosed by 
the composite curve. 

 
2 Click OK to save the changes. 
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Symbols 
What is a symbol? 

A symbol is a user-defined object constructed from a collection of 
objects. Objects used often can be stored as symbols, for example, 
nuts and bolts. 

 
A symbol is created in two stages: 

1 a symbol definition is created 

2 a symbol is created from the symbol definition 

A symbol definition is created by selecting a group of objects (for 
example, objects drawn to represent a bolt) and converting them 
into a new single object (for example, a symbol definition called 
'bolt'). All the key points of the original objects are lost when these 
objects convert into the new object, but new key points (known as 
pins) can be defined to position the new object. 

A symbol is created by selecting a symbol definition and positioning 
it on the drawing. 

A single symbol definition is shared between many symbols (saving 
space in the model). For example, if several 'bolts' symbols are 
placed in a model, each symbol accesses its object data from the 
'bolt' symbol definition. Each symbol only stores data about its 
position and orientation. 

You can store symbol definitions in a library model so that you can 
access them from any model. 

 

Creating a symbol definition 
1 Make sure you are in drafting mode. 

2 Click  (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools. 

3 Create the objects to represent your symbol definition. 
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Suppose we want to create a symbol definition called transistor 
of the following objects. 

 
4 Select the objects. 

5 From the Object menu, select Symbol Definition followed by Create 
to display the Define symbol dialog. 

6 Use the Define Symbol dialog (see page 261) to create the 
symbol definition. 

7 Click OK. 
 

Define Symbol dialog 
Use this to create a symbol definition from the selected objects. 

 
Name — The symbol definition is given a default name. Change it to 
transistor. 
Description — Enter or select the description for the symbol 
definition. This description will be displayed in the Create symbol 
dialog (see page 265) to help identify the symbol definition 
required. 
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Store in — You can store the symbol definition in either the current 
model or a library model. For further details, see Creating a library 
of symbol definitions. (see page 263) 

 — Click to browse for symbol libraries outside the model 
database  The Open Library dialog is displayed where you select a 
symbol library. 

Keep items — If ON, objects representing the symbol definition are 
stored with it. In this case, if a symbol (created from the symbol 
definition) is converted (using Edit > Convert > Symbol), it converts 
into these stored individual objects. If OFF, the objects are not 
stored with the symbol definition. In this case, if the symbol is 
converted, its geometry converts into a series of lines. 

Enter Pins by clicking or using point form — Pins are positions on the 
symbol definition. They are used to position the symbol and as key 
points on the symbol. You cannot accurately snap onto a symbol 
where no pin exists, therefore we recommend you add extra pins 
where other objects are most likely to connect with the symbol. 

A symbol definition must have at least one pin. Enter a position to 
create a pin. You can either click a position on the screen or click 
the Position button  to display the Position dialog and use this 
dialog to enter a position. When you enter pins, they are marked by 
a circle. If you input the wrong position for a pin, simply click the 
pin mark to remove it. 

In our example, we enter pins as shown below. 

 
The first pin is the default pin selected when creating symbols, 
therefore enter the first pin as the most likely point to position the 
symbol. 

List of the parameters — This functionality is for future development. 

Apply — Creates the symbol definition and allows you to create 
another symbol definition. Box select the group of objects for the 
next symbol definition. Then fill in the dialog and enter pins. 

OK — Creates the symbol definition and closes the dialog. All the 
selected objects are stored in the definition, undrawn and deleted 
from your model. 

Cancel — Closes the dialog without creating a symbol definition. 
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Creating a library of symbol definitions 
You can store symbol definitions in a library model so that you can 
access them from any model. 

1 Create a model and save it with the word library in its name. 

2 Use the steps in Creating a symbol definition (see page 260) to 
create symbol definitions in your library model. 

3 Save the model. 

When you create symbols in other models, you can now use the 
symbol definitions from this library model by selecting its model 
name from the Model selector in the Create symbol dialog. For 
further details, see Creating a symbol (see page 264). 

 

Editing a symbol definition 
You can edit the name of a symbol definition and delete the symbol 
definition if it is not used in the selected model. 

1 From the Object menu, select Symbol definition followed by Edit 
to display the Edit Symbol Definition dialog. 

2 Use the Edit Symbol Definition dialog (see page 263) to edit 
symbol definition. 

 

Edit Symbol Definition dialog 
Use this to rename and delete symbol definitions. 
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Symbol definitions — This lists the symbol definitions in the selected 
model. Use this list to select symbol definitions to edit. You can 
select more than one symbol by clicking the names. To deselect a 
symbol definition, you simply click the name again. 

Description — Enter or select the description for the selected 
definition(s). 

Model — This selector contains the library models. Use it to select 
the model from which you want to edit a symbol definition. 

To browse for symbol libraries from outside the model database, 
click  to display the Open Library dialog. Use this to select a 
symbol library. 

Delete — This deletes the selected symbol definitions, providing they 
are not used in the selected model. 

Delete Unused — This deletes unused symbol definitions. 

 Component definitions are not affected.   

Rename — This is used to rename the selected symbol definition 
and displays the Rename Symbol Definition dialog (see page 264).  

OK — Accepts any changes and closes the dialog. 
 

Rename Symbol Definition dialog 
Use this to rename the selected symbol definition. 

 
Name — This displays the current name of the selected symbol 
definition. You can change it. 

OK — Accepts the new name of the symbol definition and closes the 
dialog. 

Cancel — Closes the dialog without accepting any changes. 
 

Creating a symbol 
Symbols are instances of a symbol definition. Therefore, you can 
only create a symbol from a symbol definition which exists in either 
the current model or a library model. 

1 Click  (main toolbar). 

2 Use the Create Symbol dialog (see page 265) to create the 
symbol. 
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Create Symbol dialog 
Use this to create a symbol from one of the symbol definitions. 

 
Symbol descriptions: — This displays the description entered in the 
Description text box on the Define symbol dialog when creating new 
symbol definitions. 

Symbol definitions: — Use the list to select the symbol definition you 
want. When you select a symbol definition, it is displayed in the 
Current Symbol graphics window. 

Position at pin — This contains a list of pins on the selected symbol 
definition. Select one to position the symbol. By default, pin 1 is 
selected. 
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Angle — This angle rotates the symbol definition to create the 
symbol. The rotation is about the axis normal to the principal plane. 
When you change the angle, the symbol definition rotates in the 
Current Symbol graphics window. 

 
Current Symbol — This is a graphics window which displays the 
selected symbol definition and shows where its pins lie. The symbol 
definition is displayed looking down on the current principal plane. 

Model — Select a library model from which to choose the symbol 
definition. 

To browse for symbol libraries from outside the model database, 
click  to display the Open Library dialog. Use this to select a 
symbol library. 

If you select a symbol definition from a library model, then its 
symbol definition is imported into the current model. 

Once you have selected a symbol definition and its pin, enter a 
position to place the symbol in your model. For further details see 
Entering positions in Modelling Concepts.. 

As you move the mouse cursor in the graphics window, the symbol 
is attached to the cursor at the selected pin. 

When you enter a position, the symbol is added to your model. On 
your symbol, marks are drawn at the positions of the pins. 

 
You can continue creating more symbols whilst the dialog is 
displayed. 

OK — Accepts changes and closes the dialog. 
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Editing a symbol 
You can edit a symbol in one of the following ways: 

 Select the symbol. 

 Edit > Convert > Symbol converts the selected symbol into its 
individual objects. 

 Edit > Modify displays the Symbol Editor dialog.  

 Double-click the symbol to display the Symbol Editor dialog. (see 
page 268)  

 Right-click the symbol to display the edit options available for 
symbols. The name of the symbol and the level on which it lies is 
at the top of the context menu. 

 
Convert - converts the selected symbol into its individual objects. 

Modify - displays the Symbol Editor dialog.  

Reverse - Symbols can be turned inside out (reversed) when 
their symbol definitions contain triangles. For further details see 
Reversing triangle symbols 

Smooth - You can smooth triangle symbols in PowerSHAPE to 
improve the appearance of the faceted triangle mesh. You can 
use this option on imported files that contain triangles but do not 
contain normals, such as .STL, .DMT or .OBJ files.  

For further details see Smoothing triangle symbols 

Unite - Join selected symbols to create a single symbol. 
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Scaling Constraints - This option displays the Set Constraints for 
symbol dialog to allow constraints to be set for the selected 
symbol.  

 The warning message shown below is displayed when you use 
the Scale option (General edits toolbar) to scale multiple 
objects if any of the selected items has scaling constraints 
already set. 

 

 If Keep items is selected when its symbol definition was 
created, links from the object definitions to the symbol are 
lost. For further details, see Creating a symbol definition (see 
page 260). 

 

Symbol Editor dialog 
Use this to edit the selected symbol. 

 
Name - Displays the name of the selected symbol. You may change 
the name if you wish. 

Position at pin - The name of the selected pin is displayed. 

X, Y and Z - These give the coordinates of the selected pin. You can 
change the coordinates of the selected pin to move the symbol. 

OK - Applies the changes entered in the dialog to the symbol and 
the dialog is removed. 

Cancel - Removes the dialog without altering the symbol. 
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Schedules 
What is a schedule? 

A schedule is either a table containing the coordinates from specific 
objects or a bill of material. 

 
The Bill of Material (BOM) is a table of components/sub-assemblies 
used by an assembly. 

 
You can create schedules from: 

 assemblies 

 assembly holes 
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 balloons 

 circles 

 workplanes 

 symbols/components 

 points 

 solid holes 

 cylinders 

You can also append schedules to add further entries. 

If Microsoft Excel in installed, you can create embedded schedules. 
(see page 270) 

 

Creating an embedded schedule 
1 Ensure that MS-Excel is installed on your computer and that Use 

spreadsheet to create schedule is selected (Schedules page of the 
Drafting options). 

2 Make a drawing view active by selecting Active from the Drawing 
View popup window. 

3 Click Schedule  (drafting toolbar) 

 
4 Click one of the schedule options on the Schedule and BOM 

toolbar 

 

 Click  to produce a schedule for holes (see page 271).  

 Click  to produce a schedule for ejector pins, core pins and 
return pins. 

 Click  to produce an electrode summary sheet (see page 
276), that includes information about the electrode. 
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5 The Schedule dialog (see page 271) is displayed, containing 
items from the drawing view as a schedule. Manipulate the data 
in the Schedule dialog in the same way you manipulate data in 
the Bill of Materials dialog (see page 306). 

 

Schedule dialog (Holes) 
Use this dialog to specify the data that you want to be displayed on 
the schedule for holes. 

 
1 Using the menu options on the dialog, you can select and 

deselect the data that is displayed. The  indicates that the 
option is selected and the data will be displayed in the schedule. 

 Selection — Controls the display of the data in the table. 
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 Columns — Enables you define the columns of data that are 
displayed. Click an option to select ON (display) and deselect 
(do not display) 

 
 Labels — Displays all the options for controlling labels and 

balloons. They work in the same way as labelling in Bill of 
Materials. 
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 Category — Select the category of item you want to include in 
your schedule from the following options: 

 
 Sort — Use to select a sorting method from the following 

options: 

 
The default sort option is No origin sort. Select a sorting 
method from the options.  

You can also sort the schedule using the Diameter column. 
Click on the arrow alongside Diameter to reverse the sorting 
order. 

2 Modify the layout of the columns as required: 

a Click in the column header using the right mouse button.  

b Select the option you require from the column header context 
menu. 

  
Move left — Move the selected column to the left. 

Move right — Move the selected column to the right. 

Increase decimal places — Increase the decimal places in the 
column data. This option is active only if the column contains 
numerical data. 

Decrease decimal places — Decrease the decimal places in the 
column data. This option is active only if the column contains 
numerical data. 

3 If required, apply balloons and labels (see page 279) to 
components in drawings that are selected for the schedule.  
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4 Create the schedule on the drawing, or save it to a file. Use  
to toggle between displaying the data as an embedded Microsoft 
Excel spreadsheet or saving the data in. xlsx or .csv format. 

 

Schedule dialog (Ejector) 
Use this dialog to specify the data that you want to be displayed on 
the Schedule for ejector pins, core pins and return pins. 

 
1 Using the menu options on the dialog, select and deselect the 

data that is displayed. The indicates that the option is selected 
and the data will be displayed in the schedule. 

 Selection — Controls the display of the data in the table. 
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 Columns — Lets you define the columns of data that are 
displayed. Click an option to select (display) and deselect (do 
not display). 

 
 Labels — Displays all the options for controlling labels and 

balloons. They work in the same way as labelling in Bill of 
Materials. 

 
 Sort — Use to select a sorting method from the following 

options: 

 
The default sort option is No origin sort. Select a sorting 
method from the options.  

You can also sort the schedule using the Diameter column. 
Click on the arrow alongside Diameter to reverse the sorting 
order. 

2 Modify the layout of the columns as required: 

a Click in the column header using the right mouse button.  
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b Select the option you require from the column header context 
menu. 

  
Move left — Move the selected column to the left. 

Move Right — Move the selected column to the right. 

Increase decimal places — Increase the decimal places in the 
column data. This option is only active if the column contains 
numerical data. 

Decrease decimal places — Decrease the decimal places in the 
column data. This option is only active if the column contains 
numerical data. 

3 If required, applying balloons and labels (see page 279) to 
components in drawings that are selected for the schedule. 

4 Create the schedule on the drawing, or save it to a file. Use  
to toggle between displaying the data as an embedded Microsoft 
Excel spreadsheet or saving the data in. xlsx or .csv format.. 

 

Electrode Summary Sheet 
You can generate an Electrode Summary Sheet that includes 
information about the electrode.  

 Click the Electrode summary sheet  button on the Schedule 
toolbar to display information in the default layout on the 
Electrode Summary dialog. 
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Right-click the column headings in the Electrode Summary dialog 
and use the options on the context menu to customise the layout 
of the summary sheet.  

 
The context menu includes options to: 

 add or remove standard columns. 

 move columns left or right 

 set the number of decimal places for numeric attributes 

 select the attributes to display for a copy of an electrode 

 The following functionality has also been added: 
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 Click Columns to display a list of columns that can be included 
in the sheet. 

 
 Use an Excel template to add additional calculations or 

company logos. 

 Dynamically change the order of the columns by dragging the 
column heading to the required position. 

 When you click OK, you can select to save the summary sheet 
in .csv (Comma Delimited) or .xlsx (MS Excel) format. 

 Electrode summary sheets created on electrode template 
drawings are updated when an electrode is added to an electrode 
drawing. Electrode copies are added under the parent electrode 
in the spreadsheet.  

 You can also display the Electrode Summary Sheet by 
selecting Modify Layout ... from the Worksheet context menu on 
the setup sheet. 
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Applying balloons and labels to schedules 
The lower half of the Schedules dialog contains instructions and 
options for applying balloons and labels to items in drawings that 
are selected for the schedule. 

 
1 Select the items to balloon by clicking one of the following 

buttons to define your selection, or using Ctrl+click to select 
individual items. 

 — Select all items in the list. 

 — Invert the list selection. 

 — Clear the selection in the list. 

2  — Click to create balloons manually for selected items. The 
Label Items dialog is displayed. Use this dialog to change the 
name of the label series that is used when adding balloons 
manually. 

 
3 Select the drawing where you want to create the schedule. 

 
4 Click one of the following buttons to create the schedule . 

 Create a schedule on the drawing .  

 Save the schedule to a file .  
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Changing the font size of the labels 
You can define the font size of labels using the Size option on the 
Labels menu of the Schedule or Bill of Materials dialog.  

 
Selecting this option displays the Label Size dialog. 

 
Same as balloon toolbar — Select this option to use the label size 
that is defined on the Balloon toolbar. Deselect it to enter a new 
font size. 

Font size — Enter the font size. 

 Font sizes for Schedule and Bill of Materials are independent, 
so you can change the font size for the Schedule and use a 
different size for the Bill of Materials. 

 

Creating customised columns of data 
You can create up to 8 customised columns of data. 

1 Select Columns menu on the dialog. 
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2 Select Custom columns 

 
3 Select Modify custom columns to display the Custom columns 

dialog. (see page 313) 

4 Use the dialog to create a customised column. 
 

Updating the embedded schedule 
To display the Worksheet context menu, right-click on the 
embedded schedule. 

 
Modify — Select this option to open Microsoft Excel. Make the 
changes to the embedded schedule and Save the worksheet. 

Update — Select this option to update the schedule with any 
changes to the items in the drawing view. 

Convert — Select this option to convert the embedded schedule 
to text. 
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Adding colour to the embedded schedule 
To apply colour to the embedded schedule, select Colour from the 
options on the Label menu of the Schedule dialog (see page 271). 

 
None — Select this option to have no colour in the schedule. 

By Label Series — Select this option to apply colours to different 
label types. In this example, the A1 labels are coloured green: 
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By Column — Click on a column heading to sort the schedule. Now 
select the By Column option to apply colour according to the sorted 
order. The worksheet below was sorted on the Thread Diameter 
column before By Column was selected. 

 
 

Personalising the Schedule spreadsheet 
To include personalised information on a Schedule spreadsheet, 
such as a company logo or information, you must first set up a 
spreadsheet (.xls) template in your homes/pshapeX directory. 

1 Create a spreadsheet (.xls) called schedule.xls saved to your 
homes/pshapeX directory. 

2 In the middle of your schedule.xls spreadsheet, create a single cell 
that contains the text: 

Insert data here  
3 Add personalised details above or below the single text cell, in 

the positions you want the details to be displayed on the 
spreadsheet. 

When you create a Schedule spreadsheet by saving to file, the 
schedule.xls spreadsheet is copied into the Schedule and data from 
the Schedule dialog (see page 271) is inserted at the location of this 
single cell. 

 

Creating/appending a schedule 
When you create or append a schedule, it is created for a specific 
type of object.  
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If you have MS-Excel installed on your machine, Use spreadsheet to 
create schedule (Schedules page of the Drafting options), is ON by 
default and you will create embedded schedules automatically. If 
you do not have MS-Excel installed, or you do not want to create an 
embedded schedule, Use spreadsheet to create schedule should be 
OFF. 

For further details, see Creating an Embedded Schedule (see page 
270). 

You can either create the schedule on the screen or save it in a file. 

1 Click  (main toolbar). The Main toolbar changes to the 
Drafting toolbar and displays the drafting tools. 

2 Select the specific type of object for which you want to create a 
schedule. 

You can choose one of the following:  

 assemblies 

 schedule 

 balloons 

 circles 

 workplanes 

 symbols/component 

 points 

 solids 

If your selection contains a mixture of objects, all the objects not 
required are ignored. 

If you select nothing, all objects in the graphics window are 
treated as selected. 

3 Click  (drafting toolbar) to display the Schedule and BOM 
toolbar. 

4 Click  (schedule and BOM toolbar). The Schedule Options 
dialog is displayed. The Balloon toolbar (see page 151) is also 
displayed. This can be used to edit the text in schedules.  

5 Use the Schedule Options dialog (see page 271) to select the 
type of schedule. 
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Schedule Options dialog 
Use this dialog to create and append schedules using specific 
objects. 

 
1 Set the options on the dialog. If you want to create a schedule 

on the screen, click a position. 

 
The top left corner of the schedule is positioned where you click. 
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You can set the first label using the Counter option in the Balloon 
toolbar. 

 
Schedule type — These are the objects for which schedules can be 
created. 

 Assembly (see page 288) 

 Assembly holes (see page 289) 

 Balloon (see page 147) 

 Circle (see page 293) 

 Point (see page 294) 

 Symbol/Component (see page 295) 

 Workplane (see page 296) 

 Solid Hole (see page 297) 

 Cylinder (see page 298) 

Append a current schedule — This appends a schedule to an existing 
one. The appended schedule does not contain a top row with 
headings. It relies on the existing schedule for the top row. 
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Make sure you click the bottom left corner of an existing schedule to 
add the new rows. 

 
The rows are appended to the schedule as shown below. 

 
Build schedule from current selection — If ON, this will use the 
objects from the current selection. Otherwise, the objects are 
selected from everything in the graphics window. 

OK — This removes the dialog from the screen. 

Save — Click this button to save the schedule as an .html, .csv or 
.txt file. 
 The .html file can be viewed and printed in a browser. 

 The .csv file can be read into spreadsheet program such as Excel. 

 The .txt file can be read by another program such as a word 
processor. 
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Assemblies 
A schedule for an assembly is a bill of material. This is a table of 
components/sub-assemblies used by an assembly. 

If you are creating a schedule for an assembly and there are two or 
more assemblies in the model, you must select the assembly to be 
used to create the schedule, using the Available Assemblies dialog is 
displayed. 

 
To create a schedule for one of the assemblies, 

1 Select an assembly from the dialog and  

2 Click OK. 

If the assembly is in an active drawing view, the components are 
given labels in the schedule and balloons using those labels mark 
the components in the drawing view. You choose the shape of the 
balloons on the Balloon page of the Options dialog. For further 
details, see Setting the balloons on the Options dialog (see page 
152).  

Here is an assembly in an active view: 
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The following schedule is created for the assembly. 

 
The schedule groups all the components created from the same 
component definition. 

The schedule can contain the following columns: 

 Label — This label is used by the balloon to mark the component. 

 Part — The name of the component used to define the 
component. 

 Catalog — The name of the catalog if a component is selected 
from a catalog in Delcam Toolmaker. If there is no catalog name, 
the component is listed as user defined. If a component has been 
modified, its catalog name will be marked with an asterisk. 

 Material — The material of the component. 

 Quantity — Number of components defined from the same 
registered component. 

 If the schedule that is created is empty and no balloons are 
added to the drawing, use the context menu to check that 
you have made the view Active. 

 

Assembly holes 
A schedule from assembly holes is a table containing details of the 
holes in the assembly. 
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To create the schedule, the assembly must be in an Active drawing 
view. 

The model below is part of an assembly in an Active view. It is the 
view of an ejector plate in a mold base. 

 
The following schedule is created for the holes in the ejector plate. 

 
If the default Holes To Include setting is used from the Schedule 
page of the Options dialog, only holes that are normal to the view 
are included in the schedule. 

Only the holes of the selected components are included in the 
schedule. If none are selected, the holes of all the components are 
included. 

Each hole is given a label in the view. All holes with the same size 
diameter start with the same letter and have the same Comment 
column. 

If holes lie in the same line and have the same diameter, they are 
given the same label. 
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Through holes are now marked with an asterisk * in the schedule. 

 
The schedule displays the labels, centres, diameters and depth of 
the holes. If a hole is tapered, it has two diameters. 

There are options you can set for the schedule. For further details, 
see Setting the schedule options on the Options dialog (see page 
299). 

 

Balloons 
A schedule from balloons is a table containing positions marked by 
pointers of balloons. It can be created from all balloon types except 
geometric tolerances, surface textures, weld symbols and point 
balloons. 

If all balloons are snapped to components, a bill of materials will be 
produced. 

For further details, see Entering balloon creation mode (see page 
149). 

Three schedule balloons are given in the example below. 

 
The following schedule is created for these balloons. 
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The coordinates of the pointers of the balloons are displayed in the 
schedule. 

For schedule balloons, no pointer is visible. In this case, the pointer 
is the first position entered when you create the balloon. 

If the pointer lies on a drawing or a model, then its coordinates are 
measured from the origin of the current workspace. If the pointer 
lies on a drawing view, then its coordinates are measured from the 
origin of the drawing view. 

A comment column is also drawn in the schedule. Balloons A1 and 
A2 are from the same series. Therefore, the entries for their 
comments are merged. 

By default, only the X and Y coordinates are displayed. To display 
the Z coordinate, turn on the Include Z coordinate option on the 
Schedule page of the Options dialog. 

There are other options you can set. For further details, see Setting 
the schedule options on the Options dialog (see page 299).  

When you create a balloon by clicking its pointer on an object, say, 
the centre of a circle, the pointer's position and the centre of the 
circle become related. If you move the centre of the circle, the 
coordinates of the balloon update in the schedule. 

In the example below, balloon A1 is related to the centre of the 
circle on its left. We move the circle downwards. 

 



 

PowerSHAPE 2015 R2 Reference Help Delcam Draft • 293  

When the circle is moved, the entry in the schedule for A1 updates 
too. 

 
 

Circles 
A schedule from circles is a table containing the centre positions of 
circles. It can also contain the diameters of the circles. For further 
details see Creating a full arc (circle) 

Three circles are given below. 
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The following schedule is created for these circles. 

 
Each circle is labelled using the format AAxx where AA is any 
number of letters and xx is any number of digits. Circles with the 
same diameters have the same prefix and are put next to each 
other in the schedule. The label is automatically set from the 
Counter in the Balloon toolbar. 

In our example, two circles have the diameter 30. The labels of 
these circles are prefixed with a B and the circles are grouped 
together in the schedule. 

The coordinates of the centres and the diameters of the circles are 
displayed in the schedule. A comment column is also drawn in the 
schedule. The comments of circles with the same diameters are 
merged. 

By default, only the X and Y coordinates are displayed. To display 
the Z coordinate, turn on the Include Z coordinate option on the 
Schedule page of the Options dialog. 

 For further details, see Setting the schedule options on the Options 
dialog (see page 299) 

If you move the circle or change its diameter, the values update in 
the schedule. 

 

Points 
A schedule from points is a table containing the coordinates of the 
points. 

For further details, see Creating a point. 
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Here are some points. 

 
The following schedule is created for these points. 

 
The coordinates of the points are displayed in the schedule. A 
comment column is also drawn in the schedule. The rows of the 
comment column are merged for the selected points. 

By default, only the X and Y coordinates are displayed. To display 
the Z coordinate, turn on the Include Z coordinate option on the 
Schedule page of the Options dialog. 

There are other options you can set. For further details, see Setting 
the schedule options on the Options dialog (see page 299). 

If you move a point, its coordinates update in the schedule. 
 

Symbols/components 
A schedule from symbols (see page 264) is a table containing the 
coordinates of the pins used to position the symbols. 

Components are part of an assembly. A schedule from components 
is similar to the one for assemblies. 

Here are some symbols. 
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The following schedule is created for these symbols. 

 
The coordinates of the pins used to position the symbols are 
displayed in the schedule. A comment column is also drawn in the 
schedule. The rows of the comment column are merged for the 
selected symbols. 

By default, only the X and Y coordinates are displayed. To display 
the Z coordinate, turn on the Include Z coordinate option on the 
Schedule page of the Options dialog. 

There are other options you can set.  

For further details, see Setting the schedule options on the Options 
dialog (see page 299). 

If you move the symbol, the coordinates update in the schedule. 
 

Workplanes 
A schedule from workplanes is a table containing the origins of 
workplanes.  

Three workplanes are given below. 
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The following schedule is created for these workplanes. 

 
Each workplane is labelled by its name. The coordinates of the 
origins of the workplanes are displayed in the schedule. The 
coordinates are relative to the active workplane. A comment column 
is also drawn in the schedule. 

By default, only the X and Y coordinates are displayed. To display 
the Z coordinate, turn on the Include Z coordinate option on the 
Schedule page of the Options dialog. 

There are other options you can set. For further details, see Setting 
the schedule options on the Options dialog (see page 299). 

If you move the workplane, the coordinate values update in the 
schedule. 

 

Solid holes 
A schedule from holes in solids is a table containing the origin, the 
diameter and the depth of the holes. For further details see Creating 
a solid hole. 

A solid with holes is given below. 
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The following schedule is created for the holes. 

 
The schedule groups all the holes created from the same type of 
hole. It displays the centres of the holes, their diameters and depth. 

If the default Holes To Include setting is used from the Schedule 
page of the Options dialog, only holes which are normal to the view 
are in the schedule. 

Through holes are now marked with an asterisk * in the schedule. 

 
By default, only the X and Y coordinates are displayed. To display 
the Z coordinate, turn on the Include Z coordinate option on the 
Schedule page of the Options dialog. 

There are other options you can set. For further details, see Setting 
the schedule options on the Options dialog (see page 299). 

 

Cylinders 
A schedule from cylinders is a table containing the centre positions, 
diameters and depths of cylinders. 
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A schedule is created for the three cylinders given below. 

 
Each cylinder is labelled using the format AAxx where  

AA is any number of letters  

xx is any number of digits.  

Cylinders with the same diameters have the same prefix and are 
put next to each other in the schedule. The label is automatically 
set from the Counter in the Balloon toolbar. 

In our example, two cylinders have the diameter 60. The labels of 
these cylinders are prefixed with an A and the cylinders are grouped 
together in the schedule. 

The coordinates of the centres and the diameters of the cylinders 
are displayed in the schedule. A comment column is also drawn in 
the schedule. The comments of cylinders with the same diameters 
are merged. 

By default, only the X and Y coordinates are displayed. To display 
the Z coordinate, turn on the Include Z coordinate option on the 
Schedule page of the Options dialog. 

 

Setting the schedule options on the Options dialog 
When creating and appending schedules, you can set certain 
aspects of their contents and layout. 

1 From the Tools menu, select Options to display the Options 
dialog. 

2 From the Drafting section of the browser tree, select Schedule. 
This displays the Schedule page of the Options dialog. 
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 If you have Microsoft Excel installed, the Use spreadsheet to 
create schedule option at the bottom of this page is selected 
by default and the other schedule options are unavailable. 
This enables the enhanced Schedules and Bill of Materials 
functionality. If you do not have Microsoft Excel installed, 
this option is deselected. Deselect this option manually if 
you do not wish to use the enhanced functionality. 

 
3 Use this dialog to set the default schedule settings. 
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Colour automatic labels by series — Select this option to change 
the colour of the labels as the series changes, for example: 

 
Font — Select the colour used by the text. 

Frame — Select the colour used by the lines of the frame. 

Use workplane as Z reference — Select this option to use the 
workplane to calculate the Z position. 

Z coordinate — Select this option to include the Z coordinate in 
the schedule. 

Hole rotation — Select this option to include columns for the X 
and Y rotation angle of the hole. 

Comments — Select this option to include a column to add your 
comments when creating a schedule. 

Depth — Select this option to include a column with depth when 
creating a schedule for assembly and solid holes. 

Hole thread details — Select this option to include column for the 
pitch, depth, and start Z of the hole. 

Hole thread name — Select this option to include a column that 
lists the name of the standard and size of the thread. 

Hole tolerance — Select this option to include a column for the 
hole tolerance. 

Include diameter value — Choose whether to display a column for 
diameter values. There are three options: Auto, On, and Off. 
Auto displays a diameter only if the schedule item is defined from 
the centre of a circle. On always displays a diameter column and 
a hyphen (-) is displayed if the schedule item is not defined from 
the centre of a circle. Off never displays a diameter column. 
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Text height — Enter the text height of the hole schedule text. 

 This option is only available when Use spreadsheet to 
create schedule is deselected. 

Diameter/depth decimal places — Enter the number of decimal 
places to display for the diameter or depth value. If the units for 
the model are inches, additional decimal places are displayed. 

Coordinate decimal places — Enter the number of decimal places 
to display for the coordinates. If the units for the model are 
inches, additional decimal places are displayed. 

Automatic labelling — Select this option to display a label next to 
each object used in a schedule. The column heading of the object 
in the schedule is Label. If you deselect this option, no labels are 
displayed and the name of the object is used in the schedule. 
The column heading of object in the schedule is the name of 
object type (for example, workplane). 

Fit columns to width — Select this option to set the widths of the 
X, Y, Z and diameter columns to the size specified in Column 
Width. Deselect it to enable PowerSHAPE to set the width of the 
columns automatically, to fit the size of the widest entry. 

Column width — If you select Fit columns to width, enter the size 
of the width of the column. If the widest entry is larger than the 
column width, the width of all the columns adjust to fit that 
entry. 

Holes To Include — Select which holes to include in a schedule: 

At any angle — Include holes that are at any angle to the view. 

Normal to the view — Include only holes that are normal to the 
view. 

Whose faces are normal to the view — Include only holes whose 
face is normal to the view. 

Show only holes at front — Select this option to show only holes at 
the front of the view. 

Include pre-drilled holes — Select this option to include any pre-
drilled holes in the object. Pre-drilled holes exist in some Delcam-
Toolmaker components such as core and cavity plates. 

Sort method — Select how you want to label objects in the same 
series. 
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Use spreadsheet to create schedule — If you have Microsoft Excel 
installed, this option is selected by default and the other 
schedule options are unavailable. This enables the enhanced 
Schedules and Bill of Materials functionality. If you do not have 
Microsoft Excel installed, this option is deselected. Deselect this 
option manually if you do not wish to use the enhanced 
functionality.  

The labels on the circles below use the Sort Left To Right Then 
Back Again method . 

 
The same circles are shown using the Sort Up Then Down method 

. 

 
4 Click OK. 

 

Editing a schedule 
A schedule is made of lines and text. These can be edited using the 
editing commands for lines and text. For further details, see Editing 
a line and Editing text (see page 126) for further details 

The numbers in the schedule may depend on other objects. For 
example, a number representing the diameter of a circle will update 
if the diameter changes. 

As well as appending new rows to the end of the schedule, you can 
append them to the middle of the schedule. 
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1 Use the Stretch command on the Edit toolbar to pull down the 
lower rows. For further details, see Edit - General Edits - Stretch. 

2 Use the append command for that particular type of schedule to 
insert rows. 

 

Embedded Bill of Materials 
A Bill of Materials is a list of components used by an assembly and 
displayed in a table. The table of data can be embedded into a 
drawing as a Microsoft Excel spreadsheet, or saved as an OLE file. 

 You need licences for Delcam Drafting and Microsoft Excel to 
use this menu option. If you do not have a licence for 
Microsoft Excel, you can create a Bill of Materials by  

1.Selecting Schedule from the Object menu to display the 
Schedule Options dialog. 

2. Selecting the Assembly option on the Schedule Options 
dialog. 

 

Creating an embedded Bill of Materials 

1 Click  in the main toolbar to enter Drafting Mode. 

2 Open an assembly. 

3 Click  to display the Open Drawing dialog. 

4 Click Create new drawing  on the dialog. 
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5 Create the views of the active assembly that you want to be 
labelled. The following example shows an assembly with 4 views. 

 

6 Click Schedule  (drafting toolbar) 

 

7 Select Bill of Materials  (schedule and BOM toolbar)  

 
Delcam Drafting generates data from the active assembly and 
displays it in the Bill of Materials dialog. (see page 306) 

 Components based on round primitives (cone, cylinder, torus, 
or spring) are specified using Length x Diameter.  

 A best-fit bounding box is used to specify sizes for 
components that are not based on primitives. This gives 
accurate sizes for components that are positioned at 
compound angles (for example, sliders) 

 If the part number and catalog of components are the same, 
but the descriptions are different, the description will be 
omitted in the Bill of Materials. 

8 Use the Bill of Materials dialog (see page 306) to create an 
embedded Bill of Materials. 
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Bill of Materials dialog 
Use this dialog to specify the data that you want to be displayed as 
a Bill of Material:  

 
1 Use the menu options to define the data that is displayed in the 

dialog. The  indicates that the option is selected and the data 
will be displayed in the bill of materials.  

 Selection controls the display of the data in the table. 

 



 

PowerSHAPE 2015 R2 Reference Help Delcam Draft • 307  

 Columns defines the columns of data that are displayed.  

 
 Labels displays all the options for controlling labels and 

balloons. They work the same way as labels and balloons in 
schedules. 

 
2 Modify the layout of the columns as required: 

a Click in the column header using the right mouse button.  

b Select the option you require from the column header context 
menu. 

  
Move Left - Move the selected column to the left. 

Move Right - Move the selected column to the right. 

Increase Decimal Places - Increase the decimal places in the 
column data. This option is only active if the column contains 
numerical data. 
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Decrease Decimal Places - Decrease the decimal places in the 
column data. This option is only active if the column contains 
numerical data. 

 You can also click + drag to reposition the columns. 

3 Modify the way items are displayed (see page 308) in the Bill of 
Materials dialog. If the items have a hierarchical structure (for 
example a sub-assembly), they are displayed in a summarised 
mode by default. 

4 Apply balloons and labels to components in drawings that are 
selected for the bill of materials. For further details, see Applying 
label balloons and creating the Bill of Materials (see page 310). 

5 Click  to toggle between displaying the data as an embedded 
Microsoft Excel spreadsheet (default) or saving the data as an 
OLE file. 

6 Click OK to create the bill of materials on the drawing, or save it 
to a file.  

 

Displaying the data in the Bill of Materials 
The Bill of Materials dialog supports hierarchical structures such as 
sub-assemblies. Entries can be: 

 Summarised; only top level components/sub-assemblies are 
listed. This is the default display mode. 

 Expanded; a bold heading is added and the components are 
listed below, indented from the heading.  

 Exploded; components in sub-assembly are listed.  

In addition: 

Blank can only be applied  to top level entries.  

Unblank only unblanks entries that you have explicitly blanked. 

Changing the way the data is displayed in the BOM 
Use the options on the context menu to specify the way the data is 
displayed in the Bill of Material table. The following will be updated 
to reflect the display mode that you select: 

 columns that are displayed. 

 quantities. The Quantity column is displayed in all modes. 

The following example uses a slider sub-assembly to show the effect 
of using the different options: 

1 The sub-assembly is currently displayed in summarised format. 
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Right-click the sub-assembly entry in the table to display the 
context menu. 

 
2 Select Expand from the context menu. The table is displayed with 

the items from the sub-assembly displayed individually below the 
name of the sub-assembly. The individual items are indented. 

 
3 Right click the sub-assembly heading and select Summarise from 

the context menu. The table is displayed in the summarised 
format. 

 
4 Select Explode to display the table with the items from the sub-

assembly displayed individually. 
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Applying label balloons and creating the Bill of Materials 
The lower half of the Bill of Materials dialog contains instructions and 
options for applying balloons and labels to components in drawings 
that are selected for the bill of materials.  

 
Follow the instructions and select appropriate options: 

1 Select a view in the drawing where you want to apply component 
balloons. You can do this in one of the following ways: 

 Select a view from the drop-down list.  

 



 

PowerSHAPE 2015 R2 Reference Help Delcam Draft • 311  

 Click a view on the drawing to choose where the balloon will 
be displayed. The value that is displayed in the drop-down list 
will be changed to match the view that you have chosen. You 
can then add a manual balloon to the drawing in the normal 
way. 

 
2 Click one of the following buttons to define the components to 

balloon. 

 - Select all components in the list. 

 - Invert the list selection. 

 - Clear the selection in the list. 

3 Click  to create balloons manually for selected items. The 
Label Items dialog is displayed. Use this dialog to change the 
name of the label series that is used when adding balloons 
manually. 
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Balloons are added to a component in a single view; the balloon 
will appear on the last view that you selected. 

4 Select the drawing where you want to create the Bill of Materials. 

 

5 Click  or  to create the bill of materials. 

 Create a bill of materials on the drawing .  

 Save the bill of materials to a file .  
 

Creating customised columns of data - Bill of Materials 
You can create up to 8 customised columns of data. 

1 Select Columns menu on the dialog. 
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2 Select Custom columns 

 
3 Select Modify Custom Columns to display the Custom Columns 

dialog. (see page 313) 

4 Use the dialog to create a customised column. 

5 Add data to the custom column (see page 314) 
 

Custom Columns dialog 
Use this dialog to create customised columns of data in the dialog. 

 
Column — Select a column from 1 - 8. 
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Property — Change the default name to the name of the property 
that contains the required data. The property name entered is also 
displayed as a column title. If a user defined property matches a 
standard column name, the value should be appended to that 
column. So if you have a component called bolt that has a user 
defined property called Part, with a value test, the column will be 
called bolt test. 

OK — This creates the new column title and removes the dialog.  
The new column title is displayed in the list of custom columns that 
can be selected to be displayed in the dialog.  

 

Adding data to a new Custom column 
1 Return to the active assembly, and enter the Assembly 

application mode. 

2 In the assembly tree, right-click on a component. 

3 Select Properties from the Modify flyout to display the Modify 
Properties dialog. 

 

4 Select Create a New property . 

5 In the Name text box, enter the name of the newly created 
custom column.  

 Name is case-sensitive, so "Width_1" is not the same as 
"width_1" 

6 In Value, enter the customised data. 

7 Click OK 

When you next create a Bill of Materials this information will be 
available to be included in the column in the Bill of Materials dialog. 

Both component and component definition properties are displayed 
when the Modify Properties dialog is displayed for a component.  
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Additional information on Modify Properties dialog 
Component definition properties are inherited by all instances of the 
component definition. Individual component instances can, 
optionally, overwrite the default property values set by the 
component definition. 

Information or Query dialogs are displayed if you attempt to use the 
Modify Properties dialog to delete or rename a property when this 
action could have unexpected consequences.  

The relevant query dialog is displayed if you try to do one of the 
following: 

 Delete a property defined in the component and component 
definition. 

 
 Delete a property defined in the component definition only:  

 
 Rename a property defined in the component definition. 

 
 

Labelling components in views 
If you label all the components in one view, it may become 
cluttered. It can be useful to label different components in different 
views for clarity. 
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1 In the Bill of Materials dialog, select all the rows of components 
that you want to label 

2 Select Labels on the Bill of Materials dialog: 

 
3 Select the type of label you want to use 

4 Click one of the following buttons to create the Bill of Materials: 
with the labels displayed: 

 Create on Drawing - Click on the drawing in the position you 
want the Bill of Materials to be displayed. The Bill of Materials 
is created as an OLE file that is embedded in the psmodel. 

If a Bill of Materials is already created in a drawing this option 
creates an additional Bill of Materials. The existing Bill of 
Materials can be deleted to display only the newer version. 

 Save To File - This option creates the Bill of Materials as a 
Microsoft Excel spreadsheet (.xls file). The Save As dialog is 
displayed where you specify a filename and browse to the 
drive and folder where you want to store the Bill of Materials. 

5 Labels are generated and displayed in the Bill of Materials dialog 
and the balloons are displayed in the chosen view. 



 

PowerSHAPE 2015 R2 Reference Help Delcam Draft • 317  

6 The following example shows a labelled view of an assembly, and 
the labels displayed in the Bill of Materials dialog. 

 

 
7 Click on a labelled component in the Bill of Materials dialog to see 

it highlight in the view. You can also click on a component in a 
view to see it highlight in the Bill of Materials dialog. 

 If you wish to have just one of each item displayed or labelled 
in the Bill of Materials dialog, sort the data by Quantity. You 
will notice that some rows of components do not have a 
quantity entered. This is because the first instance of the 
component displays the total quantity. If you do not wish to 
display these rows, you can blank them using Blank Selected 
from the View menu. 

 If data is sorted when you label the components, any identical 
data will have the same label series. If you wish to override 
this you need to relabel the components. 
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Labelling individual components in views 
1 In the Bill of Materials dialog, click on the individual components 

you want to label. Hold down the CTRL key to select more than 
one component. 

2 Click  on the Bill of Materials dialog (see page 306).. The 
Label Items dialog is displayed showing a description of the first 
item selected to be labelled. 

 
3 The corresponding component is highlighted on the assembly 

drawing in the selected view. 

4 Click on the highlighted component. The cursor displays a label 
line. 

5 Click on the drawing to fix the balloon label. The description of 
the next item selected is displayed in the Label Items dialog.  

6 Click in the drawing to create the label or click Skip if you do not 
want to create a label for the item displayed. 

The next selected item is displayed. 

The corresponding label for the component is displayed in the 
Label column in the Bill of Materials dialog. Any skipped items are 
still highlighted in the Bill of Materials dialog. 

7 Click one of the following buttons to create the Bill of Materials: 
with the labels displayed: 

Create on Drawing - Click on the drawing in the position you want 
the Bill of Materials to be displayed. The Bill of Materials is 
created as an OLE file that is embedded in the psmodel. 

 If a Bill of Materials is already created in a drawing this option 
creates an additional Bill of Materials. The existing Bill of 
Materials can be deleted to display only the newer version. 

Save To File - This option creates the Bill of Materials as a 
Microsoft Excel spreadsheet (.xls file). The Save As dialog is 
displayed where you specify a filename and browse to the drive 
and folder where you want to store the Bill of Materials. 

1 Labels are generated and displayed in the Bill of Materials dialog 
and the balloons are displayed in the chosen view. 
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Modifying Labels 
Labels are sequenced automatically in alphanumerical order, for 
example A1 - D8. Make changes to labelling in the Bill of Materials 
dialog as follows: 

1 In the Bill of Materials dialog, select all the rows of components 
that you want to modify. 

2 Select Labels on the Bill of Materials dialog: 

 
3 Click Set Label Series. Use the Label Series dialog to specify the 

start number for the label series. 

 
Letter - Enter the start letter for the label series. To display labels 
alphabetically, enter A and leave Number blank. 

Number - Enter the start number for the label series. To display 
labels numerically, enter 1 and leave Letter blank.  
 
Label Series Letter Number 
Alphabetical A Blank 

Numerical Blank 1 

Hyphen A- 1 

Colon A: 1 

 
 



 

320 • Delcam Draft PowerSHAPE 2015 R2 Reference Help  

Changing the font size of the labels 
You can define the font size of labels using the Size option on the 
Labels menu of the Schedule or Bill of Materials dialog.  

 
Selecting this option displays the Label Size dialog. 

 
Same as balloon toolbar — Select this option to use the label size 
that is defined on the Balloon toolbar. Deselect it to enter a new 
font size. 

Font size — Enter the font size. 

 Font sizes for Schedule and Bill of Materials are independent, 
so you can change the font size for the Schedule and use a 
different size for the Bill of Materials. 

 

Displaying the Bill of Materials as a spreadsheet 
1 Manipulate the data in the Bill of Materials dialog so that the 

required data is displayed. 

2 Click  on the Bill of Materials dialog  

3 Click OK. 
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4 Click the cursor in the drawing at the position you want the 
spreadsheet to be displayed. 

 
 

Modifying data in the embedded spreadsheet 
1 Click on the spreadsheet in the drawing with the right mouse 

button. 

The following context menu is displayed. 

 
2 Click Modify.  

You can also double click on the spreadsheet in the drawing to 
open it. The bill of materials data is displayed in a Microsoft Excel 
spreadsheet. 

3 Edit the spreadsheet. 

As you modify data in the spreadsheet, the changes are also 
displayed in the bill of materials table in the drawing. 

 

Saving the Bill of Materials as a file 
1 Manipulate the data in the Bill of Materials dialog so that the data 

you want to save as a file is displayed. 

2 Click . 

3 Click OK.to display the Save As dialog. 

4 Select .xls or .csv from the Save as type drop-down list. 

5 Click Save. 
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 You can embed the saved .xls file into drawings as an OLE 
view. 

 

Modifying data saved as a file. 
As the file was saved automatically as a .xls spreadsheet, the file 
can be opened and modified using Microsoft Excel. 

1 Right click on the Bill of Materials. 

2 Select Modify. The Bill of Materials is displayed as an MS Excel 
spreadsheet. 

3 Make the changes to the spreadsheet and click  on the 
spreadsheet. The embedded Bill of Materials will be updated. 

 

Personalising the BOM spreadsheet 
To include personalised information on a Bill of Materials 
spreadsheet, (for example, a company logo), you must first set up a 
spreadsheet (.xls) template as a user-specific file. 

1 Create a spreadsheet (.xls) called bom.xls saved to your user-
specific folder. 

2 The location of the user-specific files (for example custom 
toolbars and shortcuts)  is structured so that these files are 
stored in xxxx\PowerSHAPE, where xxxx is one of the following: 

 C:\Documents and Settings\[username]\Application Data    (XP 
installation) 

 C:\Users\[username]\AppData\Roaming\   (Vista installation) 

 the location that is indicated by your HOME variable.  

3 In the middle of your bom.xls spreadsheet, create a single cell 
that contains the text Insert data here.  

 This text must not be translated. 

4 Add personalised details above or below the single text cell, in 
the positions you want the details to be displayed on the 
spreadsheet. 

When you create a Bill of Materials spreadsheet by saving to file, 
the bom.xls spreadsheet is copied into the Bill of Materials and data 
from the Bill of Materials dialog is inserted at the location of this 
single cell.  
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